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Getting Started
Before we dive right into the world of recording, here are some helpful tips about getting your Line 6 
gear setup, as well as links to other related resources for you.

Installing Line 6 Audio Drivers and POD Farm™ 2 Software

To use your Line 6 POD Studio™, TonePort™, GuitarPort™, POD® X3 or POD®xt as an audio device 
for your computer, you’ll need to install the Line 6 USB audio driver for your device. A “driver” is a 
software component that installs on a Mac® or Windows® computer that allows a hardware device to 
function with the computer’s operating system. If your Line 6 hardware came included with a POD 
Farm™ 2 software CD, simply install POD Farm 2 and it will automatically install the USB device 
drivers, Line 6 Monkey™ and all POD Farm 2 components for you. Or, just go to the Line 6 Software 
Downloads page where you can always download the latest POD Farm 2 installer. If you need some 
help with the installation process, please check out the additional documentation found on the POD 
Farm Online Help page.

About POD Farm 2

Line 6 POD Farm 2 software is the Mac® and Windows® companion for all Line 6 POD Studio, 
TonePort and GuitarPort devices. With these devices and the purchase of the POD Farm 2 software 
license, you can run POD Farm 2 in “standalone operation” - which you can think of as an elaborate 
“user interface” allowing you to load, customize and save presets of your Tones, fiddle about with 
amp & effects knobs and switches on your computer, and manage the POD Farm 2 signals and levels 
routed to your Digital Audio Workstation (DAW) software. POD Farm 2 also fully supports external 
MIDI control for the majority of its functions, so you can use a MIDI controller device to access most 
parameters remotely. The POD Farm 2 and POD Farm Elements Plug-Ins are also included with the 
purchase of the POD Farm 2 license for POD Studio, TonePort, GuitarPort, as well as for POD® X3 
and POD®xt and an iLok USB key!    

POD Farm 2 & POD Farm Elements Plug-Ins 

POD Farm 2 Plug-In and all the POD Farm Elements Plug-Ins are provided for the Mac® AU/VST®/
RTAS®, and Windows® VST®/RTAS® plug-in formats. This allows you to apply legendary POD® amp,  
cabinet, mic, preamp and effects models to any number of tracks within your DAW software, utilize 
parameter automation, MIDI control, and enjoy the benefits of non-destructive processing. We’ve 
covered these features in the chapter aptly titled “POD Farm™ 2 & POD Farm Elements Plug-Ins”. 
Whether you own POD Farm 2 yet or not, you can use Line 6 Monkey to get it all going in minutes on 
your Line 6 device - just read through the following section.  

Updating & Registering with Line 6 Monkey™

Line 6 Monkey is the intelligent updater utility automatically installed with the POD Farm 2 software. 
It is highly recommended that you run Line 6 Monkey at the end of your POD Farm 2 installation, 
and to do so often to be sure you have all the latest updates for all your Line 6 software and hardware 
products. 

iLok Users: You do not need to run Line 6 Monkey if you have purchased the POD Farm 2 license for your 
iLok USB key. Please see the POD Farm 2 Basic User Guide (by launching the Help from within POD 
Farm 2, or by downloading it from POD Farm Online Help) for iLok instructions.

http://line6.com/software/
http://line6.com/software/
http://line6.com/manuals/PODFARM/
http://line6.com/manuals/PODFARM/
http://line6.com/manuals/PODFARM/
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Registering your Line 6 hardware is also very important because it ensures that you’re dialed in for 
warranty service and makes it possible for us to contact you if new software versions or other cool 
enhancements are offered - cutting edge technology and such! So don’t put this off any longer. Connect 
your Line 6 hardware to your computer and follow these steps to launch Line 6 Monkey: 

•	 On Mac®, go to /Applications/Line 6 and double-click on Line 6 Monkey.

•	 On Windows®, go to the Start button menu/Programs/Line 6/Tools/Line 6 Monkey. 

Note: For the instructions on using Line 6 Monkey, product activation and license key management, 
please see the POD Farm 2 Basic User Guide (by launching the Help from within POD Farm 2, or by 
downloading it from POD Farm Online Help).

About This Guide…

This document is intended to provide basic setup information for Line 6 USB audio hardware and 
POD Farm 2 software with the most popular audio recording applications. The following sections 
provide setup information for both Mac and Windows systems. Use the Table of Contents or the 
Adobe® Reader® Bookmarks to jump directly to the chapter and sections relevant to your setup. 

Additional Online Resources

Hungry for more info? We’ve got plenty of helpful resources just a click away.

•	 Several additional Help documents covering the latest POD Farm news and support info, product 
Release Notes and more are available here:  

POD Farm Online Help

•	 Got a Line 6 FBV™ MkII Series Controller? Learn how to put that thing to work controlling 
POD Farm 2, POD Farm 2 Plug-In, or even your favorite DAW software! See the FBV MkII User 
Guides and MIDI info here:

FBV Online Help

•	 For technical support, choose from the many options listed on the Line 6 Support page, including 
the searchable Knowledge Base:

Line 6 Support

•	 Can’t get enough of that Line 6 gear, or want to check out the latest Add-Ons and accessories? 
Head on over to the Line 6 Store!

Line 6 Online Store

http://line6.com/manuals/PODFARM/
http://line6.com/manuals/PODFARM/
http://line6.com/dispatch/?appid=2097217558&page=manuals
http://line6.com/support/
http://www.line6.com/store/storefront.html
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•	 Join the Community! Line 6 users are welcome to join the Line 6 Online Community... The 
place to get:

•	 Free downloads of hundreds of Tone Presets for POD Farm 2.

•	 Free jam tracks.

•	 Free loops for GarageBand®, Acid®, Reason® and more.

•	 Free guitar lessons from LA session pros.

•	 Breaking news, links and video clips.

•	 Info on contests and special offers.

•	 Access to discussion forums, software updates and more.

Line 6 Community

http://line6.com/community/
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Line 6 Audio Driver Configuration
Now that you have your Line 6 USB audio device driver installed, its time to take a look at the 
settings and options for using your Line 6 gear in a computer recording setup! Note that there are some 
different options available, depending on your specific type of Line 6 device, so be sure to check the 
instructions describing your Line 6 hardware model.  

iLok Users: Since your POD Farm 2 & POD Farm Elements Plug-In license requires only that your iLok 
USB key is present on your system, you can use any make of audio interface for your DAW software and 
POD Farm 2 Plug-Ins (including a Line 6 USB audio device if you like) - just be sure to connect your iLok 
key to your computer whenever you want to use the POD Farm 2 or Elements Plug-Ins.

About the Line 6 Audio Driver

In the world of modern recording, a computer setup for audio recording, editing, mixing, etc. is referred 
to as a Digital Audio Workstation or “DAW”. A DAW typically consists of audio recording/editing 
software, an audio interface (or sometimes called “sound card”) and some variety of effects plug-ins. 
Your USB Line 6 device can, of course, fill the role of the audio interface since its high performance 
audio drivers can deliver the speed and quality of the most demanding audio applications! The audio 
interface driver is the key element of your audio hardware that you will see referred to by software 
applications, control panels and know-it-all computer audio geeks, so it’s a good idea that you learn a 
few things about your Line 6 device driver and its options. Things are a bit different on Mac® versus 
Windows® systems, and there are some feature differences between the specific Line 6 devices, so it is 
recommended that you refer to the POD Farm 2 User Guides, as well as the product manual for your 
specific device for the full info. To get you going, we’ll run through the main points here regarding the 
audio driver and its settings. Please refer to the Mac® section below Mac® OS X (10.4, 10.5 & 10.6) 
systems, and the Windows® section on page 2•19 for all Windows® XP, Windows Vista® & Windows® 7 
systems. 

*Note: The POD Farm 2 standalone application requires that you have a Line 6 POD Studio, TonePort or 
GuitarPort USB device connected. Only these Line 6 devices offer the proprietary ToneDirect Monitoring™ 
and driver functionality to output audio from the POD Farm 2 standalone application.

Mac® Driver Settings 

You can launch the Line 6 Audio-MIDI Devices dialog from within the Mac® System Preferences, or 
from the POD Farm 2 standalone application’s Preferences > Hardware tab. On Mac® systems, all Line 
6 hardware utilizes the Mac® OS X Core Audio driver format, which means that some of your Line 
6 device settings will be in the OS X Audio-MIDI Setup. You can get to this from within the Line 6 
Audio-MIDI Devices dialog (or, from the Finder by going to Applications > Utilities > Audio-MIDI 
Setup). 

Line 6 Audio-MIDI Settings - Driver Tab

POD Studio, TonePort & GuitarPort devices – The following example shows UX2 as the selected 
device, with the POD Farm 2 standalone* software running.  If you have the UX8 hardware, you’ll 
have even more options, so be sure to also read up on the UX8 specific sections where noted.

POD X3 & PODxt devices - You’ll see some differences with a POD X3 or PODxt device selected – 
as noted in the following description.

http://line6.com/manuals/PODFARM/
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1                                 2                                    3                   4

5

6

7

1 – Line 6 Device selector: Allows selection of any supported Line 6 USB audio device that is 
connected. Note that if you have more than one supported device connected, each will be individually  
selectable in this list, regardless if it is in use by the POD Farm 2 standalone application or not. If your 
device is not connected and powered on, it will not appear in this list.

2 – Selected Device Icon: An icon for the selected Line 6 Device appears here.

3 – Driver Version: Displays the current device’s installed driver version number. 

4 - ESN: Displays the current device’s unique Electronic Serial Number.

5 – Run Audio MIDI Setup button: On Mac® systems, Core Audio device driver settings are typically 
configured in the OS X Audio MIDI Setup utility. This button launches the utility for you (see following 
OS X Audio MIDI Setup Dialog section).

6 – Sample Rate Converter Active indicator: POD Studio, TonePort and GuitarPort devices support 
44.1 and 48 kHz sample rates natively, and support 88.2 and 96 kHz sample rates by way of an internal 
sample rate converter.* This indicator lights up to show you when this converter is active, which 
can be any time your audio software is requesting a different sample rate than the one your device 
“natively” supports or is “fixed” at (see the Force Driver Format checkbox description below). 

*UX8 and POD X3 hardware supports 44.1, 48, 88.2 and 96 kHz sample rates natively.

7 – ToneDirect & USB Streaming Buffer Size slider: Use this slider to adjust the latency of the 
ToneDirect (POD Studio & TonePort devices) or USB Streaming (POD X3 & PODxt devices) 
monitoring signal. Lower slider settings offer less latency but utilize more CPU power from your 
computer. Higher values offer less CPU usage and can resolve audio drop-out issues. It is recommended 
to start at a lower value, as shown above, and move the slider slightly to the right only if you experience 
drop-outs in your monitor signal. Note that larger buffer size slider settings here will also impact the 
audio driver buffer, where your DAW’s overall audio latency will also be increased slightly.  
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Mac® OS X Audio MIDI Setup Utility

For UX8, please see the following UX8 audio driver section on page 2•7.

5a

5b

5c

5d

5e

5f
The Audio MIDI Setup utility - Mac OS® X 10.4 & 10.6*

*Note: The Audio MIDI Setup utility window within Mac OS® X 10.6 has a slightly different 
layout, but offers the same options and functionality as described here.   

5a – System Settings: 

•	 The Default Input and Default Output options allow you to choose the audio interface you 
want your Mac® multimedia applications (iTunes®, QuickTime® Player, etc.) to use by default. If 
you want this to be your Line 6 device, select it here. 

Note: POD Farm 2 in standalone operation automatically uses only the POD Studio or TonePort 
device which holds your POD Farm 2 license for its audio input & output, regardless of these 
“Default” settings. Most DAW applications also offer their own audio device input & output 
options, which are independent of these “Default” settings.   

•	 The System Output option allows you to choose which sound card the Mac® System sounds 
are played through. You may NOT want to choose this to be your Line 6 device, since it can be 
rather annoying to hear those dings, beeps or frogs croaking at blaring volumes in your monitors 
when working in your audio application! Even better, you can turn these system settings off 
completely (see “System Sounds and Alerts” on page 2•12).

5b – Properties For: Choose your Line 6 device here to allow the Audio Input and Audio Output 
options to display its settings.

5c – Audio Input:

•	 In the top selector, you will be able to choose the Record Send for your Line 6 device to view its 
format settings below. 

•	 The Format selectors show you the Sample Rate* and Bit Depth that the Line 6 device is 
operating at for recording. The Bit Depth for all Line 6 devices is fixed at 24 bit. 
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5d – Volume sliders (audio input): These sliders will adjust the recording level for the selected device. 
For Line 6 hardware, also use the POD Farm 2 standalone Mixer sliders and/or the Tone’s Volume 
controls to set your Record Send levels. 

5e – Audio Output:

•	 The Format selectors show you the Sample Rate* and Bit Depth that the Line 6 device is 
operating at for playback. The Bit Depth for all Line 6 devices is fixed at 24 bit. 

*It is recommended that you do not use the Sample Rate selectors in the Mac® Audio-MIDI 
Setup dialog to set your sample rate when your recording software is running. Typically, your 
recording software will offer a Sample Rate option within its own “Preferences” or “Audio 
Setup” settings. It is best to configure the Sample Rate within the recording software for your 
project, and you will see the device’s sample rate switch automatically to match it.  

5f – Volume sliders (audio output): These sliders will adjust the playback level for the selected 
device. For  Line 6 devices, it is recommended to keep these set to 100% and instead use the POD 
Farm 2 standalone application’s Volume controls (or the Volume knobs on your Line 6 hardware) 
adjust output levels.

Line 6 Audio-MIDI Devices - Inputs & Recording Tab

Note - If you are using a UX8 device, please skip to the UX8 audio driver section on page 2•7.

1

2

3

1 - Input Select Menu: This allows you to select which physical input “source” is fed through the Line 
6 USB hardware (Mic 1, Instrument, etc.) Note that this menu is ONLY visible when the POD Farm 
2 standalone software is not in use by the Line 6 hardware. When POD Farm 2 is in use, the Input 
Source  (as well as the Record Sends) is configured within the POD Farm 2 standalone application’s 
Mixer View. 
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When the POD Farm 2 standalone application is not in use by the selected Line 6 device, this Input 
Source menu is visible and offers a list of input options. The options will differ depending on the Line 
6 device - POD Studio or TonePort UX2 displays the following:

When POD Farm 2 standalone is not 
running, the Input Source Select menu 
is available. As shown here, UX2 
offers several input Sources to choose 
from. The selected Source is what gets 
routed to the device’s Main Outputs 
and Record Sends. 

GX, DI and GuitarPort devices are always “fixed” to only route their 1/4-inch input signals. With 
one of these devices, this Input Source Select list offers only “Instrument” as the source. 

POD X3 and PODxt devices are “fixed” to route their input signals. With one of these devices 
there is no Source Select menu displayed in the dialog. 

2 – Record Sends info box: One line for each Record Send appears here along with a general 
description for each Send.

POD Studio, TonePort & GuitarPort devices (except UX8) show two stereo Sends (1-2 and 3-4):

The Record Sends description shows the 
Input Source, and informs you if that signal 
is “processed” or not. When POD Farm 
2 standalone is not running, the Record 
Sends carry “unprocessed” audio.

POD X3 devices show a list of 5 Record Sends:
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Note that the type of signal that is fed to each Send is configured on the POD X3’s on-board Outputs 
settings screen. For example, Send 1-2 carries the same “Direct/Studio” signal you hear on POD X3’s 
Main outputs, which could be just Tone 1, or some combination of Tone 1 & 2. Your POD X3 Output 
screen options allow you to mute, pan or swap Tone 1 and Tone 2, so these options will, of course, 
also affect what is fed to the Sends. Please refer to your POD X3 Pilot’s Handbook for details on the 
Output screen options and especially to learn more about the unique POD X3 Dual Tone feature. 

POD X3 also offers a Monitor Level slider in this tab as well - you can use this to independently adjust 
your POD X3 monitor signal while recording (independently of the Send signal level that is being 
recorded).

PODxt devices show only one Record Send (Record 1-2). 

The type of signal that is routed to the Record Send 1-2 is determined by the PODxt Signal Routing 
option within the Audio Signal Routing menu at the left. PODxt also offers a Monitor Level slider in 
this tab as well - you can use this to independently adjust your PODxt monitor signal while recording 
(independently of the Send signal level that is being recorded).

3 - Hardware Meters Show: For Line 6 devices that offer the on-board VU style meters (UX2 & 
KB37), this menu allows you to select what signal the meters measure (the selected Input, Main 
Output, Record Sends Output, or ToneDirect Monitor Output).
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Line 6 Audio-MIDI Settings - Inputs & Recording Tab (UX8 Only)

2

3

4

5

1

1 – Input Source Select: UX8 offers 8 individual input sources, each with its own selector where you 
can choose which physical input is to be used for each. Input source options are as follows:

Input 1: Instrument 1 or XLR 1 or Line 1 or S/PDIF (L) 
Input 2: Instrument 2 or XLR 2 or Line 2 or S/PDIF (R)
Input 3: XLR 3 or Line 3
Input 4: XLR 4 or Line 4
Input 5: XLR 5 or Line 5
Input 6: XLR 6 or Line 6
Input 7: XLR 7 or Line 7
Input 8: XLR 8 or Line 8

Using Inputs 1 & 2 with the POD Farm 2 standalone application

The POD Farm 2 standalone application works with the UX8 driver to provide ultra-low latency via 
ToneDirect™ Monitoring for Inputs 1 & 2 of the UX8, which includes two high-Z Instrument inputs, 
two XLR inputs, two Line level inputs and stereo S/PDIF input. ToneDirect Monitoring is ideally 
suited for recording guitar and bass with amp and effects processing, providing the instantaneous feel 
necessary for competent performance while tracking.
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When POD Farm 2 standalone is not running, 
the Input 1 & input 2 selectors are available. As 
shown here, UX8 offers several input Sources to 
choose from. The selected Source is what gets fed 
to the Record Send. 

Stereo Paired Inputs

You can also link inputs into stereo pairs. This affects 
hardware monitoring controls in the Outputs & 
Monitoring tab (see below).

2 – Record Sends info box: This box displays the names of the UX8 input sources as they appear in 
Mac® recording applications utilizing the UX8 Core Audio driver, along with a description of what 
each Send is carrying. The UX8 Input Sources 1 through 8 are mapped directly to the corresponding 
Send number (i.e. - Inputs 1-2 are fed to Record Send 1-2). Sends 9-10 and 11-12 will carry a different 
signal depending on if the POD Farm 2 standalone application is running.

If the POD Farm 2 standalone application is not currently running, then you’ll see the list appear 
as follows:

When POD Farm 2 standalone is not running, Sends 
9-10 and 11-12 carry the Input 1 (dry, unprocessed) 
signal

If the POD Farm 2 standalone application is currently running, then Sends 9-10 and 11-12 carries the 
type of signal defined within the POD Farm 2 Mixer view - Record Send Source menus (Processed, 
Semi-Processed or Dry). See the POD Farm 2 Basic User Guide for more about the Mixer View 
options.

3 - Clock Source: Set your preferred UX8 clock source with this menu. Select “S/PDIF” to sync the 
UX8 to an external S/PDIF clock source from another device’s digital output. If you are not connecting 
anything into the UX8 digital S/PDIF input, then keep this set to “Internal” to use the UX8 clock.

4 - Hardware Meters Show: This selector allows you to choose what the VU meters on the front of 
UX8 are measuring. Note that these hardware meters function even if the POD Farm 2 standalone 
software is not currently running.
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5 - Restore Defaults: Click this button to restore all this tabs settings to their original, default values.

Outputs & Monitoring Tab (UX8 Only - Mac®)

Important: Note that the Outputs & Monitoring tab provides control over monitoring levels - that 
is, what you hear coming from whatever you plugged into the UX8 Mic or Line inputs. These controls 
do not affect the level of the signals fed to the Record Sends. Volume and pan levels here are purely 
analog, intended for monitoring live input levels (from instruments, mics, etc.) and computer audio 
output levels, in order to facilitate the recording process. 

The Outputs & Monitoring tab provides control over hardware monitoring settings, including input 
source volume, pan and mute states. You can specify different mix settings for each pair of UX8 outputs 
if you like. 



POD Farm 2 Recording Setup Guide - Audio Driver Configuration

2•10

By default, the only sounds that come out of the UX8 are the computer’s output and POD Farm 2 
9-10 signal, all through Main Outs 1-2. You can directly monitor other UX8 inputs by un-muting 
(unchecking the Mute checkbox for) the corresponding input source in this tab. UX8 provides 
monitoring through the hardware with zero latency, which is ideal for tracking with multiple sources 
simultaneously.

Use the drop-down menu at the top 
to select the output pair for which you 
want to mix. Each output pair allows 
independent mix settings.

Mix Controls

Inputs 1 - 12 offer the following controls:

Mute (On/Off) 	     Monitor Volume (-100dB to +6dB)     

Monitor Pan (100% Left - 100% Right)*      Stereo Monitor Meters    

* -3dB panning law is applied to the pan control to maintain a constant monitoring level across the 
panorama.

Main Monitor Volume

This slider controls the overall monitoring volume for the current output pair. What you hear is 
displayed in the adjacent level meter and includes the combination of input sources and computer-
generated signals, such as those assigned to the current output from within your recording software. 
Note that computer-generated signals are unaffected by the volume slider. The level meter’s clip LED 
graphics light up when the signal reaches 0 dB.

Main Mix vs. Talent Mix

The UX8’s two front panel headphone outputs mirror Outs 1-2 and 3-4, respectively. You can use the 
monitor controls, for example, to create a “main mix (1-2)” that captures the overall image of the 
recording project, while a separate “talent mix (3-4)” can be provided for the musician who is currently 
performing a new part (you know, the guy asking for “more me” in his phones), and may need a click 
track and an ample level of themselves above the rest of the mix. Additional output pairs 5-6 and 7-8 
are available for headphone mixers or sending to a mixer, other monitors, etc.
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Stereo Pairs

When the “Stereo” checkbox is active in the Inputs & Recording tab for a pair of Inputs, the 
representative Inputs in the Outputs and Monitoring tab will display them as “locked” as a stereo pair.

The lock icon represents two sources linked as a stereo pair.  

The Pan sliders for a “locked” stereo pair are automatically set to 100% Left and Right.

Using Tool Tips

You can obtain precise value readings for output levels, volume sliders and pan sliders. Do this by 
hovering the mouse cursor over the meter or slider you wish to read.
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Mac OS® X System Preferences Settings

There are a few System Preferences that you should configure when using your Mac® for audio recording. 
Launch the Mac OS® X System Preferences utility to make the following settings.

System Sounds and Alerts

When using your Line 6 USB hardware as your audio device, you likely will not want to hear these 
system sounds, and you certainly don’t want to end up recording them by mistake! You can adjust the 
volume independently for these system sounds and alerts by going to the Sound page.

In the Sound Effects page, adjust 
the Alert volume slider down, 
and uncheck the Play user 
interface sound effects and Play 
user interface sound effects 
checkboxes

Choose Sound in your Mac’s 
System Preferences utility
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Energy Settings

It is also a good idea to configure your Energy settings so that critical computer components do not go 
to “sleep” or run at less than full.

Choose Energy Saver in the 
System Preferences utility

Choose Power Adapter  
You can also select Battery if you 
have a laptop and repeat all the steps 
in this section, but you may want 
your settings to conserve battery 
power - just keep these settings in 
mind if recording when running on 
battery power.

Set the top slider all the way to 
Never so that the computer is not 
allowed to enter “sleep” mode

Uncheck this box so that your 
hard disk does not go to sleep
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Configuration as an Aggregate Device (Mac® only)

Combine your Line 6 POD Studio, TonePort, GuitarPort, POD X3 or PODxt with other Core Audio 
devices using the Mac® OS X® Aggregate Device feature.

Note: The OS X Aggregate Devices functionality is not officially supported by Line 6 or most audio 
hardware manufacturers since, of course, it is not feasible to test the vast number of possible audio interface  
combinations. However, it is possible to combine one Line 6 USB device with another (non-Line 6) audio 
device for the combined functionality as described here - your exact performance may vary with different 
hardware. 

Starting in Mac OS® X version 10.4.x (Tiger®), this Mac® feature allows you to configure two or 
more Core Audio devices into one Aggregate Device. As the name suggests, this makes it possible to 
combine multiple connected audio devices allowing audio applications to utilize all inputs and outputs 
as one virtual Core Audio device. The Aggregate Device feature also provides the ability to sync the 
devices, and resample, if needed, to allow them to work together with your audio application. This can 
be quite useful if you have another Core Audio sound card and want to use your Line 6 hardware along 
with it to provide additional inputs for recording, or additional outputs for sending multiple playback 
or monitoring mixes.

In this section, we’ll be showing you how to create a simple Aggregate Device using your Line 6 
hardware and your Mac® Built-in Audio device Inputs and Outputs. The steps are similar for combining 
Line 6 hardware with other models of audio devices, as long as they offer a Core Audio driver that 
supports this Mac OS® X feature. 

Be sure to connect the USB cable from your Line 6 hardware into your computer’s USB port, and then 
proceed with the following steps.	

			 

Creating an Aggregate Device

First, connect your Line 6 hardware to your Mac® USB port (a USB 2.0 port is required for UX8 and 
POD X3 devices, all other Line 6 devices can use a USB 1.1 or USB 2.0 port). All the required settings 
you need to create an “Aggregate” device are made within the Aggregate Device Editor window, 
which is found in the Mac® Audio MIDI Setup utility. 

Go into the Mac® System Preferences, select the Line 6 Audio-MIDI Devices (in the Other 
category), and in the Driver tab of the Line 6 dialog, click on the Run Audio MIDI Setup button.
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Click on the “+” button to create a 
new Aggregate Device - it will then 
appear in the above pane

All detected Core Audio devices are 
then listed in the Structure pane

Select Open Aggregate Device 
Editor from the Audio menu

Click on the “Use” boxes for all Audio 
Devices to activate them. (Click your 
Line 6 device’s “Use” box first to make 
it the first device in the list.)  Check the 
boxes for both the “Built-in Input” and 
“Built-in Output” so they can be used 
for both recording and playback.

IMPORTANT! Always set your Line 
6 hardware to be the assigned Clock 
device Keep the Resample checkboxes 

unchecked unless necessary*

When creating an Aggregate Device, only one audio device can be designated as the “Clock.” This 
means that the designated device acts as the “master” and all other devices follow its digital clock, 
thus keeping all your audio in sync. Even though the Aggregate Device dialog allows you to set any 
individual Audio Device as the Clock, be sure that your Line 6 hardware is set as the clock, as shown 
above, to ensure proper sync. 

*The Aggregate Device Resample function - When combining audio devices, the sample rates must 
match to allow them to be used together. But if you run into sync problems when using some devices 
together, or in the case where you need to choose a sample rate not commonly supported by all audio 
devices, you can check the Resample checkbox for the device. This instructs the Aggregator to 
automatically perform a sample rate conversion to allow the audio devices to sync.

Once above settings are made, click the Done button to return to the Audio MIDI Setup window.
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You are now able to choose this new “Aggregate Device” in the menus of the 
System Settings. Choose your new Aggregate Device as the Properties For device

Now you will be able 
to access settings for 
all combined inputs 
and outputs! 

For the device we 
created, this totals 6 
Audio Inputs and 4 
Audio Outputs

The Audio Input and Audio Output sections each have a selector to allow you to choose each stereo 
device, and then make settings for each with the set of controls below.

You will now see all devices’ inputs 
in the Audio Input selector. 
Likewise, you will see all outputs in 
the Audio Output selector

Note the order in which these Inputs and Outputs appear in the Audio-MIDI Setup dialog. In our 
example, Line 6 device “Record Send” inputs are listed first because we made it the first device in the 
Aggregate Device Editor dialog. The “Stream 3” input is from the Built-in Audio device, and appears 
last. These input and output ports will also appear in this same order within your audio recording 
software, but likely will not have any other identifying name other than their order number.



POD Farm 2 Recording Setup Guide - Audio Driver Configuration

2•17

Using an Aggregate Device with Audio Recording Software

Once an Aggregate Device is created on your Mac, you should then be able to access it in your recording 
software. As an example, we’ll be showing you how it appears in the included Ableton Live software.

Launch the Ableton Live software and open the Preferences to configure the audio device.

Go to the Live menu 
and choose Preferences

Just as with most DAW software, in Live you also need to configure the 
individual inputs and outputs once a Multi-in/out device is selected. Click on 
the Input Config button to access the Inputs

Go to the Audio tab

Choose CoreAudio as the driver type

Then choose the Aggregate Device that 
was just created for both the Input and 
Output Audio Device. Note that this 
appears along with the individual audio 
devices in these menus as an additional 
selectable device

Set a Sample Rate – preferably this 
should be one supported by all the audio 
devices that make up your Aggregate 
Device. Once all other settings are 
complete, click the Input Config button 

By default, Live will usually have only the first 
device enabled. Activate the desired devices 
here to allow them be available as recording 
inputs in the Live software. Note that each 
additional active devices utilizes more CPU, so 
only activate the ones you need!

Click OK when done

As noted earlier, you’ll need to refer to the order of the devices in the Audio MIDI Setup window to 
know which are Line 6 hardware ins, and which are from the other device since Live does not show the 
individual device names.

Next, click the Output Config button in the Live Preferences window to similarly activate multiple 
outputs.
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Click on additional output devices to make 
them available as playback outputs in Live if 
desired.* Here again, activate only the ones you 
need to avoid excess CPU usage

Click OK when done

* Note: The Ableton Live Lite, Line 6 version has a restriction that allows only one stereo output to be 
used at a time. To be able to choose two or more different output devices in a Live Set, you must switch 
into Demo mode, or upgrade to a full version of Ableton Live.

You can now continue to use Ableton Live and all inputs and outputs will appear within the audio 
track menus, just as if all exist on one sound card!

All inputs appear in the Live 
audio track input menu

For more information regarding the Aggregate Device feature, check your Mac® OS X documentation.
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Windows® Driver Settings 

The following settings are the same for Windows® XP, Windows Vista® or Windows® 7, 
unless otherwise noted. 

Be sure to first connect your Line 6 hardware directly to your computer’s USB port and then launch the 
Line 6 Audio-MIDI Devices utility from within the Windows® Control Panel. This is the place where 
you can access the audio driver settings for your connected device to see and configure things such as 
the current Sample Rate, Bit Depth, Buffer settings, Record Sends, etc. For the Windows® recording 
software applications covered in this document, it is always recommended that you use the ASIO 
audio driver. When prompted for ASIO driver settings, this is where you will make them. This dialog 
offers controls specifically for your connected Line 6 hardware. 

Line 6 Audio-MIDI Devices - Driver Tab

POD Studio, TonePort & GuitarPort - This example shows UX2 as the selected device, with POD 
Farm 2 running in standalone mode. You’ll see some differences with a POD device selected, which are 
noted in the following diagram. If you have a UX8 device, you’ll have even more options, so be sure 
to also read up on the UX8-specific sections, starting on page 2•25.

4

5

6

7

8

9

10

11

1			    2		                        3

1 – Line 6 Device selector: Allows selection of any supported Line 6 USB audio device that is 
connected. Note that if you have more than one supported device connected, each will be selectable 
in this list, regardless if it is in use by the POD Farm 2 standalone application or not. If your device is 
not connected and powered on, it will not appear in this list.
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2 – Selected Device icon: An icon for the selected Line 6 Device appears here.

3 – Driver Version: Displays the current device’s installed driver version number. 

4 – ESN: Displays the current device’s unique Electronic Serial Number.

5 – ASIO Client: If you are running audio software that is using this Line 6 device as its ASIO sound 
card, the name of the software will appear here. If not in use by an ASIO software, “none” is displayed 
here, as shown in the above example.

6 – Buffer Size: The ASIO buffer size in use. Note this field is only active when in use by an ASIO 
application. As your DAW software documentation will likely tell you, the ASIO Buffer Size will affect 
the “responsiveness” and “latency” of the DAW software. The lower the setting, the faster the response, 
but with the trade-off of higher processor usage and the risk of audio dropouts. Raise the value if you 
are getting inconsistent playback or recording in the audio software. Basically, 256 is generally a good 
average setting to start with for modern PC’s.*

*Note that Line 6 devices also offer ToneDirect™ Monitoring / USB Audio Steaming, which 
is a separate audio path with its own Buffer setting. This allows you to keep the above ASIO 
Buffer Size at a high “stable” value, yet still benefit from low latency monitoring of your input 
signal while recording.

7 – Bit Depth: The ASIO bit depth in use. Note this field is only active when in use by an ASIO 
application. It is recommended to use the 24-bit option here as well as the 24-bit option within your 
ASIO recording software. (If your ASIO audio software only supports, or is set to 16-bit, then it is 
recommended to set your Line 6 hardware’s Bit Depth setting here also to 16-bit to match.)

8 – Sample Rate Converter Active indicator: POD Studio, TonePort & GuitarPort devices support 
44.1 and 48 kHz sample rates natively, and also support 88.2 and 96 kHz sample rates by way of an 
internal sample rate converter. This indicator lights up to show you when this converter is active, 
which can be any time your ASIO® software is requesting a different sample rate than what your device 
“natively” supports. UX8 and POD X3 family devices support 44.1, 48, 88.2 and 96 kHz sample rates 
natively.

9 – Driver Operation indicator: 

POD Studio, TonePort & GuitarPort devices - Displays what sample rate and bit depth the current 
device is operating at (or with no text if not in use). 

10 – Lock Driver Format: When checked, this forces the Line 6 audio driver to operate at the Sample 
Rate and Bit Depth settings entered in the two fields below (as opposed to following the sample rate 
requested by a Windows® audio application). 

Note: This checkbox will remain grayed-out while the current Line 6 device is in use by the 
POD Farm 2 standalone application and/or any 3rd party DAW application. To access the Force 
Driver Format feature, you will need to exit POD Farm 2, as well as any audio software that 
might be using the currently selected Line 6 device as its audio device. This checkbox will then 
be selectable. 
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Windows Vista® & Windows® 7 users: You won’t see these options in this portion of the dialog since 
these driver format options are handled by Windows® itself. You will instead see a Sound Control 
Panel button - click this to launch the Windows® Sound panel.  Within the Sound panel’s Playback 
and Recording tabs you can designate your Line 6 USB device as the “Default” audio device if you 
want all your Windows® multimedia programs to utilize it as their sound card device (see “Windows® 
Default Sound Device Settings” on page 2•29). 

The Line 6 USB device selected as the Default Playback Device

You can also click on the Properties button in the Sound dialog and access the default format setting 
for the Sample Rate and Bit Depth for your Line 6 device when used with Windows® multimedia 
applications. (Note that if you are using an audio application that is set to utilize the ASIO driver for 
your Line 6 device, then ASIO communicates directly with the device, and these “default format” 
settings do not apply.)

The Window Vista/7 Control Panel>Sounds>Properties - Advanced tab

11 – ToneDirect - USB Audio Streaming Buffer Size: This slider adjusts the buffer size for the audio 
responsiveness of the ToneDirect Monitoring signal. Basically, the default setting should be fine for 
most systems, but if getting audio dropouts or working with large CPU demands on your system, raise 
the slider a notch or two to the right until it alleviates the problem. 
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Inputs & Recording Tab - Windows

Input Source Menu: This allows the user to select which physical input “source” is used on the Line 
6 USB hardware (Mic 1, Instrument, etc.). Note that this menu is visible only when the POD Farm 2 
standalone software is not in use by the Line 6 hardware. When POD Farm 2 is in use, the Input Source 
(and Record Sends) are configured within POD Farm 2 standalone application’s Mixer View. 

When POD Farm 2 standalone is not in use by the selected Line 6 device, this Input Source menu  
offers a list of input options. These options differ, depending on your specific Line 6 device.

For UX2 & KB37 devices 
only: Choose what signal 
your device’s VU Meters 
measure

GX, D.I. and GuitarPort are always “fixed” to only route their “instrument” 1 /4 input signal into 
POD Farm 2 standalone. 

PODxt & POD X3 devices do not offer an Input Source menu in this dialog.

TonePort UX8 has a larger set of options - see the UX8-specific sections, starting on page 2•25.

Record Sends Info box: One line for each Record Send appears here along with a general description for 
the signal each Send is carrying.  Refer to your specific Line 6 device type in the following descriptions.

Note that multiple Sends for your Line 6 device are only available when using the ASIO driver 
in your recording software. If your recording software is configured to access the device via its 
WDM or DirectSound driver, then only one Send will be available in the recording software 
(Send 1-2). 
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POD Studio, TonePort & GuitarPort devices (except UX8) show the following Sends:

TonePort devices show two stereo Sends (Record 1-2 and Record 3-4)

•	 Single Tone Source (Mono/Stereo): When the POD Farm Standalone application is not 
running, Record Send 1-2 and 3-4 both carry the unprocessed signal. When running POD Farm 
standalone, Record Send 1-2 and 3-4 carry the type of signal defined within the POD Farm 2 
Mixer View - Record Send Source menus (Processed, Semi-Processed or Dry). Please see the 
POD Farm 2 Basic User Guide for more about the Mixer View options. 

POD X3 devices show a list of 5 Record Sends:

Note that the type of signal that is fed to each Send is configured using the POD X3 on-board Outputs - 
Studio/Direct Mix settings screen.  To put it another way, Send 1-2 is fed the same “Studio/Direct Mix” 
as your main outputs, which could be just a Tone 1, or some combination of Tone 1 & 2, depending on 
how you set the Studio/Direct mix controls. Please refer to your POD X3 Pilot’s Handbook for details 
on the Output screen options and especially about POD X3’s unique Dual Tone operation. 

POD X3 also offers a Monitor Level slider in this tab as well - you can use this to adjust your POD 
X3 hardware monitor signal while recording (independently of the Send signal level that is being 
recorded).
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PODxt devices show one Record Send (Record 1-2). 

The type of signal that is routed to the Record Send 1-2 is determined by the PODxt Signal Routing 
option within the Audio Signal Routing menu at the left. PODxt also offers a Monitor Level slider in 
this tab as well - you can use this to adjust your PODxt monitor signal while recording (independently 
of the Send signal level that is being recorded).

Hardware Meters Show: For Line 6 devices that offer the on-board VU style meters (UX2 & KB37), 
this menu allows you to select what signal the meters measure (the selected Input, Main Output, 
Record Sends Output, or ToneDirect Monitor Output).
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Line 6 Audio-MIDI Devices - Inputs & Recording Tab (UX8 only)

The Inputs & Recording tab lets you select specific inputs for recording. Input Source options are as 
follows:

Input 1: Instrument 1 or XLR 1 or Line 1 or S/PDIF (L) 
Input 2: Instrument 2 or XLR 2 or Line 2 or S/PDIF (R)
Input 3: XLR 3 or Line 3
Input 4: XLR 4 or Line 4
Input 5: XLR 5 or Line 5
Input 6: XLR 6 or Line 6
Input 7: XLR 7 or Line 7
Input 8: XLR 8 or Line 8

You can also link inputs into stereo pairs. This affects 
hardware monitoring controls in the Outputs & 
Monitoring tab (see below).
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Using Inputs 1 & 2 with the POD Farm 2 standalone application

The POD Farm 2 standalone application works with the UX8 driver to provide ultra-low latency via 
ToneDirect™ monitoring for Inputs 1 & 2 of the UX8, which includes two high-Z Instrument inputs, 
two XLR inputs, two Line level inputs and stereo S/PDIF input. The UX8 ToneDirect™ Monitoring is 
ideally suited for recording guitar and bass with amp and effects processing, providing the instantaneous 
feel necessary for competent performance while tracking.

ASIO® Record Sends

This box displays the ASIO® names of the UX8 input sources as they appear in recording applications 
utilizing the UX8 ASIO driver, along with a description of what each Send is carrying. UX8 Input 
Sources 1 through 8 are mapped directly to the corresponding Send number (i.e. - Inputs 1-2 are fed to 
Record Send 1-2). Sends 9-10 and 11-12 will carry a different signal depending on if the POD Farm  2 
standalone application is running.

If the POD Farm 2 standalone application is not currently running, then you’ll see the list appear as 
follows:

When POD Farm 2 standalone is not running, Sends 
9-10 and 11-12 carry the Input 1 (dry, unprocessed) 
signal

If the POD Farm 2 standalone application is currently running, then Sends 9-10 and 11-12 will carry  
the type of signal defined within the POD Farm 2 Mixer view - Record Send Source menus (Processed, 
Semi-Processed or Dry). Please see the POD Farm 2 Basic User Guide for more about the Mixer 
View options. 

Hardware Meters Show

Use this menu to select the input and output 
levels you want the UX8 front panel hardware 
meters to display. 

Clock Source

Set your preferred UX8 clock source with this menu. 
Select “S/PDIF” to sync the UX8 to a S/PDIF clock 
source from another device’s digital output.
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Outputs & Monitoring Tab (UX8 Only - Windows®)

Important: Note that the Outputs & Monitoring tab provides control over the monitor volume of 
whatever you are inputting into UX8. These controls do not affect Send levels (the audio that streams 
out to your recording software), nor do they control the level of audio coming from your computer 
(such as the playback level of your software’s project). In other words, volume and pan levels here are 
purely analog, intended for monitoring live input levels (from instruments, mics, etc.) to provide you 
with independent level control over these items versus the playback levels of your audio software’s 
tracks. 

You can specify different mix settings for each pair of UX8 outputs if you like. By default, the only 
sounds that come out of the UX8 are the computer’s output and POD Farm 2 Record Send 9-10 
signal (determined by the POD Farm 2 Mixer View - Record Send settings), all through the physical 
Main Outs 1-2.  You can directly monitor other UX8 inputs by un-checking the Mute checkbox for 
the corresponding input source in this tab. Note that the Mute and volume controls here only act 
upon inputs (your guitar, bass, mic etc., plugged into the UX8), and not audio coming from your 
computer (such as the playback of your DAW software session). UX8 provides monitoring of these dry 
input signals through the hardware with zero latency, which is ideal for tracking with multiple sources 
simultaneously.

Use the drop-down menu at the top to 
select the output pair that you want to mix. 
Each output pair provides independent mix 
settings.
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Mix Controls

Inputs 1 - 12 offer the following controls:

Mute (On/Off) 	     Monitor Volume (-100dB to +6dB)     

Monitor Pan (100% Left - 100% Right)*      Stereo Monitor Meters    

* -3dB panning law is applied to the pan control to maintain a constant monitoring level across the 
panorama.

Main Monitor Volume

This slider controls the overall monitoring volume for the current output pair. What you hear is 
displayed in the adjacent level meter and includes the combination of input sources and computer-
generated signals, such as those assigned to the current output from within your DAW software. Note 
that computer-generated signals (e.g. - the playback audio from your DAW software’s session) are 
unaffected by the volume slider. The level meter’s clip LED graphics light up when the signal reaches 
0 dB.

Main Mix vs. Talent Mix

The UX8 two front panel headphone outputs mirror Outs 1-2 and 3-4, respectively. You can use the 
monitor controls, for example, to create a “main mix (1-2)” that captures the overall image of the 
recording project, while a separate “talent mix (3-4)” can be provided for the musician who is currently 
performing a new part, and may need a click track and an ample level of themselves above the rest of 
the mix (you know... the guy asking for “more me” in his headphones). Additional output pairs 5-6 
and 7-8 are available for headphone mixers or sending to an external tape deck, other monitors, or 
whatever else you might want to send out a customized mix to.

Stereo Pairs

When the “Stereo” checkbox is active in the Inputs & Recording tab for a pair of Inputs, the 
representative Inputs in the Outputs and Monitoring tab will display them as “locked” as a stereo pair.

The lock icon represents 
two sources linked as a 
stereo pair.  

The Pan sliders for a 
“locked” stereo pair are 
automatically set to 
100% Left and Right.
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Using tool tips

You can obtain precise value readings for output levels, volume sliders and pan sliders. Do this by 
hovering the mouse cursor over the meter or slider you wish to read.

Windows® Default Sound Device Settings

Windows® makes use of a sound card device to be able to play all those dings, beeps and other system 
alerts. Additionally, most Windows® Internet and multimedia applications such as Windows® Media 
Player®, iTunes®, etc., will automatically set themselves to use the Windows® “default” audio device 
for audio playback  & recording as well. You can set your Line 6 device to be this default device if you 
like. To follow are the  separate instructions for Windows® XP and Windows® 7/Vista®.

 

Note: POD Farm 2 in standalone operation will always utilize your POD Studio or TonePort device, 
regardless if your Line 6 device is set as the Windows® default audio device. Also, most DAW applications 
typically offer their own, independent sound card device selector.

Windows® XP Default Sound Device

Go to your Windows® Control Panel > Sounds and Audio Devices > Audio tab. In the Sound 
Playback section, choose your Line 6 device as the Default device. Do the same in the Sound 
Recording section if you also want to set your Line 6 device as the default recording device.

 

UX2 set as the Windows® Default device for 
Playback and Recording

If you have a Windows® software that   
requires MIDI playback, then you can also 
choose the GS Wavetable Device here, 
which is a “software synthesizer” included in 
Windows®. Its output will also play through 
the  Default Playback Device.

Note: If setting a Line 6 device that offers multiple Source Inputs (UX1, UX2, UX8 & KB37) as the 
default sound recording device, use the Source Input menu within the Line 6 Audio-MIDI Settings 
application to select the device’s specific input that you want to record from (see page 2•19).
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The Windows® Mixer utility is automatically configured to control the Windows® default audio 
device. This is important to be aware of since it means that all the controls in the Windows® Mixer’s 
“Wave” and main “Volume” sections (Pan, vertical Level slider and Mute checkbox) will affect your 
Line 6 device’s input & output levels if it is set as the default device. 

Note: If you have one of the fancier computer keyboards or a laptop that include volume and mute buttons, 
then they likely will adjust these same default device/Windows® Mixer controls.

To Launch the Windows® Mixer in Windows® XP - Go to the Windows® Control Panel > Sounds 
and Audio Devices > Volume tab. From the previous step, your Line 6 device should already be set as 
the Windows® default audio device. Click the Advanced button to launch the Mixer.

These Windows® Mixer Volume and Wave controls 
affect the Windows® default device’s playback output

You may want to just keep the above Playback levels set to 100% and just use your volume controls on 
your Line 6 hardware and within the POD Farm 2 standalone software. 

To access the Windows® Mixer Recording controls, go to the Options menu > Properties and choose 
the Recording option.

These Windows® Mixer Volume 
and Pan controls affect the 
Windows® default device’s 
Recording input
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Windows®  7 & Windows Vista®  & Default Sound Device

Go to your Windows® Control Panel > Sounds dialog. In the Playback and Recording tabs, select 
your Line 6 device and choose “Set Default” in the menu at the bottom of the window to set it as the 
Default audio device. 

The Windows® 7/Vista® Sound Control Panel - Playback & Recording “Default” Devices

Note: If setting a Line 6 device that offers multiple Source Inputs (UX1, UX2, UX8 & KB37) as the 
default sound recording device, use the Source Input menu within the Line 6 Audio-MIDI Settings 
application to select the device’s specific input that you want to record from (see page 2•19).

Click the Properties button within the Playback or Recording tab to access the Levels tab, where you 
can adjust the selected device’s Playback or Recording levels. For the Playback level slider, you may 
want to just keep this set to 100% and just use your volume knobs on your Line 6 hardware and within 
the POD Farm 2 for easier volume control.

The Windows® 7/Vista® Playback or Recording - Properties - Level tab

Note: If you have one of the fancier computer keyboards or a laptop that include volume and mute buttons, 
then they likely will adjust these same default device Level controls.
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On Windows® 7 & Vista® only, you’ll see a “Listen” tab once you click the Sound panel > Recording 
tab > Properties button: 

Windows® 7 & Vista®: Sound Recording Properties - Listen settings

The “Listen to Device” checkbox and “Playback through...” menu, when configured as shown above, 
route any audio that is fed into an input on your Default Recording Device to the selected Playback 
device. For example, this allows you to hear an instrument, mic, or line in source plugged into your 
UX2 through the UX2 outputs - which you would not otherwise be able to hear unless running the 
POD Farm 2 standalone application (or if running a DAW application that offers input monitoring 
features). 

Note that once this “Listen to this device” box is checked, however, it will always route input audio 
to the device’s output. This may not be what you want when using POD Farm 2 and/or DAW software, 
since you’ll likely prefer to monitor only your POD Farm 2 processed or DAW track signal! Since this 
also utilizes the Windows® audio driver and internal routing, the input signal suffers a bit of delay 
before heard through your monitors (i.e. - not a “low latency” functionality, unlike the POD Farm 2 
ToneDirect Monitoring and the ASIO audio driver do provide). Therefore, it is not recommended to 
check this option with POD Farm 2 or DAW software running.

Disable System Alert Sounds

It can actually be quite annoying to have all those Windows®  system alert sounds blaring at high volume 
through your Line 6 device when you are trying to focus on more musical endeavors. Fortunately, you 
can independently turn off these system sounds and still keep your Line 6 device as your Windows® 
default playback device. While still in the Windows® XP or Windows® 7/Vista® Sound dialog, go to the 
Sounds tab. For the Sounds Scheme setting, choose No Sounds. Click OK to exit the dialog.
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Surround Playback

The POD Studio, TonePort, GuitarPort, PODxt and POD X3 playback capabilities are designed for 
stereo.* If you already have a sound card that provides surround sound via multiple speakers, this 
would be a feature that you would lose by making your Line 6 device your preferred audio device.

* Note that UX8 offers multiple physical outputs and can actually be configured for multi-channel surround 
output playback! Please see the documentation for your audio application and configuring a multi-channel 
sound card for Surround output.

S/PDIF Digital Output from Line 6 Hardware to an External Device

UX2, UX8, KB37, POD X3 and PODxt Pro devices all include a S/PDIF digital audio output, which 
allows you to connect to digital devices such as a DAT recorder, digital mixing console, another 
computer sound card, or most any device that offers a S/PDIF format digital audio input. POD X3 Pro 
and PODxt Pro additionally include AES/EBU digital outs, which can be used to connect to hardware 
that offers this type of digital input as well. Connecting digitally is the preferred method to transfer 
audio to external devices that support it since this does not require the added digital-to-analog-to-
digital signal conversion process as required with using analog outs. 

One type of recording setup where you might use the S/PDIF output of your Line 6 hardware is with 
a Digidesign Pro Tools® or Pro Tools® LE system. With any Pro Tools setup, your Line 6 hardware 
would not be the assigned sound card for the Pro Tools software (since Digidesign requires proprietary 
hardware), but you can still utilize it by connecting the Line 6 S/PDIF output into the S/PDIF input of 
the Pro Tools hardware. Likewise, if you prefer to use a different sound card with other audio applications 
and the unit includes a S/PDIF input, then you can still utilize your Line 6 device connected digitally. 
This way you are simply routing the digital audio from your Line 6 gear right into Pro Tools or other 
software with no signal degradation! 

We’ve provided detailed steps specifically for connecting a Line 6 device’s S/PDIF output to a Digidesign 
Mbox® 2 device in the Recording with Digidesign Pro Tools® LE chapters - try the links below to 
jump to these chapters. The steps are very similar if you are connecting to the S/PDIF inputs of other 
manufacturer’ sound card devices as well.

•	 Mac® - Digidesign Pro Tools® LE on page 5•37

•	 Windows® - Digidesign Pro Tools® LE on page 6•31

Considerations When Using S/PDIF or AES/EBU Output

•	 Some digital devices may only support one sample rate (some DAT and video machines are fixed 
at 48 kHz, for example), so you will want to be sure to choose a sample rate supported by both 
units.

•	 When connecting via S/PDIF between devices, it is best to use a special 75 ohm cable intended 
for this purpose (available at most pro audio or video shops). A standard “RCA” type analog 
audio cable will physically fit the typical S/PDIF jack on your gear, but is not correctly shielded 
or rated for this type of use.

•	 When POD Studio & TonePort UX2 and KB37 and PODxt Pro are operating at their 96 kHz 
“compatible” sample rate mode, they send data out the S/PDIF outputs at 48 kHz. The S/PDIF 
output is always sent as 24 bit.
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•	 Remember that if you are connecting your POD Studio, TonePort, POD X3 or PODxt Pro digital 
output to another audio interface, you are not limited to the other interface being on the same 
computer. You can use your POD Studio, TonePort or GuitarPort + POD Farm 2 in standalone 
operation on one computer as your “Tone Machine” - or POD X3/PODxt by itself - and then 
send the fully baked Tone digitally to a completely different setup for recording!

•	 For more specifics on digital input and output operation for TonePort, POD X3 or PODxt Pro 
please see the device’s User Manual.

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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POD Farm™ 2 & POD Farm Elements Plug-Ins

POD Farm™ 2 and POD Farm™ Elements Plug-Ins are amazing tools for computer recording since 
they  allow you to non-destructively apply any number of “POD®” amp, cab, mic, preamp and effects 
models on your recorded audio tracks, without needing to commit the settings until your final mixdown. 
POD Farm 2 & Elements Plug-Ins are compatible with VST®, AU and RTAS® Plug-In formats for use 
with all major Mac®  or Windows®  recording software “host” applications. If you want to get in on all 
the fun, you can purchase POD Farm 2 now without even getting out of your chair! Just run Line 6 
Monkey with your Line 6 USB device connected and go to the Optional Add-Ons tab, or head over 
to the Line 6 Online Store.

The POD Farm 2 Plug-In User Interface

The POD Farm Elements (Guitar Amps) Plug-In User Interface

http://www.line6.com/store/storefront.html


POD Farm 2 Recording Setup Guide - POD Farm 2 & Elements Plug-Ins

3•2

Using these Line 6 Plug-Ins with your favorite Digital Audio Workstation (DAW) host software gives 
you the freedom to change your Tone as often as needed and automate amp and effect settings with 
surgical precision. If you have experience with DAW host applications, then you have probably used 
audio effects Plug-Ins. Using POD Farm 2 Plug-In in your host is no different from using any other. 
Unlike most other Plug-Ins, however, POD Farm 2 is not just a one-trick pony! It is really a full suite 
of amp, preamp, cab, mic and effects models that you can utilize to apply on guitar, bass or vocals. 
Or, you can apply individual POD Farm 2 models or effects on any types of instruments, on as many 
tracks as you like, and even fully automate the parameters. Each POD Farm Elements Plug-In can be 
thought of as one “category” of models of POD Farm 2 (Guitar Amps, Bass Amps, Delays, Distortions, 
etc.) Having these as individual plug-ins further provides the flexibility of inserting virtually any 
combination of amps, preamps & effects, and in any desired order!

If you’re new to the world of recording software and Plug-Ins, read through the following tutorials in 
this chapter for using the Ableton Live DAW software. These should serve as helpful examples on how 
to configure and use POD Farm 2 & Elements Plug-Ins within most Mac® and Windows® DAW host 
applications.  We’ve also provided some tips for the Line 6 Plug-Ins in the following software chapters.

Activation & USB Hardware

Before using POD Farm 2 & Elements Plug-Ins, you’ll need to activate and/or authorize the software  
to be used with your Line 6 USB hardware on your computer. No worries, we’ve made this simple 
enough that even a drummer can do it, using the Line 6 Monkey software installed with POD Farm 
2! If you’ve purchased the POD Farm 2 license for your iLok USB key, then activation steps are also 
necessary, as described on the www.ilok.com site. Please also see the POD Farm 2 Basic User Guide 
- Getting Started chapter for further instructions.

Configuring POD Farm 2 & Elements Plug-Ins in your Host Software

Accessing and utilizing the Line 6 Plug-Ins from within your VST®, AU or RTAS® DAW host 
application is fairly straight-forward, but there are a few little differences between host applications, 
so it is a good idea to read through the documentation that came with your host software as well. To 
follow are a few helpful pointers. 

Where Can I Find the Line 6 Plug-Ins On My Computer?

If you followed the default installation of POD Farm 2, then all supported formats of the POD Farm 2 
and POD Farm Elements Plug-Ins were automatically installed on your computer, and into the default 
directories, as listed below. If, by chance, you customized your installation by unchecking any of the 
POD Farm 2 Plug-In formats, then you’ll need to run the POD Farm 2 installation again with them 
checked to allow them to be installed.     

Most DAW “host” applications scan and locate your POD Farm 2 & Elements Plug-Ins automatically 
on launch. But if you don’t see these Line 6 plug-ins within your host’s plug-in menus, then you’ll need 
to configure your host’s plug-in options to find them (such options are typically found in the host’s 
Preferences or Options*). Here are the default install locations for each of the Line 6 Plug-In formats:

•	 On Mac®

•	 Audio Units (AU) Plug-Ins are installed in /Library/Audio/Plug-Ins/Components.

•	 VST® Plug-Ins are installed in /Library/Audio/Plug-Ins/VST/Line 6.

•	 RTAS®  Plug-Ins are installed in /Library/Application Support/ Digidesign/Plug-Ins/Line 6

http://www.ilok.com
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•	 On Windows® 

•	 VST® Plug-Ins are installed in \Program Files\Line6\POD Farm 2\VST\Line 6

•	 RTAS® Plug-Ins are installed in \Program Files\Common Files\Digidesign\DAE\Plug-
Ins\Line 6

*For Windows® VST Plug-Ins, DAW host applications quite often require that you “browse” to the 
directory where your VST plug-ins are installed. Here is an example of this in Ableton Live, and the 
steps are similar in most Windows® VST DAW hosts:

Click Browse to choose the folder where 
POD Farm 2 VSTs are installed.

Choose the Program Files\Line 6\POD 
Farm 2\VST\Line 6 folder* and click OK  

 *TIP: If you have other Line 6 VST Plug-Ins (POD Farm 1 or GearBox) installed, you can alternatively 
select the Program Files\Line 6 folder. Ableton Live (and most VST hosts) will then find all VST Plug-Ins 
within this directory, as well as within all sub-directories.
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Using the POD Farm 2  VST or AU Plug-In

Once you have POD Farm 2 activated for your Line 6 hardware or iLok, you are ready to jump right 
into a whole new level of sound possibilities right within your Mac® or Windows® DAW software!  

If you are using a Mac®, then POD Farm 2 & Elements Plug-Ins are supported by any audio software 
that hosts the Mac® Audio Units (AU) or VST® Plug-In formats. Note that some hosts, (such as 
Ableton Live®), support both these formats, so you can simply use either with the same results. If you 
are using a Windows® PC, then POD Farm 2 & Elements Plug-Ins are supported by any audio software 
that supports the VST® Plug-In format. If using Digidesign Pro Tools® software, it utilizes the RTAS® 
plug-in format on either Mac® or Windows®. (Please see the following Pro Tools Mac® chapter on page 
5•50, or the Windows® chapter on page 6•45 for more info.) 

To follow we’ve provided a few short tutorials for using POD Farm 2 Plug-In within Ableton Live 
version 8 and Steinberg Cubase® 5. These provide examples for how to insert, configure and automate 
parameters for POD Farm 2 Plug-In on most any  Mac® or Windows® DAW host applications. The 
steps are the same for using any of the POD Farm Elements Plug-Ins, and on either Mac® or Windows®, 
except where noted.

In the following example, we’re assuming you’ve performed the default POD Farm 2 installation, 
where the POD Farm 2 Plug-In is installed into the default locations on your computer for all formats 
(see “Where Can I Find the Line 6 Plug-Ins On My Computer?” on page 3•2). 

 Note: If you have not initially used AU or VST effects plug-ins within Ableton Live yet, you may need 
to “activate” the plug-in ability within the Live software. For instructions, see the Mac®Ableton Live® 
chapter on page 5•8, or the Windows® Ableton Live® chapter on page 6•9.

Inserting POD Farm 2 Plug-In on an Audio Track

Open or create a new project (or “Set” as Live refers to it), and create at least one audio track. Record 
or import an audio file into the track so you have something to hear. A dry guitar audio file would be 
best here. Within your Live “Set”, let’s insert POD Farm 2 Plug-In on this audio track.

Click here to switch to 
Live’s Arrangement View   

Mono versus Stereo Operation

An important aspect to understand when using plug-ins is how your DAW host offers mono versus 
stereo plug-in operation. Some DAWs (Cubase®, Logic & Pro Tools® for example), allow you to 
choose the plug-in format to match your audio track type (i.e. - mono in>mono out, mono in>stereo 
out, stereo in>stereo out). However, Ableton Live and some other DAWs (such as SONAR® & 
Garageband) do not offer options the same way. Behaviors differ further among Live and these other 
DAWs, but whenever you insert a POD Farm 2 and Elements Plug-In on any Live Audio or Return 
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track, you’ll see that it is automatically inserted as a stereo plug-in. This may seem contradictory if 
you have your Live audio track set to record from a mono sound card input, and/or insert a mono au-
dio clip, but all audio tracks in Live always function as stereo. This allows any plug-in effects’ outputs 
to be heard in stereo, regardless of your track input. 

For more info on mono & stereo audio routing capabilities, check Live’s documentation. We’ve also 
included some tips for mono & stereo operation in other DAW hosts in the following respective 
chapters.

Back to our Live example... We have recorded a stereo audio clip in Audio Track 1, so let’s insert 
the POD Farm 2 Plug-In here.   

On Mac® you may have two choices here since Live supports both the POD Farm 2 AU and VST 
Plug-In. It really does not matter if you’ve activated either (or both) for your POD Farm 2 & Ele-
ments plug-ins, so use whichever version you like.  

Click on the desired plug-in within the Live Plug-In Devices Browser and drag 
& drop it directly onto your Audio Track to “insert” it on the track.

Or, alternatively, if you are in Live’s “Session View”, you can also drag the plug-in from the Plug-In 
Device Browser directly onto the desired vertical “track” strip to insert it that way.

Once inserted, you’ll see the POD Farm 2 Plug-In User Interface (UI) window is automatically 
launched, and a POD Farm 2 Plug-In “Device” panel is loaded in the lower pane of Live.  

Enable/Bypass the Plug-In Click this button to show/hide 
the POD Farm 2 UI window
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To remove POD Farm 2 Plug-In from the Track, simply 
right click (Windows) or Ctrl + click (Mac) directly on 
POD Farm 2 Plug-In’s title bar and choose Delete

Now go on and try a few presets and tweak settings all you like in the POD Farm 2 Plug-In UI window!  
Remember that it is a good idea to save your Plug-In settings as a Preset before removing the inserted  
Plug-In so that you can recall the settings another time. For details on specific POD Farm 2 features, 
please refer to the POD Farm 2 User Guides available on the POD Farm Online Help site. 

Inserting POD Farm 2 Plug-In on a Send Return

Each instance of any Plug-In you add in your Live Set utilizes CPU power. Therefore, if you have the 
situation in your Live Set where you want to apply the same exact POD Farm 2 Plug-In settings to 
more than one audio track, it is a better practice to insert one instance of POD Farm 2 Plug-In on one 
of Live’s “Return” tracks and route the desired audio tracks’ Send outputs to it. Here is how to set this 
up:

In Live’s Arrange View, drag and drop the POD Farm 2 Plug-In 
onto the “A Return” track

Once the plug-in is loaded as an insert on 
the Return track, you’ll see the track name is 
automatically changed to “A POD Farm 2”

Configure POD Farm 2 Plug-In with any combination of effects you like. For example, maybe you just 
want to use the Stereo Delay and Reverb (with no Amp or Cab processing added) so that these effects 
can be applied to several different tracks of recorded instruments.

Next, switch to Live’s Session View where you can easily see and adjust the Send A levels from 
multiple tracks. In this scenario, we’ve set the Send A controls for both audio tracks 1 and 2. The result 
is that each of these tracks will have part of their output routed to the “A POD Farm 2” Return track 
and, therefore, through the inserted POD Farm 2 Plug-In. 

http://line6.com/manuals/PODFARM/
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TIP: When using POD Farm 2 Plug-In on a Send Return like this, it may be desirable to set each active 
Model’s Mix knob to 100% (if the particular effect model includes one). This way, the “Wet/Dry” mix can 
then be controlled by adjusting an audio track’s Send A level control, to feed the desired amount of signal 
through the Plug-In to add more “Wet” to the mix.

Adjust the “Send A” knob 
on each audio track to 
determine the level fed to the 
A POD Farm 2 Return track

Adjust the Track 
Volume for the amount of 
“dry” track signal

Adjust the Track Volume on the A POD Farm 2 Return track to 
determine how much “POD Farm-effected” audio you will hear 

You can choose how much effect is applied for each audio track by how much you raise its Send A level 
knob. Additionally, the main output of each audio track is still routed to the main stereo Out 1-2, so 
you can adjust the vertical Track Volume slider for each audio track to also determine how much “dry” 
track signal is also heard at the main output. 

Note that it also possible to insert POD Farm 2 Plug-In on the Master track of your Live Set - just 
drag POD Farm 2 Plug-In onto the Master track to do so. This allows you to run all your audio tracks 
through a common Plug-In effect, such as the POD Farm 2 or Elements Compressor, Delay or Reverb! 
Ableton Live offers a great deal more signal routing options, allowing you to be even more creative 
with the use of POD Farm 2 Plug-In and the mix of your Live Sets. Please go to the Live Help menu 
and choose Read the Live Manual for more info.

External MIDI Control with POD Farm 2 Plug-In

Ableton Live, like most full featured DAW software, offers the ability to access the knobs, sliders & 
switches of any inserted effects Plug-In remotely, via a hardware MIDI controller device, provided the 
Plug-In supports this ability. And POD Farm 2 Plug-In does indeed support MIDI Control to allow you 
to take full advantage of these MIDI  features! It is recommended that you first get familiar with the 
POD Farm 2 MIDI Control & MIDI Learn features covered in the POD Farm 2 Basic User Guide. To 
follow, we’ll provide some examples for configuring an external MIDI controller to access POD Farm 
2 Plug-In parameters within Ableton Live. The process is similar in most DAWs (and note that the 
following chapters offer some specifics for MIDI control in other popular DAW applications as well). 
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Configure your MIDI Controller Device’s MIDI Operation

You will need to configure your MIDI device to send MIDI Continuous Controller (MIDI CC) and/
or MIDI Bank & Program Change messages for each of its onboard pedal, knob & switch controllers. 
To “map’ your MIDI device’s controllers to access the POD Farm 2 Tone Presets that include “pre-
configured” MIDI control assignments for their parameters, you’ll want to use the settings recommended 
in the MIDI Control section of the POD Farm 2 Basic User Guide (available from the POD Farm 
Online Help site.)  The User Guide also lists the necessary MIDI Bank & Program Change settings 
necessary to access the POD Farm 2 Setlist & Preset navigation options!

To create custom MIDI control of POD Farm 2 functions, you can take advantage of the POD Farm 2 
“MIDI Learn” functionality (more about MIDI Learn in the next section). When using MIDI Learn to 
“map” your device’s controllers, it is not necessary to configure specific MIDI values. POD Farm 2 will 
“learn” MIDI CC, Note On and Pitch Wheel MIDI  commands for its parameters. MIDI controller 
devices typically offer software utilities for creating, editing and storing these settings:

•	 If you are using a Line 6 KB37, UX2 or UX8, you can go to Line 6 Audio-MIDI Devices dialog 
> MIDI tab > MIDI Control Settings. (For more info on these MIDI controllers & the MIDI 
Control Settings utility, please see the POD Studio & TonePort MIDI Setup Guide, available 
on the POD Farm Online Help site.)

•	 If you are using a Line 6 FBV MkII Series Controller, use the FBV Control application.* (See the 
FBV MkII Basic & Advanced User Guides available from the POD Farm Online Help site.)

*TIP: You can download the “POD Farm 2” FBV MkII control presets, which you can load using the Line 
6 FBV Control application to instantly configure your FBV with a full set of useful MIDI mappings for 
POD Farm 2 - available from the POD Farm Online Help site.

Ableton Live MIDI Input Device Configuration

Next, you’ll need to configure the Ableton Live software to receive MIDI from your external MIDI 
controller device. In the following example, we’ll configure a Line 6  KB37 to be used as a MIDI device, 
since it includes the on-board Expression Pedal and Footswitch features that can send MIDI control 
commands to the Live software. You can use any MIDI controller hardware that is capable of sending 
MIDI CC, Note On & Pitch Wheel MIDI commands.

With your MIDI device connected to your computer, launch the Ableton Live software, and go to:

•	 Mac® - Ableton Live > Preferences > MIDI/Sync page

•	 Windows® - Options > Preferences > MIDI/Sync page   

Here you will see that Live automatically detects your Line 6 device’s MIDI ports. You might see 
additional devices’ MIDI Ports appear here as well, depending what other MIDI hardware/software you 
have installed on your computer.

http://line6.com/manuals/PODFARM/
http://line6.com/manuals/PODFARM/
http://line6.com/manuals/PODFARM/
http://line6.com/manuals/PODFARM/
http://line6.com/manuals/PODFARM/
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Click the Track 
and Remote 
buttons both to 
On for your Line 
6 device’s MIDI 
Input*

Select your Line 
6 device here so 
that Live will 
receive MIDI 
from it

*It is necessary to turn on the MIDI In “Remote” option to allow Live to receive MIDI controller data 
from the selected device. However, to allow Live to receive MIDI into a MIDI track you need to turn 
on the “Track” option. You need MIDI track input to utilize KB37 as a keyboard controller, and/or to 
route MIDI control data directly to POD Farm 2 and other Plug-Ins that offer direct MIDI control. 

With Ableton Live now configured to receive MIDI from your external MIDI controller device, you 
can start working in your project. 

Configure your DAW software to receive MIDI from your connected MIDI Controller device to feed 
it to the audio track where POD Farm 2 Plug-In is inserted. This is typically accomplished by setting 
up a MIDI track to receive from your MIDI device and its Output to the audio track & Plug-In. For 
example, here is how to configure this in Ableton Live, where POD Farm 2 Plug-In is inserted on 
Audio track 1.

On a new MIDI track, set the track’s Input to your 
MIDI controller’s MIDI Out port

Set the track’s Output to be the Audio track where 
your POD Farm 2 Plug-In is inserted

The POD Farm 2 Plug-In should then appear as the 
“MIDI Output Channel” destination

POD Farm 2 Plug-In is inserted 
on Audio track 1

Be sure to Arm the MIDI track 
to allow MIDI through-put

Configuring Ableton Live for MIDI Input to POD Farm 2 Plug-In

With MIDI now successfully routed to your inserted POD Farm 2 Plug-In, you can either utilize the 
POD Farm 2 factory provided Tone Presets’ “pre-configured” MIDI assignments*, or use the MIDI 
Learn feature to create your own custom MIDI assignment. 

*Note: POD Farm 2 includes many Tone Presets that already include useful “pre-configured” MIDI control 
assignments. To view these settings for the currently loaded Tone Preset, select the MIDI Assignments 
View within POD Farm 2 Plug-In. Then configure your MIDI control device to transmit matching MIDI 
commands to access the desired POD Farm 2 parameters. Please see the POD Farm 2 Basic & Advanced 
User Guides for more on these pre-configured MIDI assignments.
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Use MIDI Learn: In the POD Farm 2 Plug-In window, double click on any model in the Signal Flow 
View to load its Edit Panel in the Panel View. Right click (Windows®) or Ctrl+click (Mac®) directly 
on the model’s knob, slider or switch that you want to control remotely and select the MIDI Control 
menu. For example, load a Delay effect model and then right click/Ctrl+click directly on the Delay’s 
Mix knob within the Panel View to access this parameter.

In the MIDI Control sub-menu, click MIDI Learn. This places POD Farm 2 into MIDI Learn mode, 
where it waits to receive a command from your connected MIDI Control device.

Right click (Windows®) or Ctrl+click 
(Mac®) directly on the desired control 
(Delay-Mix knob, in this example)

Select MIDI Learn to place POD Farm 2 
Plug-In in MIDI Learn mode

•	 Press the desired footswitch, move the pedal, or turn a knob on your POD Studio/TonePort 
to send its MIDI control message. Since we want to remotely control the Mix knob here (a 
“variable” parameter that can be adjusted), move the pedal or a knob on your MIDI control 
device. (When mapping to POD Farm 2 “on/off” type parameters, it is better to use a switch or 
footswitch on your device.)

•	 Presto! POD Farm 2 Plug-In automatically “learns” the MIDI control message and assigns the 
accessed controller to the selected POD Farm 2 parameter. In our example, the Delay-Mix knob 
is now able to be remote controlled by the controller pedal or knob you accessed. If you right 
click (Windows®) or Ctrl+click (Mac®) on the Mix knob once again, you’ll see the learned 
assignment in the menu.

The menu now shows the “learned” 
MIDI command as assigned

•	 To remove a MIDI assignment, select “Clear” from the context menu - or use the options in the 
POD Farm 2 Plug-In MIDI Assignments display to see and manage your MIDI assignments. 

You can control just about any parameter within any inserted instance of POD Farm 2 Plug-In. Note 
that you can control these parameters anytime - even while using your DAW’s automation “write” 
mode to record all your moves in real-time! 

Parameter Automation with POD Farm 2 & Elements Plug-Ins

Most DAW applications offer parameter automation capabilities for audio effects Plug-Ins, where you 
can specify on your DAW track to change one or more of the Plug-In’s knob or switch values over time 
using editable track envelopes. Most DAWs further allow you to record parameter automation in real-
time, where you enter an automation “write” mode and then all changes to the Plug-In’s parameters 
are recorded and displayed on the track as adjustable envelopes. 
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DAW host applications typically allow you to access the list of automatable parameters for any AU/
VST/RTAS Plug-In by way of an automation parameter menu, specific to the audio, bus or aux/return 
track where you have inserted the Plug-In. To follow we’ve provided examples for how to utilize the 
parameter automation features in Steinberg Cubase® with both POD Farm 2 Plug-In and the POD Farm 
Elements Plug-ins. Each DAW host software offers parameter automation options slightly differently, 
so it is recommended you consult your host software’s documentation for their specific instructions and 
parameter automation capabilities. We’ve also provided additional, application-specific examples in 
the following DAW application setup chapters.

POD Farm 2 Assignable Automation Slots

Since POD Farm 2 offers a very large number of automatable parameters for its many amp, preamp and 
effects models, you’ll see that we’ve added 16 “assignable” Knob and 16 “assignable” Switch Automation 
Slots within POD Farm 2 Plug-In. Each Automation Slot allows you to assign one parameter from 
among the vast number of POD Farm 2 model  parameters, providing your DAW track control over up 
to 32 amp, preamp or effects parameters per instance of POD Farm 2 Plug-In. 

In addition to the 32 assignable Automation Slots, POD Farm 2 Plug-In also presents several additional 
“fixed” parameters within your DAW host. Where POD Farm 2 Plug-In is inserted on any DAW track, 
this total list of parameters appears in your DAW’s track automation parameter menu. Here is how 
this appears on a Steinberg Cubase Audio Track, when you click on the track’s automation parameter  
selector for the inserted POD Farm 2 Plug-In:

Click on the small arrow button at the left of the 
audio track to display an Automation Lane

Click on the Automation Parameter selector - 
here you can choose from an abbreviated list of 
parameters. Or, select the “More” option to open 
the Add Parameter dialog, where it is easier to see 
all Knob, Switch Slots & Fixed parameters 

(Note that you may need to scroll down to see all 
40 of these POD Farm 2 parameters)

The Cubase audio track’s “Add Parameter” list POD Farm 2 Plug-In
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Note that the DAW host’s parameter menu will list all 32 POD Farm 2 assignable (Knob & Switch) 
parameters, plus all “fixed” parameters, regardless if you have actually assigned a specific amp, preamp 
or effect parameter to any of the assignable Slots. (A non-assigned Slot will still be “automatable” 
within the DAW host, but it simply will not control any POD Farm 2 settings until you assign one.) 

Note: DAW applications differ slightly in how they offer this menu of automatable parameters for VST/
AU/RTAS Plug-Ins. See the following chapters for more application-specific information on POD Farm 2 
Plug-In parameter automation - and be sure to also read your DAW application’s documentation as well!

Assigning POD Farm 2 Parameters to Automation Slots

To assign a POD Farm 2 Plug-In amp, preamp or effect parameter to an Automation Slot:

•	 Load the desired Amp, Preamp or Effect model into the POD Farm 2 Panel View.

•	 Right click (Windows®) or Ctrl+click (Mac®) directly on the desired POD Farm 2 knob or 
switch control to bring up the Automation menu. The menu displays a list of 16 “Knob” or 16 
“Switch” Automation Slots (pertaining to the type of control you’ve selected). Initially, these 
Slots are all empty (not assigned to any parameter).

•	 Click within any Slot to “assign” the chosen control. Note that clicking in an occupied Slot will 
overwrite an existing assignment with your new control assignment. 

Right click (Windows®) 
or Ctrl+click (Mac®) 
directly on the desired 
knob or switch 
control to access the 
Automation menu

An arrow at the left 
of the slot number 
indicates the “selected” 
slot. Clicking Clear in 
the menu will remove 
the selected Slot as-
signment.

POD Farm 2 Plug-In - assigning a knob parameter to an Automation Slot

•	 The name within the Slot provides descriptive information about the assigned parameter. For 
example, the assigned parameter in the above screenshot: B - Analog Delay w/Mod (FX-5) - 
Mix, refers to the “Mix” parameter of the “Analog Delay w/Mod” effect. The “B” indicates this 
model is in Tone B, and the “(FX-5)” indicates the specific effect model instance. 

Note: It is not possible to assign a POD Farm 2 parameter to more than one Slot. If the current parameter 
is already assigned to a Slot, clicking in a different Slot will move the assignment to the new Slot.

•	 To “un-assign” a parameter - Select the Slot you want to un-assign, then click on  Clear from the 
top of the Automation menu.

TIP: For easy reference to all Automation assignments for POD Farm 2 Plug-In, go to the Assignments 
View and click on the Automation button. See the POD Farm 2 User Guides for more about the 
Assignments View.

http://line6.com/manuals/PODFARM/


POD Farm 2 Recording Setup Guide - POD Farm 2 & Elements Plug-Ins

3•13

POD Farm Elements Plug-In Automation Parameters

Unlike the POD Farm 2 Plug-In, Elements Plug-Ins do not offer assignable Automation Slots - each 
Elements Plug-In offers a fixed set of parameters that appear in your DAW’s parameter automation 
menu. Each Elements Plug-In also offers two “Global” parameters to the DAW host for automation - 
Master Input and Master Output - which correspond to the Plug-In’s level knobs on the Main Control 
Bar. The numbered parameters (“Param 1”, “Param 2”, etc.) are mapped to the parameters left to right 
within the Plug-In’s Edit Panel.*

*Note: Some Elements effects Plug-In have slightly different sets of parameters, depending on the specific 
model selected, hence the “generic” automation parameter names that appear in the DAW host parameter 
menus. Please see the POD Farm 2 Advanced User Guide - Elements Plug-Ins chapter for reference 
tables that show the actual parameters within each Elements effect Plug-In that corresponds to each 
“generic” automation parameter . 

Here is an example of how the Elements “POD Farm Delays” Plug-In list of parameters appears in a  
Steinberg Cubase audio track automation parameter selector:

Elements - POD Farm Delays Plug-In 
is inserted on the Cubase Audio 01 
track’s Insert #1

All the automation parameters for the 
Elements - POD Farm Delays Plug-In 
appear in the track’s parameter selector

The Cubase automation parameter selector, showing the POD Farm Delays Plug-In parameters

You’ll see that each inserted Plug-In offers one set of automation parameters, and these parameters 
remain constant, even if you select a different amp or effect model within the Plug-In. For example, say 
you have inserted the POD Farm Delays Plug-In on your audio track, and you’ve selected the Analog 
Delay model. If you choose the Delay’s “Mix” parameter within your DAW host’s track automation 
menu, this will allow you to automate the Analog Delay model’s Mix parameter as expected. If you 
then select the Tube Echo model within this same instance of the POD Farm Delays Plug-In, your host 
automation remains mapped to the “Mix” parameter, and automatically controls the mix for the Tube 
Echo model. 

Manually Editing Automation Envelopes in Steinberg Cubase

For this example, let’s suppose you want to increase the POD Farm 2 Analog Chorus effect’s Mix 
parameter in a particular section of a stereo guitar track you’ve recorded in Cubase...

http://line6.com/manuals/PODFARM/
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Insert POD Farm 2 Plug-In into the “Insert 1” of a Cubase stereo audio track, and configure a Single 
Tone in POD Farm 2, adding the Analog Chorus effect from the Modulation category. (Alternatively, 
you could insert an Elements Plug-In - such as the POD Farm Mods Plug-In, and choose its Analog 
Chorus model.) Import or record a stereo clip in this audio track - a clean guitar recording would work 
nicely here.

Assign the POD Farm 2 Chorus model’s “Mix” parameter to a “Knob” Automation Slot. As described 
on  page 3•12, Right click (Windows®) or Ctrl+click (Mac®) on the Chorus Mix knob within the Edit 
Panel and let’s assign it to the “Knob 1” slot.

Right click (Windows®) or Ctrl+click 
(Mac®) on the Analog Chorus Mix 
knob and then within the Automation 
- Knob 1 Slot to assign this to “Knob 
1”

Next, we can access our POD Farm 2 Plug-In “Knob 1” parameter from the Cubase audio track for 
automation. (Or, if you inserted an Elements Plug-In, choose it here.)

POD Farm 2 Plug-In inserted on Insert #1

Click the arrow button to expose one 
Automation Lane below the Audio track

Click on the Automation Lane’s parameter 
selector, and choose the POD Farm 2 - 
“Knob 1” parameter

Click on the envelope line to create edit 
“handles,”  then drag each handle up/down to 
adjust the Chorus - Mix parameter amount over 
time, as desired 

Click the lane’s “Read” button so that it is active 
- then hit play and you’ll hear the Chorus - Mix 
change, following your envelope adjustments! 

TIP: Cubase, like many other DAW applications, also features a Pencil tool, which allows you to literally 
“draw” the parameter envelope right over the track. You can select the pencil tool from the Cubase Toolbar 
at the top of the window, then use it like a pencil to draw on the track!
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You can create any number Automation Lanes, which allows you to display envelopes for additional 
Plug-In parameters. To display more Automation Lanes, click on the “+”  button on the existing 
Automation Lane. 

Repeat the previous steps to assign another POD Farm 2 Plug-In parameter to a Knob or Switch 
Automation Slot and then select the slot parameter within the new Automation Lane to display its 
envelope.  

Note that when the envelope for a POD Farm 2 Plug-In Switch Automation Slot is displayed, the 
envelope adjustment behaviors are slightly different. Since a “Switch” parameter has only two values 
(on or off) when you create and adjust edit handles for a Switch Slot parameter, you’ll see the edit 
handles will always snap to either minimum or maximum. For example, here is how an edited Switch 
Slot parameter appears in Cubase

Switch 1 parameter 
max. value

Switch 1 parameter 
min. value

POD Farm 2 Plug-In 
“Switch 1” parameter 
is selected in 
Automation Lane

Using the Automation Write Modes in Steinberg Cubase

For this example, let’s suppose you want to add some Wah pedal effect to your recorded guitar track. A 
great way to do this is to tweak and record your Wah Position knob moves while you are playing back 
the track, so you can hear and record your Wah tweaks in real-time. Once again, we’ve shown these 
steps using Cubase, but the process is similar in most DAW applications. 

First, load the POD Farm Wahs Plug-In on your audio track, and select one of its Wah models. 
(Alternatively, you can insert POD Farm 2 Plug-In, choose one of its Wah models on your Tone, and 
assign the Wah “Position” knob to a “Knob” Automation Slot, as shown on page 3•12.) 

Within the Cubase audio track’s Automation Lane header, use the parameter selector as in the previous 
example - this time we’ll select the POD Farm Wahs Plug-In - Pedal Pos parameter.
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Elements “POD Farm Wahs” Plug-In 
added on Insert #1

Click on the Automation Lane’s 
parameter selector, and choose the 
“POD Farm Wahs - Podal Pos” 
parameter

As with most DAW applications, automation can be “written” in Cubase by setting the audio track 
to one of the automation “write” modes, and then accessing the desired parameter’s control directly 
within the Plug-In edit panel window. Here, we’ve set the Cubase automation mode to “Touch.” With 
these settings made, once Cubase playback is started, the POD Farm 2 Plug-In Wah Pedal Position 
knob can be manipulated during playback by using the mouse* directly in the Wah edit panel, and the 
Wah “performance” is captured by Cubase. 

To write automation, set the 
Automation option to one of the 
“write” settings (Touch, Latch or 
Write), and enable the “Write” 
function on the Automation Lane 
for your Wah Position parameter

“Edit handles” are written automatically, in 
response to adjustments made with the plug-
in’s Wah Position knob during the write mode 
playback

*TIP: Instead of using your mouse to adjust the Wah knob, you can alternatively assign a MIDI controller 
pedal to the Wah Position parameter and wangle it just like your trusty old wah pedal - see “External MIDI 
Control with POD Farm 2 Plug-In” on page 3•7.

Please the following chapters covering your specific DAW application for more examples using 
POD Farm 2 & Elements Plug-Ins, MIDI Control, Parameter Automation and more!
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POD Farm™ 2 Standalone Operation
With any Line 6 POD Studio™, TonePort™ or GuitarPort™ device* as the connected hardware, 
POD Farm™ 2 can be launched in “standalone” operation - that is, as an individual application rather 
than a Plug-In requiring a host application. This allows you to utilize your USB hardware as a “front 
end” Tone machine, where you can process your input source, feed the signal to the Record Sends for 
your DAW software application, as well as to all analog and digital hardware outputs. In standalone 
operation, POD Farm™ 2 also offers the super low latency benefits of ToneDirect™ Monitoring, as 
well as a complete Mixer View where you can independently control the signals fed to the Record 
Sends! The following sections cover the settings within POD Farm 2 when in standalone operation 
for recording use.

POD Farm 2 in Standalone Operation

*POD Farm 2 standalone operation is not available with POD® X3 or POD®xt family devices. Since POD® 
devices perform all their Tone processing magic inside the hardware itself, their on-board controls are 
used to shape all Tone settings and configure monitor and Record Send options. Please see “Line 6 Audio 
Driver Configuration” on page 2•1 and your Pilot’s Handbook for more info.

Mixer View

When utilizing POD Farm 2 in standalone operation for recording, many of your key controls are found 
within the Mixer View, where you can control all those signal Input and Output levels & routings! 

Choosing your POD Farm 2 Source Inputs

In POD Farm 2, the “Source” inputs are the physical inputs on your Line 6 hardware (Instrument, Mic, 
Line In, etc.), which are where you connect your guitar, bass, mic or other line-level devices to feed 
their signal into Tone A and/or Tone B within POD Farm 2.
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•	 For Line 6 devices that offer a single input and single tone capability (GX, D.I. and GuitarPort 
devices), this Instrument Input is the “fixed” Source. 

•	 For all other POD Studio & TonePort devices, there are multiple input capabilities and, therefore, 
you’ll see Input Source Select menus within the POD Farm 2 Mixer View for Tone A & Tone B. 

  Input Source Select Menus                       

POD Farm 2 offers independent Input Source Selectors for Tone A & Tone B

•	 Unlike the POD Farm 2 Plug-In interface, there is no Master Input level knob for the standalone 
application - to adjust the input levels of your Sources, use your guitar’s volume knob, the Mic 
Gain knobs on your Line 6 hardware, or the output controls on any source device that is feeding 
into your Line 6 hardware.

Once you have your guitar, bass, mic, or line level item(s) plugged into your device, use the Source 
Select menu(s) to choose which of these “sources” you want fed into POD Farm 2 for each Tone path. 
The Input Meter will measure the incoming signal from the selected Source. Be sure to adjust your 
instrument or input device’s level to avoid the POD Farm 2 Input Meters from “clipping” (going into 
the red). Clipping results in distortion and a degraded audio signal quality!

TIP: To feed one single input source (such as your guitar, plugged into your device’s Instrument jack) into 
both Tone paths, select “Same as Tone A” in the Tone B Source menu as shown above. This allows you to 
use the A/B Switch Box to feed into both Tones (see next page)! 

Tone A & B Input Source Menus

•	 Each Tone’s Input Source menu allows you to choose which of your Line 6 hardware’s inputs  
(Instrument, Mic 1, Line Stereo, etc.) is routed to the respective Tone path. Note that the 
options available in the menu differ depending on the connected Line 6 hardware*, and for 
Single versus Dual Tone modes. 

*Note: When a Line 6 GX, D.I. or GuitarPort is the device in use, no Input Menus are displayed since 
these devices offer a single, “fixed” Instrument Input.

•	 In Single Tone mode, the Tone A Input Source menu lists each of the Mono & Stereo Input 
Sources your specific Line 6 device offers.
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•	 In Dual Tone mode, there is an Input Source menu provided for each Tone (as in the above 
screen example). The Source menu for Tone A lists each of the Mono inputs your device 
offers, The Source menu for Tone B is dynamic and contingent upon the source selected for 
Tone A.

The Tone A Input Source menu options with a UX2 device - Single Tone Mode (left) Dual Tone mode (right) 

UX1, UX2 & KB37 Users: You can use the “Mute Mains for Mic Record” option found in the 
Preferences > Hardware dialog. Activating this checkbox silences the POD Farm 2 signal that is fed to 
your hardware’s Main Outputs, while the POD Farm 2 Tone A & B signals are still fed to the Headphone 
outs and Record Sends. This feature facilitates recording with microphones, (e.g. - recording vocals, in 
the same room as the monitor speaker system). Simply activate the Mute Mains option and listen via 
headphones while recording vocals when you are in the same room as your monitor speaker system.

A/B Switch Box

The function of the A/B Switch Box is to allow you to route a single input source into either Tone A 
or Tone B, or into both. If you have a Dual Tone configuration within POD Farm 2, with a single input 
source (or when Tone B’s Input Menu is set to “Same as Tone A”) you’ll see this A/B Switch Box active 
in the Mixer. Whenever you have a Single Tone configuration, or have different input sources in Tone 
A and B, the A/B Switch Box is disabled. 

•	 Click the A/B button to toggle between feeding your single input source into either Tone A or 
Tone B. The  A and B lights tell you which Tone is active.

•	 Click the A+B button to feed your single input source into both Tones A and B simultaneously. 
Both A and B lights illuminate to indicate A+B mode is active.

Note that this is a duplicate of the A/B Switch Box you see in the Signal Flow View and functions the 
same - we’ve simply added it here as well so that you can easily toggle these Tone A/B options while 
making your Mixer adjustments. Wasn’t that thoughtful of us?

Record Send Controls

The controls in this section allow you to select the type of signal routed to POD Farm 2 Record Sends  
1-2 & 3-4 (or Sends 9-10 & 11-12 for UX8 devices), and adjust Send output levels.  You can think 
of the two Record Sends as “virtual pipelines” that each carry a stereo output signal from POD Farm 
2, allowing you to select your POD Farm signals within your recording software as Input sources for 
recording into audio tracks. 
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Send Input Source Menus                           

Output Level Fader                  

+18 dB Boost button               

Output Level Meter

The POD Farm 2 Mixer - Record Send controls

Once you’ve installed the Line 6 USB audio device driver (which you did automatically when you 
installed POD Farm 2) and connected the USB cable, these Record Sends are established on your 
computer and accessible within the Line 6 Audio-MIDI Control Panel dialog. Note that these Sends 
carry audio back and forth regardless if you are using POD Farm 2 in standalone operation or not. And, 
for POD X3 & PODxt devices (which do not utilize standalone operation) you can still access the 
device’s Record Sends within DAW software on your computer to utilize your device as a sound card 
for high quality audio recording and playback. For all POD Studio, TonePort and GuitarPort devices, 
the Record Sends carry the “unprocessed” output of whatever you’re plugging into your device, but if 
you launch POD Farm 2 in standalone operation, you can process whatever signal you are inputting 
into your Line 6 device with all those luscious Tones! 

For more about your Line 6 device’s Record Sends and their use when not running POD Farm 2 in 
standalone operation, please see “Line 6 Audio Driver Configuration” on page 2•1.

Send Source Menus

Select the audio Source you want fed independently to each Record Send. If  POD Farm 2 is in Single 
Tone mode, the options available in the Source menus are:  

•	 Tone A - The fully processed signal fed from Tone A.

•	 Tone A (semi) - A signal from Tone A which is processed only by any existing Amp/Cab/
Preamp and effects models positioned to the left of them (i.e. - “Pre” positioned effects).

•	 Dry - A completely unprocessed signal from the Tone A assigned input source.

•	 If  POD Farm 2 is in Dual Tone mode, the options available in the Source menus are:  

•	 Tone A - The fully processed signal fed from Tone A.

•	 Tone B - The fully processed signal fed from Tone B.

•	 Tone A+B - The fully processed signals fed from both Tone A & B.

•	 Dry - A completely unprocessed signal from the Tone A & B assigned input sources.

Record Send Level Controls

•	 Use the Level Fader to adjust the output of each Record Send. This is how you adjust the level 
of the signal that gets recorded into your DAW software.
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•	 Use the Output Level Meter to gauge your levels. The red clip indicator will light up if your 
level is too high - clipping should always be avoided to produce good quality recordings! 

•	 Use the +18 dB Boost button if your Send signal is not hot enough. When this button is lit, an 
18 dB gain boost is applied to the Record Send output signal. Watch the meters and adjust the 
Level Slider for an optimal signal to feed to your DAW track for recording. 

Record Send Behaviors

It is important to note that the Record Send Input Source menu selections also result in slightly 
different interactions between the Tone A & B and Record Send Mixer controls.

•	 When a Record Send Input Source menu is set to “Tone A+B”, the Tone A and Tone B Output 
Level Fader, Balance Knob and Mute buttons all affect what is fed to this Record Send (as well 
as what you hear as the POD Farm 2 ToneDirect Monitoring signal).

•	 When a Record Send Input Source menu is set to any option other than “Tone A+B”, the Tone A 
and Tone B Mixer controls do not affect what is fed to this Record Send (they only affect what 
you hear as the POD Farm 2 Tone Direct Monitoring signal).

Note: The Mixer View Record Send (Send Input menu, Send Level, Balance and +18 controls) are “global” 
settings - meaning, they are not saved individually with each Tone Preset, but rather persist regardless of 
the Tone Preset loaded. However, you may see the Send Input menu options change accordingly when 
loading a Preset with a Single Tone versus Dual Tone configuration.

 ToneDirect™ Monitoring

A unique feature of Line 6 USB audio hardware is ToneDirect™ Monitoring, (or, referred to as 
“USB Audio Streaming” on POD X3 & PODxt devices) which is a separate audio path that allows 
you to monitor the incoming signal with the lowest possible latency, for uncompromised feel and 
responsiveness when recording or jamming.

Additionally, when using POD Farm 2 in standalone operation along with your DAW software, this 
allows you to set the audio buffer size in your DAW software at a large value for efficient use of your 
computer, yet still enjoy extreme low latency monitoring while recording.  On Windows®  systems, the 
ToneDirect™ audio path has its own buffer adjustment while on Mac®, no adjustments are needed.

ToneDirect™ - USB Audio Streaming buffer size slider

The Line 6 ToneDirect™ Monitoring (for POD Studio, TonePort & GuitarPort devices) and USB 
Audio Streaming (for POD X3 and PODxt devices) audio path has its own buffer to allow you to keep 
your ASIO® Buffer Size at a high value, for more solid performance and more efficient performance 
of your DAW software. This buffer slider is accessed within the Driver screen of the Line 6 Audio-
MIDI Devices application (found in the Mac® System Preferences and Windows® Control Panel). 
The initial default setting is slightly to the right of “Extra Small,” as shown. Raise this slider if you are 
getting any dropouts in your monitor signal. 



POD Farm 2 Recording Setup Guide - POD Farm 2 Standalone Operation

4•6

ToneDirect™ Monitoring while recording with POD Farm 2 Plug-in

ToneDirect™ is a feature of the POD Farm 2 application when run in standalone mode, so in order 
for you to enjoy the feel and responsiveness provided by ToneDirect™, you’ll need to run the “stand-
alone” POD Farm 2 application alongside the DAW host software hosting your POD Farm 2 Plug-In. 
Keep in mind that these applications run independently of each other, so any Tone settings you make 
in the POD Farm 2 standalone mode will have to be matched in the Plug-in to provide the same 
results. You can achieve this by creating your settings in the POD Farm 2 standalone application, 
saving them as a Tone Preset to your computer, and then recalling that preset later within the POD 
Farm 2 Plug-in. Here are the steps to configure this type of setup:

•	 Connect the recording source (guitar, bass, mic, etc.) to your Line 6 hardware.

•	 Launch the POD Farm 2 standalone application and monitor the POD Farm 2 processed signal 
thru your hardware’s Line Outputs. These outputs supply the ToneDirect™ Monitoring magic.

•	 In the POD Farm 2 Mixer View, set one of Record Sends’ Source to be a Dry Input signal. 
Choose this Record Send as the input for the DAW track you’re recording into. 

•	 Disable your DAW software’s Input Monitoring for the track you’re recording into and record 
your take. You’ll see that just a dry, unprocessed signal has been recorded in your DAW track.

•	 Now load POD Farm 2 Plug-In on the recorded DAW audio track and dial in your desired Tone 
for playback. Note that you can now tweak your POD Farm 2 amp & effects settings all you like 
up until you do your final bounce!

 

Using a Line 6 device with another audio interface

If you have a non-Line 6 audio interface you’d like to use for your DAW recording/playback, you can 
still utilize your Line 6 hardware with POD Farm 2 in standalone operation to take advantage of  its  
low latency ToneDirect™ Monitoring signal, while feeding a separate signal into your other audio 
interface for recording. For this type of setup, you’ll need to purchase a guitar/signal splitter hardware 
box, which will afford you the unprocessed dry output needed to feed your guitar input into both your 
Line 6 hardware and DAW audio interface simultaneously.

•	 Connect your guitar to the splitter input.

•	 Connect Output A from the splitter to your DAW audio interface - this provides an unprocessed 
guitar signal to record into your DAW audio track. 

•	 Choose this channel as the audio  track input in your DAW software, and disable input monitoring 
for that track.

•	 Connect Output B from the splitter to your Line 6 Hardware, and connect the processed Analog 
Outs of your Line 6 hardware to your monitoring system. The idea here is that you’ll want to 
hear both the Line 6 hardware processed output along with the DAW playback through your 
monitor system. 

•	 Launch the POD Farm 2 in standalone mode and monitor the POD Farm 2 processed signal thru 
your Line 6 hardware’s Outputs. These outputs supply the ToneDirect™ Monitoring magic, so 
you’ll hear the processed signal with extremely low latency, while simultaneously recording an 
unprocessed version of your performance into the DAW audio track.

•	 Load POD Farm 2 Plug-In on the recorded DAW audio track and dial in your desired Tone! 
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Using a TonePort DI, POD X3 or PODxt Pro with another audio interface

If you are using TonePort DI, POD X3 Pro, or PODxt PRO, and want to utilize these devices’ 
“unprocessed” analog outputs to feed into another sound card device (such as a Digidesign Mbox® to 
allow recording into Pro Tools® utilizing the POD Farm 2 RTAS® Plug-In) you’ll be able to monitor 
your signal with ToneDirect™ by following these steps:

•	 Connect the signal source (guitar, mic, etc.) to the input of your Line 6 Hardware.

•	 Connect the unprocessed, dry analog output of TonePort DI/POD X3 Pro/PODxt PRO to the 
analog input on your DAW’s audio interface.  

•	 Configure a new audio track in your DAW software to record from this same audio interface 
input.

•	 Disable Input Monitoring in your recording application, for the track you’re recording into.

•	 Connect the processed Analog Outs or Main Outs of your Line 6 hardware to your monitoring 
system. The idea here is that you’ll want to hear both the Line 6 hardware processed output along 
with the DAW playback through your monitor system. 

•	  Launch POD Farm 2 in standalone mode and monitor the recorded signal thru the Analog 
Outputs of your Line 6 Hardware to get the benefits of ToneDirect™ Monitoring for your input 
signal. 

•	 Record your track - note you just recorded a “naked”, unprocessed signal into this audio track. 
Insert POD Farm 2 Plug-In on the audio track and dial in the desired Tone Preset. 

POD Farm 2 MIDI Control

Like POD Farm 2 Plug-In, POD Farm 2 in standalone operation also offers remote MIDI control over 
the majority of its parameters via an external MIDI Controller device! Setting up an external MIDI 
controller device with POD Farm 2 can be great for allowing you to do things such as use a pedal 
to control your Wah, Volume or Pitch Bender effects, control the wet/dry mix of any effect, switch 
through your Tone Presets, or even control POD Farm 2 Amp & Mixer options. The functionality is 
essentially the same as with POD Farm 2 Plug-In, so please refer to “External MIDI Control with POD 
Farm 2 Plug-In” on page 3•7, and your POD Farm 2 Basic User Guide for more details. To follow are a few 
setup steps for getting MIDI Control going within the POD Farm 2 standalone application.

TIP: Looking for the perfect USB MIDI Foot Controller for POD Farm 2? Check out the Line 6 FBV 
MkII Series Controllers!

Configuring POD Farm 2 Standalone Application for MIDI Control

You first need to configure POD Farm 2 to receive MIDI communication from your connected MIDI 
Controller device. Be sure to connect your MIDI Controller to your computer before launching POD 
Farm 2, then make the following settings.

•	 Launch the POD Farm 2 Preferences dialog and go to the MIDI tab. Here you will be able select 
any connected MIDI Controller device (or any MIDI Input Port to which your controller device 
is connected):

http://www.line6.com/footcontrollers/index.html
http://www.line6.com/footcontrollers/index.html
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The Preferences, MIDI dialog - Selecting a MIDI Controller Device (Mac OS® X)*

*FBV MkII Users: Note that you’ll see the four FBV MkII MIDI ports appear titled differently depending 
on you computer’s operating system.

Preferences - MIDI dialog on Windows® 7 or Windows Vista® 

Preferences - MIDI dialog on Windows® XP

•	 In the above example you can see that we’ve chosen to receive MIDI from only the Port 1 output 
of the connected Line 6 FBV Shortboard MkII controller. 

•	 Note that our connected Line 6 UX2  device is also an option, since its Footswitch 1 & 2 
connections can be configured to send MIDI commands! For info on using Line 6 UX2, UX8 and 
KB37 devices’ MIDI controller features, please see the POD Studio & TonePort MIDI Setup 
Guide, available from the POD Farm Online Help site.

 

MIDI Learn

POD Farm 2 in standalone operation offers MIDI Learn functionality, which allows you to assign your 
MIDI Controller’s pedals, knobs and switches to POD Farm 2 parameters in just a few clicks of the 
mouse. The functionality is the same as described for POD Farm 2 Plug-In - please refer to the POD 
Farm 2 Plug-In chapter in your POD Farm 2 Basic User Guide for details.

For more information about features offered in the POD Farm 2 standalone application, please check out 
the additional documentation found on the POD Farm Online Help site.

http://line6.com/manuals/PODFARM/
http://line6.com/manuals/PODFARM/
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Mac® Audio Applications 
The following chapters cover the setup of Line 6 POD Studio™, TonePort™, GuitarPort™, POD® 

X3 or POD®xt as the USB audio device, as well as optionally using POD Farm™ 2 & POD Farm™ 
Elements Plug-Ins and/or POD Farm™ 2 in standalone operation, with several popular Mac® audio 
applications. 

Use the following links to jump to the chapter that covers your specific application:

“Ableton Live® 8 Setup” on page 5•2

“Apple GarageBand® ‘09 Setup” on page 5•16

“Apple Logic® Pro 9 Setup” on page 5•25

“Digidesign Pro Tools® LE 8 Setup” on page 5•37

“MOTU Digital Performer® 6 Setup” on page 5•60

“Propellerhead Reason® 4 Setup” on page 5•74

“Steinberg Cubase® 5 Setup” on page 5•81

“Windows® Audio Applications” on page 6•1
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Ableton Live® 8 Setup
For this chapter, we’ll show how to configure Ableton Live® version 8 to work with Line 6 POD Studio™, 
TonePort™, GuitarPort™, POD® X3 or POD®xt as the USB audio device, as well as optionally using 
POD Farm™ 2 & POD Farm™ 2 Elements Plug-Ins, and/or POD Farm 2 in standalone operation on 
your Mac® computer. The steps are very similar for the setup of other Live versions as well, including 
the special Ableton Live Lite - Line 6 Edition versions.

Choose Your Line 6 Gear Configuration

Before you record your first track in any DAW software, you have a few options to consider  with your 
Line 6 hardware & POD Farm 2 gear! You should decide if you want to record a “dry” signal into the 
audio track, such as if you want to utilize POD Farm 2 Plug-In to “non-destructively” apply your POD 
Farm 2 Tone onto the recorded track. Or, if you prefer to record a “processed” signal, where the POD 
Farm 2 Amp/Preamp and Effects are already applied and recorded permanently on the track. We’ll 
cover the steps to record either of these ways, but first it is helpful to understand the options with your 
particular Line 6 gear.

POD Studio, TonePort, GuitarPort devices 

•	 Using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into your 
device and launch POD Farm 2 in standalone operation. Use the Mixer View - Record Send 
Source options to choose the type of signal fed to your Record Sends. Also see “POD Farm™ 2 
Standalone Operation” on page 4•1 for more about the Mixer View. 

•	 Tone A, Tone B or Tone A+B - Feeds the same fully processed signal from the respective 
Tone path(s) that you hear out to the Record Send.

•	 Tone A (semi) - This option is available only when a single Tone A exists in POD Farm 2.  
It feeds only the signal processed with the Amp group of models (Amp/Cab/Mic/Preamp 
models) plus any effects inserted to the left of the Amp group within Tone A. Note that 
you’ll still hear the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ 
Monitoring output. (Useful, for example, if you want to hear a delay or reverb effect inserted 
after the Amp group, but do not want that delay effect recorded!)

•	 Dry Input - Feeds a completely unprocessed signal to the Record Send, even though you can 
listen to the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ Monitoring 
output. (This is a great option if you want to insert POD Farm 2 or Elements Plug-Ins on the 
recorded audio track in the DAW later!)

•	 Without using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into 
your device and configure the Line 6 Audio-MIDI Settings dialog to feed your “dry” input 
source to your device’s Record Sends. See “Mac® Driver Settings” on page 2•1 for more about this. 
Note that when using this option, you won’t have the benefit of POD Farm 2 ToneDirect™ 
Monitoring when not running POD Farm 2 in standalone mode, so you’ll need to enable your 
DAW software’s monitoring feature on the audio track (more on this in the next section).

POD X3 devices - Plug a Mic or Instrument into your POD X3 and configure the options within 
X3’s onboard Outputs - Studio/Direct Mix settings screen to determine what type of signal is fed 
to the X3’s Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your POD X3 Pilot’s Handbook for 
details on X3’s Output screen options. 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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PODxt devices - Plug a Mic or Instrument directly into your PODxt device and configure the 
options within the Line 6 Audio-MIDI Settings dialog for the type of signal (Processed or Dry) that 
is fed to the Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your PODxt Pilot’s Handbook for 
details about output options.

Monitoring through the DAW software - If you are using POD Studio/TonePort/GuitarPort hardware 
and not running POD Farm 2 in standalone operation, then you’ll need to use the DAW software’s own 
monitoring feature to hear your input signal routed through the DAW software’s audio track, as called 
out in the following steps. This also means you’ll hear the input signal effected with any Plug-Ins, such 
as if you have POD Farm 2 Plug-In inserted on the same audio track. You may need to set your DAW 
software’s buffer size fairly low to minimize the “latency” (the time between when you pluck a note 
on your guitar to the time you actually hear it after feeding through your DAW software and out your 
speakers). We’ll cover all these steps here.

Info View

First a handy tip... If you are new to Ableton Live then you might want to turn on the Info View panel. 
This displays a brief description of the user interface element within Live that your mouse is currently 
over. You can show/hide this panel by choosing it from Live’s View menu:

Configuring Live to Use the Line 6 Core Audio Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps.

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Launch the Ableton Live Preferences dialog:

Just as with most DAW software, in Live you also need to configure the 
individual inputs and outputs once a Multi-in/out device is selected. Click on 
the Input Config button to access the Inputs.

Go to the Live menu 
and choose Preferences

Go to the Audio tab

Choose CoreAudio as the driver type…

Then choose your Line 6 device for both 
the Input and Output Audio Device. In 
this example, we’ll choose our connected 
UX2

Set a Sample Rate – 44,100 is a good 
choice here, or you can use 48,000, 
88,200 or 96,000 Hz if your Project 
requires a higher sample rate

Activate Inputs:

Here you can “activate” all the inputs from your 
Line 6 hardware that you want to be accessible 
for any audio track as a track input for recording

Click OK when done

You’ll want at least the 1 (mono) & 2 (mono) and the 1/2 (stereo) inputs activated. Each additional 
activated input utilizes more CPU, so only activate the ones you need!

Note that you’ll see a different number of inputs listed in the Input Config dialog depending on 
the specific Line 6 device you are using. Typically these enumerated inputs correspond to the Line 6 
device’s Sends of the same number (i.e. - Live’s input “1/2 (stereo)” is the UX2 Record Send 3-4).  
More about this when we get to the part about setting up your audio track.

POD Studio, TonePort & GuitarPort devices (except UX8): You will see 4 Mono inputs and 2 
Stereo inputs, as pictured above.

UX8: You’ll see 12 Mono inputs and 6 Stereo inputs.

The UX8 driver offers multiple Inputs and Sends with many flexible options for routing and monitoring. 
Please see “Line 6 Audio-MIDI Settings - Inputs & Recording Tab (UX8 Only)” on page 2•7.
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POD X3 devices: You’ll see 8 Mono inputs and 4 Stereo inputs.

POD X3 offers several onboard options for the type of signal that is assigned to each Send. For more info 
about POD X3 Sends, please see page 2•5 and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see 2 Mono inputs and 1 Stereo input.

PODxt offers onboard options, as well as options within the Line 6 Audio-MIDI Settings dialog for the 
type of signal that is assigned to the Record Send. For more info about the PODxt Sends, please see page 
2•6 and your PODxt Pilot’s Handbook.

Activate Outputs:

To access the outputs, click the Output Config button back in the Live Preferences > Audio tab. This 
will show you all outputs available for your selected Line 6 Output Device. 

For all Line 6 devices (except UX8), the Core Audio driver offers Output 1/2, therefore, the dialog will 
show its two mono and one stereo output options, and they will automatically be selected. 

UX8: You’ll see 8 mono and 4 stereo outputs. For most Live projects, you likely only need to enable 
the Output 1/2 mono and stereo options and assign all track playback to one common output. 

Note: The Ableton Live Lite versions allow only one stereo output to be used at a time. To be able to 
choose two or more different output devices in a Live Set, you must switch into Demo mode, or upgrade 
to a full version of Ableton Live.

Configure Record Options

Back in  the Live Preferences dialog, select the Record options:

Select the Record 
Warp Launch tab

For File Type you can 
select  AIFF or WAV, 
whichever format you 
prefer your recorded 
audio files to be created 
as. 

For Bit Depth, select 24 
Bit
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Configuring an Audio Track for Recording 

Now that your Line 6 hardware is set up, you are ready to start working in a Live Set!  Create a new 
Live Set (or open an existing one) and insert a new audio track to record into.

Choose Insert Audio Track from 
Live’s Insert menu

In the following example, we’ve inserted two audio tracks, assigned their outputs to the “Master” track, 
and assigned the Master Output to the stereo Main 1/2 output of our Line 6 device (UX2). For Audio 
Track inputs, note that you can select from the mono or stereo inputs of your Line 6 device, which you 
“activated” in the previous steps. If you choose a stereo input, a stereo audio file will be recorded into 
the track - Likewise, if you choose a singular mono input, a mono audio file will be recorded.

Choose the Arrangement 
View

(Alternatively, you can ac-
cess all these same settings 
in the Session View if you 
prefer)

Click the I-O toggle but-
ton to display the Input/
Output settings for the 
tracks

To configure your Audio 
tracks:

Choose Ext. In for the Input 
Type

Then choose the stereo or 
mono input you want to 
record from

Set your Audio tracks’ Output 
to Master

Note that here we’ve chosen 
to record from UX2’s Send 
1-2 for track 1, and Send 1 for 
track 2

On the Master track, choose the 
stereo Out 1/2 of your Line 6 device 
for both the Cue Out and Master 
Out

* Note that the Master Track offers two Output selectors. The top selector is to set a “Cue Out”, which 
allows you to route a separate output for playback of browser clips and previews. If you have a UX8 device, 
then you can set this Cue Out to a different stereo output to allow you to listen to previews on a completely 
separate headphone or speaker out. Please see Live’s documentation regarding the Cue Out feature. For all 
other Line 6 hardware, set both Master Outs to the same Out 1/2.
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Set Input Monitoring Options

As mentioned in the previous Choose your Line 6 Gear Configuration section, you’ll want to keep 
Live’s Monitor function to “off” if you are utilizing POD Farm 2 in standalone operation, or if using 
POD X3 or PODxt for their hardware Monitoring capabilities. 

Click the audio track’s Monitor Off 
button

If you are using POD Studio/TonePort/GuitarPort and not running POD Farm 2 in standalone 
operation, then you’ll want to turn Live’s Monitor feature to “Auto” on this track to hear your input 
signal through the Live software. You’ll likely also want to insert POD Farm 2 Plug-In and/or Elements 
Plug-Ins on this audio track now and dial in a Tone to hear applied to your input signal while recording. 
See Live’s documentation for more about its Monitor options.

Arm Your Track & Set Your Levels

Click the Arm button to arm the audio track for recording

Note that you’ll see the meters measure your input recording 
level once the track is armed

The type of signal coming into the Live audio track, and how you adjust its input level, depends upon 
the configuration of Line 6 gear you’ve selected, as covered at the start of this chapter. 

•	 If you are using POD Studio/TonePort/GuitarPort hardware and not running POD Farm 2 in 
standalone operation, then you’ll need to use your guitar’s volume knob, the hardware’s Mic 
Gain knob, or the volume on the external device plugged into any Line In.

•	 If you are using POD X3/PODxt hardware, adjust your levels using the onboard Output controls 
for what is routed to the Record Send you’ve selected for the audio track’s inputs.

•	 If you are using POD Farm 2 in standalone operation, use POD Farm 2’s Mixer View. Here you 
can choose the type of signal fed to either Record Send and adjust the Record Send fader levels 
independently of the signal you hear coming from the ToneDirect™ Monitoring signal!

Adjust the Record 
Send Levels

Choose the type of “Source” signal 
that is fed to each Send (Processed, 
Dry or Semi-Processed)* If the Record Send output 

is still very low, activate the 
+18 boost 

POD Farm 2 standalone Mixer - Record Send controls
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*Note that you’ll have different options for POD Farm 2 Record Send Sources depending on if you 
currently have a Single or Dual Tone running. Please see the “Mixer View” on page 4•1.

Start Recording!

Once your record level is set, click on Live’s transport Record button to put it 
into Record Mode, then press Play and start riffing!

Using POD Farm 2 & POD Farm Elements Plug-Ins in Live

To follow we’ve provided some pointers for using POD Farm 2 & Elements Plug-Ins within Ableton 
Live. Ableton Live sometimes requires a few unique, configuration steps for Mac® AU & VST plug-ins, 
so we’ve covered them here. Please also see the additional plug-in tutorials in the POD Farm 2 & POD 
Farm 2 Elements Plug-In chapter, on page 3•2.

Activating Effects Plug-Ins in Live

Launch Ableton Live and select the Plug-In Device Browser. If you don’t automatically see the POD 
Farm 2 & Elements AU and/or VST Plug-Ins listed here, then you’ll probably see an Activate button, 
meaning you need  Live to “activate” all plug-ins on your system (this has nothing to do with the Line 
6 “Plug-In Activation” by the way, it is strictly a Live feature for all effects plug-ins):
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Click the Activate button   

Click on the button to 
display the Plug-In Device 
Browser  

Clicking the Activate button displays the Preferences dialog with several options - select the File 
Folder tab to get to the Plug-In Sources options.

Ableton Live AU Plug-In Activation

Click the Use Audio Units 
button so that it becomes “On”

Once Use Audio Units is enabled, Live will scan your Mac® and display all found AU plug-ins in 
the Plug-In Devices browser panel, including your POD Farm 2 & Elements plug-ins within a Line 6 
folder, like this:
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POD Farm 2 & Elements AU Plug-Ins in the Live Plug-In Devices Browser

Ableton Live VST Plug-In Activation

Just like above for the AU plug-ins, if you do not already see the Line 6 VST plug-ins in Live’s Plug-In 
Browser, then go to the Live > Preferences > File Folder window again and turn the VST feature on:

Click the Use VST Plug-
In System Folders so that it 
becomes “On”

Live will run its scan and display all found VST Plug-Ins, including POD Farm 2 & Elements plug-ins, 
in the Plug-In Devices browser panel like this:

POD Farm 2 & Elements VST Plug-Ins in the Live Plug-In Devices Browser
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If the Line 6 VST plug-ins do not appear in the browser, try clicking the Rescan button in the Live > 
Preferences > File Folder window.

Insert a Plug-In on a Track

To insert POD Farm 2 or an Elements Plug-In on your track, simply drag and drop! 

Click on the desired plug-in within the Live Plug-In Devices Browser and drag 
& drop it directly onto an Audio or Bus Track to “insert” it on the track.

Hit play and you’ll hear the Plug-In do its thing to the playback of the audio within your track. Tweak 
the POD Farm 2 or Elements Plug-In settings to dial in the perfect tone. 

Plug-In Parameter Automation in Ableton Live

Ableton Live offers features for creating and editing automation envelopes for AU or VST plug-in 
parameters, and POD Farm 2 and POD Farm Elements Plug-Ins all allow you to take full advantage 
of this feature! To follow, we’ve provided some specifics for accessing the plug-in parameters within a 
Live audio or bus track. 

Ableton Live functions much like other DAW applications in respect to displaying automation 
envelopes and “writing” Plug-In parameter automation. It is highly recommended to first read through 
“Parameter Automation with POD Farm 2 & Elements Plug-Ins” on page 3•10  for a good example of how 
this is typically accomplished in DAW applications. 

Ableton Live requires some additional, specific configuration steps before you’ll be able to see the 
POD Farm 2 Plug-In Automation Slots within its audio or bus tracks’ “Control Chooser” (automation 
parameter) menus. 

These confiration steps are not necessary for Elements Plug-Ins. The Elements Plug-Ins’ parameters will 
automatically appear in the Live track’s Control Chooser. If using an Elements Plug-In, skip ahead to 
“Adjusting a Plug-In Parameter Envelope” on page 5•13.

•	 Once POD Farm 2 VST or AU Plug-In is inserted on a track in your Ableton Live project, assign 
the POD Farm 2 Knob & Switch parameters that you wish to expose for automation (follow the 
steps as described in “Assigning POD Farm 2 Parameters to Automation Slots” on page 3•12).
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•	 In the Live “Device Panel,” place the inserted POD Farm 2 Plug-In into “Configure Mode.”

Click the arrow button to 
expand the Live “Plug-In 
Device” window

Click the Configure button 
to put the Plug-In into 
“Configure Mode” 

Placing the inserted POD Farm 2 Plug-In into Configure Mode in Ableton Live

•	 Next, go into the POD Farm 2 Plug-In window, display the Panel View for the Amp or Effect for 
which you have assigned a Knob or Switch parameter to an Automation Slot, and click once on 
the specific Knob or Switch control. For example, we assigned the Analog Delay W/Mod effect’s 
Mix knob to the Knob 2 Automation Slot. So we’ll click on this Mix knob in the POD Farm 2  
Plug-In GUI: 

Click on the Delay’s assigned 
Mix knob... 

The “Knob 2” Automation 
Slot then appears within the 
Live project’s POD Farm 2 
Plug-In “device” window

Configuring an “assigned” POD Farm 2 Plug-In parameter in Ableton Live

•	 Repeat the above steps to configure all your assigned POD Farm 2 Plug-In parameters, and then 
go to the Ableton Live “Control Chooser” for your track and you’ll be able to access each of 
these as automatable parameters. 

The assigned Automation Slots we 
configured now appear in the Live 
Control Chooser list as automatable 
parameters

The Ableton Live track Control Chooser showing “configured” POD Farm 2 Plug-In parameters
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Adjusting a Plug-In Parameter Envelope

To access the “automation envelope” for a POD Farm 2 or Elements Plug-In parameter, select the 
desired parameter from the Live track’s Control Chooser selector (see previous section) where the 
Plug-In is inserted. We’ll choose the POD Farm 2 Plug-In -  Knob 2 to access its assigned Analog 
Delay W/Mod - Mix knob. (If you inserted an Elements Plug-In, you can choose any of its parameters 
from the list.) 

Once a parameter is selected, a red envelope line appears 
across the track - you can click and drag this line up/down to 
adjust the selected parameter

Click on the track’s Control 
Chooser and select Knob 2

Double click on the envelope line to create a 
“breakpoint”.  Here, breakpoints are added where we 
want to start and end the parameter change. Note 
that when the mouse cursor is over a breakpoint, the 
parameter value at this position is displayed

Now you can add additional breakpoints and drag them 
up/down to have the Analog Delay-Mix parameter value 
change over time. Here, the results are that no Delay 
effect is heard until bar 13, then it goes to a 50% Mix, and 
gradually back to no Delay by the end of Bar 20

Ableton Live also features a Draw Mode tool, which allows you to literally “draw” the parameter 
envelope right over the track. You can select the Draw Mode tool from Live’s control bar at the top of 
the window, then use it like a pencil to draw on the track.

Click on the Draw Mode tool Then “draw” your parameter changes directly on the track

Turn off the Draw Mode tool and you can click any individual breakpoint and adjust it up/down to 
fine tune your adjustments, as shown above. Now open the POD Farm 2 Plug-In GUI and select the 
Analog delay W/Mod effect in Panel View and hit Rewind and Play in Live. You’ll see the Delay’s Mix 
knob move in response to this recorded automation, and you’ll hear the Mix change over time!



Ableton Live 8 - Mac

5•14

Using the Automation Write Modes in Ableton Live

Suppose you want to add some “Wah” effect to your recorded guitar track. A great way to do this is 
to tweak and record your Wah Position knob moves while you are playing back the track, so you can 
hear and record your Wah tweaks in real-time. First, load the Elements “POD Farm Wahs” Plug-In 
on your audio track, and select one of its Wah models. (Alternatively, you can insert POD Farm 2 
Plug-In, choose one of its Wah models on your Tone, and assign the Wah Position knob to a “Knob” 
Automation Slot, as shown in the previous steps.) 

Within the Live audio track’s header, use the Device Chooser and Control Chooser as in the previous 
example - this time we’ll select the POD Farm Wahs Plug-In - Pedal Pos parameter.*

 

* Note: It is not actually necessary to select the POD Farm Wahs Plug-In or the specific parameter in 
Live’s Track Chooser selectors, since when you go into the Record mode in the next steps, any POD Farm 
2 Plug-In or Ableton Live track parameters’ adjustments will be recorded, whether the envelope on the 
track is currently displayed or not. However, selecting the specific parameter in the track’s Chooser allows 
you to see your adjustments being written to the track envelope in real-time. 

You’ll want to have the POD Farm Wahs Plug-In GUI open, and so that you have access to the Wah  
position knob for tweaking.

Next, click on Live’s Transport Record button to place it in “Record Ready” mode - note that you do 
not want your audio track’s Record Arm button on since that will record audio into your track (and 
possibly overwrite your current audio clip). When ready, press the transport Play button and start 
tweaking the Wah Position knob. You’ll hear the effect applied as the track plays, and you’ll see your 
adjustments being “recorded” via the envelope on the track. Do not adjust any other plug-in or Live 
track parameters while in this Record mode, since any such settings changes will be recorded as well. 
Hit your spacebar to stop Live when done. If you didn’t like what you just did, just select Edit > Undo 
in Live before you do any other edits and try again. 
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Now start tweaking the Wah position knob 
and you’ll see your adjustments recorded on 
the Live track

Click on the Transport’s Record button, 
and then the Play button when ready

TIP: Instead of using your mouse to adjust the Wah knob, you can alternatively assign a MIDI controller 
pedal to the Wah Position parameter and wangle it just like your trusty old wah pedal - see “External MIDI 
Control with POD Farm 2 Plug-In” on page 3•7.

Once stopped, you’ll see the Device and Control Choosers show red dots to indicate the parameter has 
been “edited”. Further, if you click on the Control Chooser to expand the menu, any plug-in parameter 
that has “edited” automation is shown here with a red dot. You can also now zoom in and further adjust 
the individual “breakpoints” on the envelope, as in the earlier example, to fine tune your automation.

Red dotes indicate the 
parameter has been edited

Click and drag to adjust the 
envelope’s breakpoints

Once done with your automation for the Wah parameter, it is a good idea to Ctrl+click on the track 
and choose “Lock Envelopes” to prevent the envelope from being overwritten. Or, you can leave 
envelopes “unlocked” and repeat the previous steps to record automation for any number of Elements 
or POD Farm 2 Plug-In parameters. 
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Apple GarageBand® ‘09 Setup
For this chapter, we’ll show how to configure Apple GarageBand® ‘09 to work with Line 6 POD 
Studio™, TonePort™, GuitarPort™, POD X3 or PODxt as the USB audio device, as well as optionally 
using POD Farm™ 2 Plug-In and/or POD Farm™ 2 in standalone operation on your Mac® computer.  
The steps are very similar for the setup of other recent GarageBand versions as well.

Choose Your Line 6 Gear Configuration

Before you record your first track in any DAW software, you have a few options to consider  with your 
Line 6 hardware & POD Farm 2 gear! You should decide if you want to record a “dry” signal into the 
audio track, such as if you want to utilize POD Farm 2 Plug-In to “non-destructively” apply your POD 
Farm 2 Tone onto the recorded track. Or, if you prefer to record a “processed” signal, where the POD 
Farm 2 Amp/Preamp and Effects are already applied and recorded permanently on the track. We’ll 
cover the steps to record either of these ways, but first it is helpful to understand the options with your 
particular Line 6 gear.

POD Studio, TonePort, GuitarPort devices 

•	 Using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into your Line 
6 device and launch POD Farm 2 in standalone operation. Use the Mixer View - Record Send 
Source options to choose the type of signal fed to your Record Sends. Also see “POD Farm™ 2 
Standalone Operation” on page 4•1 for more about the Mixer View. 

•	 Tone A, Tone B or Tone A+B - Feeds the same fully processed signal from the respective 
Tone path(s) that you hear out to the Record Send.

•	 Tone A (semi) - This option is available only when a single Tone A exists in POD Farm 2.  
It feeds only the signal processed with the Amp group of models (Amp/Cab/Mic/Preamp 
models) plus any effects inserted to the left of the Amp group within Tone A. Note that 
you’ll still hear the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ 
Monitoring output. (Useful, for example, if you want to hear a delay or reverb effect inserted 
after the Amp group, but do not want that delay effect recorded!)

•	 Dry Input - Feeds a completely unprocessed signal to the Record Send, even though you can 
listen to the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ Monitoring 
output. (This is a great option if you want to insert POD Farm 2 or Elements Plug-Ins on the 
recorded audio track in the DAW later!)

•	 Without using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into 
your device and configure the Line 6 Audio-MIDI Settings  dialog to feed your “dry” input 
source to your device’s Record Sends. See “Mac® Driver Settings” on page 2•1 for more about this. 
Note that when using this option, you won’t have the benefit of POD Farm 2 ToneDirect™ 
Monitoring when not running POD Farm 2 in Standalone mode, so you’ll need to enable your 
DAW software’s monitoring feature on the audio track (more on this in the next section).

POD X3 devices - Plug a Mic or Instrument into your POD X3 and configure the options within 
X3’s onboard Outputs - Studio/Direct Mix settings screen to determine what type of signal is fed 
to the X3’s Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your POD X3 Pilot’s Handbook for 
details on X3’s Output screen options. 

PODxt devices - Plug a Mic or Instrument directly into your PODxt device and configure the 
options within the Line 6 Audio-MIDI Settings dialog for the type of signal (Processed or Dry) that 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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is fed to the Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your PODxt Pilot’s Handbook for 
details about output options.

Monitoring through the DAW software - If you are using POD Studio/TonePort/GuitarPort hardware 
and not running POD Farm 2 in standalone operation, then you’ll need to use the GarageBand 
Monitoring feature to hear your input signal routed through the software’s audio track, as called out in 
the following steps. This also means you’ll hear the input signal effected with any Plug-Ins, such as if 
you have POD Farm 2 Plug-In inserted on the same audio track. You may need to set your GarageBand  
buffer size options fairly low to minimize the “latency” (the time between when you pluck a note on 
your guitar to the time you actually hear it after feeding through GarageBand and out your speakers). 
We’ll cover all these steps here.

Configure Your Mac® to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Mac® System Preferences and select the 
Line 6 Audio-MIDI Devices dialog to access the Audio Driver settings. If needed, please see “Mac® 
Driver Settings” on page 2•1. 

Configuring GarageBand to Use the Line 6 Core Audio Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps.

Launch GarageBand and choose Preferences from the menu:

Select your Line 6 device for both the “Audio 
Output” and “Audio Input”

Select Audio/MIDI

Note that after changing the Audio Input 
and Output options you may be prompted if 
you want to change the audio driver - click 
“Yes” for this prompt

Set the “Optimize for” option to “Minimum 
delay” for the best performance. If your 
session is large and you start getting audio 
drop-outs, come back here and choose the 
“Maximum” option

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Also, go to the Advanced page of the Preferences to set the audio quality.

Set the “Audio Resolution” option to 
“Best”. This sets GarageBand to record 
and playback at 24 bit, to match the 
higher audio quality settings of your 
Line 6 device

Go to the “Advanced” page 

Configuring an Audio Track for Recording 

Now that your Line 6 hardware is set up, you are ready to start working in a new project! 

Open or create a new GarageBand song project…

Select New Track from the GarageBand 
Track menu

Select Real Instrument Track, and click Create
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You should now see a new audio track (or “Real Instrument” track, as GarageBand calls it), added 
to your project. Click on the track header to make sure it is the selected track, and you’ll see the 
properties for this new track at the right, in the Track Info panel’s - Real Instrument tab.

Adjust the “Recording Level” slider to 
around 75% - this affects the amplitude of 
the signal being fed into the GarageBand 
track, but it is best to keep it at this moderate 
setting and use your Line 6 hardware and/or 
POD Farm 2 Mixer Record Send controls to 
adjust your recording level

Keep the “Automatic Level Control” 
unchecked

For the “Input Source”, you’ll see all the 
available mono and stereo Inputs for your Line 6 
device - choose the one you want to record from.

Leave “Monitor” set to “Off” 
(See below about Monitor options)

Monitor Options

As mentioned in the previous Choose your Line 6 Gear Configuration section, you’ll want to keep 
the GarageBand Monitor function “off” if you are utilizing POD Farm 2 in standalone operation, or if 
using POD X3 or PODxt for their monitoring capabilities. 

If you are using POD Studio/TonePort/GuitarPort and not running POD Farm 2 in standalone 
operation, then you’ll want to check the box for the GarageBand Monitor feature for this audio track 
to hear your input signal through the GarageBand software. You’ll likely also want to insert POD Farm 
2 and/or Elements Plug-Ins on this audio track now and dial in a Tone to hear them applied to your 
input signal while recording. See the GarageBand documentation for more about its Monitor options.

About Input Source Options

In the GarageBand Input Source menu, you will see slightly different input sources depending on your 
specific Line 6 device:

POD Studio, TonePort (except UX8) & GuitarPort: You’ll see options similar to this:

•	 The individual Mono 1 thru 4 options receive input from the hardware’s respective Record 
Sends 1 thru 4, and record a mono file.

•	 The Stereo 1/2 and Stereo 3/4 options receive input from the hardware’s respective Record 
Sends 1-2 and 3-4, and record a stereo file. 
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*Note that you’ll have different options for POD Farm 2 Record Send Sources depending on if you 
currently have a Single or Dual Tone running. Please see the “Mixer View” on page 4•1.

TonePort UX8: You’ll see the following options:

•	 The Mono Input 1 thru 8 options receive input from the hardware’s respective Record Sends 1 
thru 8.

•	 The individual Mono 9 thru 12 options receive input from the POD Farm 2 Record Sends 9 thru 
12*, and record a mono file (when POD Farm 2 is running in standalone operation).

•	 The Stereo 1/2 thru Stereo 7/8 options receive input from UX8’s respective Record Sends 1-2 
thru 7-8, and record a stereo file. 

•	 The Stereo 9/10 and Stereo 11/12 options receive input from the respective the POD Farm 
2 Record Sends 9-10 and 11-12*, and record a stereo file (when POD Farm 2 is running in 
standalone operation).

* Note that the type of signal fed into Record Sends 9-10 and 11-12 is determined by the Source options 
you select in the POD Farm 2 “Mixer View”. The UX8 driver additionally offers multiple Inputs and 
Sends with many flexible options for routing and monitoring. Please see “Line 6 Audio-MIDI Settings - 
Inputs & Recording Tab (UX8 Only)” on page 2•7. 

POD X3 devices: You’ll see the following options:

•	 The individual Mono 1 thru 8 options receive input from the respective POD X3 Record Sends 
1 thru 8, and record a mono file.

•	 The Stereo 1/2 thru Stereo 7/8 options receive input from the respective POD X3 Record Sends 
1-2 thru 7-8, and record a stereo file.
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POD X3 offers onboard options for the type of signal that is fed to Record Sends 1-2 within its onboard 
Output screen options, while Record Sends 3-8 all carry Dry input signals. For more info about POD X3 
Sends, please see page 2•5 and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see the following options:

•	 The individual Mono 1 and 2 options receive input from the respective PODxt Record Sends 1 
and 2, and record a mono file.

•	 The Stereo 1/2 option receives input from the respective PODxt Record Send 1-2, and records 
a stereo file.

PODxt offers options for the type of signal fed to the Record Sends within the Line 6 Audio-MIDI Settings 
dialog. For more info about the PODxt Sends, please see page 2•6 and your PODxt Pilot’s Handbook.

GarageBand Track Effects and POD Farm 2 & Elements Plug-Ins

Within the lower portion of the Track Info panel’s Edit tab, GarageBand offers a number of optional 
track effects, and some are typically on by default on a new “Real Instrument” track. You probably want 
to toggle them off if you are recording a processed signal from the POD Farm 2 standalone application, 
or from a POD device. 

If you are recording a dry signal into the track, then you might want to use some of these effects to 
non-destructively process the playback of your recorded track. If you want to insert POD Farm 2 or 
Elements Plug-Ins on the audio track, you can click on any of the 4 pop-up menus here and choose one 
of your Line 6 plug-ins from the menu. As mentioned in the Monitoring options section above, if you 
have the GarageBand Monitor option active, then you’ll also hear your input source with any of these 
effects applied to it as it is fed through the GarageBand software. 

To get to the track effects for the selected track, go to the Track Info panel’s Real Instrument - Edit tab:

The “built-in” track effects can be 
enabled/disabled by clicking on the 
button at the left of each 

To insert POD Farm 2, an Elements  
Plug-In (or any other AU Plug-In 
installed on your system), select it 
in one of the four empty effect slots
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It is important to note that, unlike in many other DAW applications, the “Real Instrument” audio 
tracks in GarageBand always function as stereo. Even if you choose a mono sound card input for re-
cording into the track, the output of the track is stereo. Therefore, whenever you insert a POD Farm 
2 or Elements Plug-In on a Real Instrument track, it will be inserted as a stereo plug-in, allowing all 
models to process and output in full stereo playback. 

Arm Your Track and Set Your Recording Levels

Note that the track meters measure the input 
signal once the track is armed

Double click here and type in a name 
for your track

Press the Arm button to prepare your 
track for recording

The type of signal coming into your GarageBand track, and how you adjust its input level, depends 
upon the configuration of Line 6 gear you’ve selected, as covered at the start of this chapter. 

•	 If you are using POD Studio/TonePort/GuitarPort hardware and not running POD Farm 2 in 
standalone operation, then you’ll need to use your guitar’s volume knob, the hardware’s Mic 
Gain knob, or the volume on the external device plugged into any Line In.

•	 If you are using POD X3/PODxt hardware, adjust your levels using the onboard Output controls 
for what is routed to the Record Send you’ve selected for the audio track’s inputs.

•	 If you are using POD Farm 2 in standalone operation, use the POD Farm 2 Mixer View. Here you 
can choose the type of signal fed to either Record Send and adjust the levels independently of 
the signal you hear coming from the ToneDirect™ Monitoring signal!

Adjust the Record 
Send Levels

Choose the type of “Source” signal 
that is fed to each Send (Processed, 
Dry or Semi-Processed)* If the Record Send output 

is still very low, activate the 
+18 boost 

POD Farm 2 standalone Mixer - Record Send controls

*Note that you’ll have different options for POD Farm 2 Record Send Sources depending on if you 
currently have a Single or Dual Tone running. Please see the “Mixer View” on page 4•1.
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Start Recording!

Click on the transport Record button and start recording!

Plug-In Parameter Automation in GarageBand

GarageBand offers features for creating and editing automation envelopes for AU plug-in parameters, 
and POD Farm 2 and POD Farm Elements plug-ins all allow you to take full advantage of this feature! 
Please first refer to the information on configuring POD Farm 2 and Elements Plug-Ins for automation 
in “Parameter Automation with POD Farm 2 & Elements Plug-Ins” on page 3•10.  To follow, we’ve 
provided some specifics for accessing the plug-in parameters within a GarageBand track. 

For this example, start by adding a “Real Instrument” track to your GarageBand project, and import or 
record an audio clip into the track (a dry guitar clip would work great here). Then insert POD Farm 2 
Plug-In on the track.

Note that to access POD Farm 2 Plug-In model parameters, you must first assign each desired parameter 
to one of the POD Farm 2 Automation Slots - please see page 3•12.

In the track header, click the arrow button to display an 
automation lane

Click on the Parameter Menu and select “Add Automa-
tion” - this displays the Add Automation dialog.

In the Add Automation dialog, click the arrow at the left 
of POD Farm 2 to expand its list of parameters. Check the 
“Knob,” “Switch” or “Fixed” parameter(s) for which you 
want to have an Automation Envelope displayed. (Note 
that you’ll need to scroll down to see all parameters.)
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TIP: These steps are the same for any POD Farm Elements Plug-In. With an Elements Plug-In inserted 
on the track, in the above steps you would simply check any of its “fixed” parameters to show their  
Automation Envelopes!

Once you’ve created the Automation Envelope for the plug-in, you can click directly on the envelope 
line to create “Nodes”, which allow you to adjust the envelope to manipulate the parameter over time. 
Play your GarageBand project to hear the POD Farm 2 effect respond! 

Click on the Envelope line to add 
adjustable “Nodes” and automate the 
parameter 

Please see your GarageBand documentation for more about its Automation features.
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Apple Logic® Pro 9 Setup
For this chapter, we’ll show how to configure Apple Logic® Pro 9 to work with Line 6 POD Studio™, 
TonePort™, GuitarPort™, POD X3 or PODxt as the USB audio device, as well as optionally using 
POD Farm™ 2 Plug-In and/or POD Farm™ 2 in standalone operation on your Mac® computer.  The 
steps are very similar for the setup of Apple Logic® Express, as well as other recent Logic versions.

Choose Your Line 6 Gear Configuration

Before you record your first track in any DAW software, you have a few options to consider  with your 
Line 6 hardware & POD Farm 2 gear! You should decide if you want to record a “dry” signal into the 
audio track, such as if you want to utilize POD Farm 2 Plug-In to “non-destructively” apply your POD 
Farm 2 Tone onto the recorded track. Or, if you prefer to record a “processed” signal, where the POD 
Farm 2 Amp/Preamp and Effects are already applied and recorded permanently on the track. We’ll 
cover the steps to record either of these ways, but first it is helpful to understand the options with your 
particular Line 6 gear.

POD Studio, TonePort, GuitarPort devices 

•	 Using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into your 
device and launch POD Farm 2 in standalone operation. Use the Mixer View - Record Send 
Source options to choose the type of signal fed to your Record Sends. Also see “POD Farm™ 2 
Standalone Operation” on page 4•1 for more about the Mixer View. 

•	 Tone A, Tone B or Tone A+B - Feeds the same fully processed signal from the respective 
Tone path(s) that you hear out to the Record Send.

•	 Tone A (semi) - This option is available only when a single Tone A exists in POD Farm 2.  
It feeds only the signal processed with the Amp group of models (Amp/Cab/Mic/Preamp 
models) plus any effects inserted to the left of the Amp group within Tone A. Note that 
you’ll still hear the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ 
Monitoring output. (Useful, for example, if you want to hear a delay or reverb effect inserted 
after the Amp group, but do not want that delay effect recorded!)

•	 Dry Input - Feeds a completely unprocessed signal to the Record Send, even though you can 
listen to the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ Monitoring 
output. (This is a great option if you want to insert POD Farm 2 or Elements Plug-Ins on the 
recorded audio track in the DAW later!)

•	 Without using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into 
your device and configure the Line 6 Audio-MIDI Settings  dialog to feed your “dry” input 
source to your device’s Record Sends. See “Mac® Driver Settings” on page 2•1 for more about this. 
Note that when using this option, you won’t have the benefit of POD Farm 2 ToneDirect™ 
Monitoring when not running POD Farm 2 in Standalone mode, so you’ll need to enable your 
DAW software’s monitoring feature on the audio track (more on this in the next section).

POD X3 devices - Plug a Mic or Instrument into your POD X3 and configure the options within 
X3’s onboard Outputs - Studio/Direct Mix settings screen to determine what type of signal is fed 
to the X3’s Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your POD X3 Pilot’s Handbook for 
details on X3’s Output screen options. 

PODxt devices - Plug a Mic or Instrument directly into your PODxt device and configure the 
options within the Line 6 Audio-MIDI Settings dialog for the type of signal (Processed or Dry) that 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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is fed to the Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your PODxt Pilot’s Handbook for 
details about output options.

Monitoring through the DAW software - If you are using POD Studio/TonePort/GuitarPort hardware 
and not running POD Farm 2 in standalone operation, then you’ll need to use the DAW software’s own 
monitoring feature to hear your input signal routed through the DAW software’s audio track, as called 
out in the following steps. This also means you’ll hear the input signal effected with any Plug-Ins, such 
as if you have POD Farm 2 Plug-In inserted on the same audio track. You may need to set your DAW 
software’s buffer size fairly low to minimize the “latency” (the time between when you pluck a note 
on your guitar to the time you actually hear it after feeding through your DAW software and out your 
speakers). We’ll cover all these steps here.

 Configuring Logic Pro to Use the Line 6 Core Audio Driver

Launch the Logic Pro application. If a project opens, go to Logic’s File menu and select Close Project 
to exit it. 

Open the Logic Preferences

Go to the Logic Pro menu and 
choose Preferences > Audio

Check the Enable box

Select your Line 6 device for both the 
Output & Input device 

Set the I/O Buffer Size to 256.* If 
you encounter audio drop-outs in your 
Logic Pro Projects, come back here and 
raise this to a slightly higher value

Check the box for 24 Bit Recording

If you will not be using POD Farm 2 
in standalone operation (but rather 
inserting a Plug-In on your audio track 
for recording), you’ll probably want to 
check the Software Monitoring option*

Click Apply Changes when done

Click on the Core Audio tab 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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*As mentioned above, if you will not be running POD Farm 2 in standalone operation, and instead utilizing 
Logic’s software monitoring feature, then you may want to set the I/O buffer size here to the lowest value 
that still offers playback & recording stability with your project. This will minimize latency.

Create & Configure a New Project

Go to the File menu and select New

In the New... dialog, choose 
Empty Project

Typically, Logic will immediately prompt you with the New Track dialog, where you can create one or 
more audio tracks, and designate the track’s input and output. 

Type in the number of tracks and type to be created - 
we’ll just add one audio track

Choose Mono or Stereo for the track Format

For the Input options, you’ll be able to select either an 
individual mono input or stereo input, depending on 
your Format selection*

The Audio tracks’ Output Routing should default to 
your Line 6 device’s Output 1-2 (see below regarding 
UX8’s Output options)

Keep Input Monitoring and Record Enable 
unchecked.  (We’ll cover more on Monitoring options 
in a later section.)  

*When the Mono Format is chosen, you’ll see one mono Input option for each Send channel that your 
Line 6 device offers. Likewise, if the Stereo Format is chosen, you’ll see one stereo Input option for 
each Stereo Send your hardware offers. Since we’re using a Line 6 UX2 device, the track Input options 
appear like this:

             

Stereo Inputs

Mono Inputs    

You’ll have a different number of track Input and Output options available depending on your specific 
Line 6 device:



Apple Logic Pro 9 - Mac

5•28

POD Studio, TonePort & GuitarPort devices (except UX8): You will see 4 Mono Inputs and 2 
Stereo Inputs, as pictured above.

•	 The individual Mono Inputs 1 thru 4 receive input from the hardware’s respective Record Sends 
1 thru 4, and record a mono file.

•	 The Stereo Inputs 1-2 and 3-4 receive input from the hardware’s respective Record Sends 1-2 
and 3-4, and record a stereo file. 

 Note that if you have POD Farm 2 running in standalone operation, the type of signal fed into Record 
Sends 1-2 and 3-4 (processed, dry or semi-processed) is determined by the Source options you select in the 
POD Farm 2 “Mixer View”. 

UX8: You’ll see 12 Mono inputs and 6 Stereo inputs.

•	 The individual Mono Inputs 9 thru 12 receive input from the POD Farm 2 Record Sends 9 thru 
12*, and record a mono file (when POD Farm 2 is running in standalone operation).

•	 The Stereo Inputs 1/2 thru 7/8 receive input from UX8’s respective Record Sends 1-2 thru 7-8, 
and record a stereo file. 

•	 The Stereo Inputs 9/10 and 11/12 receive input from the respective the POD Farm 2 Record 
Sends 9-10 and 11-12*, and record a stereo file (when POD Farm 2 is running in standalone 
operation).

* Note that the type of signal fed into Record Sends 9-10 and 11-12 is determined by the Source options 
you select in the POD Farm 2 “Mixer View”. UX8’s driver also offers multiple Inputs and Sends with 
many flexible options for routing and monitoring. Please see “Line 6 Audio-MIDI Settings - Inputs & 
Recording Tab (UX8 Only)” on page 2•7. 

POD X3 devices: You’ll see 8 Mono inputs and 4 Stereo inputs.

•	 The individual Mono Inputs 1 thru 8 receive input from the respective POD X3 Record Sends 1 
thru 8, and record a mono file.

•	 The Stereo Inputs 1/2 thru 7/8 receive input from the respective POD X3 Record Sends 1-2 thru 
7-8, and record a stereo file.

POD X3 offers onboard options for the type of signal that is fed to Record Sends 1-2 within its onboard 
Output screen options, while Record Sends 3-8 all carry Dry input signals. For more info about POD X3 
Sends, please see page 2•5 and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see 2 Mono inputs and 1 Stereo input.

•	 The individual Mono 1 and 2 options receive input from the respective PODxt Record Sends 1 
and 2, and record a mono file.

•	 The Stereo 1/2 option receives input from the respective PODxt Record Send 1-2, and records 
a stereo file.

PODxt offers options for the type of signal fed to the Record Sends within the Line 6 Audio-MIDI Settings 
dialog. For more info about the PODxt Sends, please see page 2•6 and your PODxt Pilot’s Handbook.
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Next, we need to select a sample rate for our Project.

Select the Project Settings > Audio dialog 
from the File menu 

44,100 Hz is a good choice for your Sample 
Rate, or you can choose 48,000, 88,200 
or 96,000 Hz if your project specifically 
requires one of these higher rates

Now that the Project is all configured, it’s a good time to Save It! Go to File > Save and  type in a name 
and choose a directory to Save to.

Configuring an Audio Track for Recording 

To follow are a few more quick settings to cover for the audio track configuration. 

Set Input Monitoring Options and Get Armed and Ready

As mentioned in the previous Choose your Line 6 Gear Configuration section, you’ll want to keep the 
Logic Input Monitor function “off” on the audio track if you are utilizing POD Farm 2 in standalone 
operation, or if using POD X3 or PODxt for their Monitoring capabilities. This way, your input is not 
also fed through the Logic software.
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Keep the audio track’s Input Monitor button 
set to OFF*

Click the Record Ready button to ON

Note that once the track is in Record Ready 
mode, you’ll be able to see the input signal 
in both the track header or to the left in the 
“Inspector”. You can use this to reference 
your record levels coming from your Line 6 
device

*If you are using POD Studio/TonePort/GuitarPort an not running POD Farm 2 in standalone 
operation, then you’ll want to turn the Logic track’s Input Monitor button “On” to hear your input 
signal through the Logic software. You’ll likely also want to insert POD Farm 2 and/or Elements Plug-
Ins on this audio track now and dial in a Tone to hear applied to your input signal while recording. See 
the Logic Pro documentation for more about its Input Monitor options.

Set Your Recording Levels

Be sure to set your record levels before you start recording. The signal coming into the Logic track, and 
how you adjust its level, depends upon the configuration of Line 6 gear you’ve selected, as covered at 
the start of this chapter. 

•	 If you are using POD Studio/TonePort/GuitarPort hardware and not running POD Farm 2 in 
standalone operation, then you’ll need to use your guitar’s volume knob, the hardware’s Mic 
Gain knob, or the volume on the external device plugged into any Line In.

•	 If you are using POD X3/PODxt hardware, adjust your levels using the onboard Output controls 
for what is routed to the Record Send you’ve selected for the audio track’s inputs.

•	 If you are using POD Farm 2 in standalone operation, use the POD Farm 2 Mixer View. Note 
that here you can choose the type of signal fed to either Record Send and adjust the levels 
independently of the signal you hear coming from the ToneDirect™ Monitoring signal!
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Adjust the Record 
Send Levels

Choose the type of “Source” signal 
that is fed to each Send*

If the Record Send output 
is still very low, activate the 
+18 boost 

POD Farm 2 standalone Mixer - Record Send controls

*Note that you’ll have different options for POD Farm 2 Record Send Sources depending on if you 
currently have a Single or Dual Tone running. Please see the “Mixer View” on page 4•1.

Start Recording!

Once your record level is set, click on the transport Record button and start riffing!
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Using POD Farm 2 & POD Farm Elements Plug-Ins in Logic

Logic Pro supports the AU Plug-In format, and if you installed the POD Farm 2 & Elements AU 
format Plug-Ins during your POD Farm 2 installation, they should automatically appear in the Logic 
Insert menus. 

To insert a Line 6 Plug-In on your audio track: In the Logic Inspector panel with your audio track 
selected (or in the Logic Mixer panel), click on one of the Insert slots and choose the desired Plug-In 
from the list of effects. Note that if your audio track is stereo, you’ll see “Stereo” versions of the POD 
Farm 2 & Elements Plug-Ins. If your track is mono, you’ll have the option of choosing either “Mono” 
or “Mono-Stereo” for the Plug-In. You’ll want to choose the option that best matches your audio 
track’s signal routing in Logic. Also note that when using any stereo effects within your POD Farm 2/
Elements  Plug-In, if you choose the “Mono” option then the stereo output of these effect models will 
be “folded down” to mono.

Click one of the Insert selectors in 
the Inspector panel for your audio 
track and select POD Farm 2 or an 
Elements Plug-In from the list of 
effects.

In this example, we’re inserting the 
POD Farm 2 Plug-In on the stereo 
audio track 1, therefore, the Plug-In 
option is “Stereo”.

In this example, we’re inserting the 
POD Farm 2 Plug-In on the mono 
audio track 2, therefore, the Plug-
In options are “Mono” or “Mono > 
Stereo”.
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External MIDI Control of POD Farm 2 Plug-In in Logic

Logic offers the ability to access the knobs, sliders & switches of any inserted AU Plug-In remotely, 
via a hardware MIDI controller device, provided the AU Plug-In supports this ability. And POD 
Farm 2 Plug-In does indeed support MIDI Control to allow you to take full advantage of these MIDI  
features! It is recommended that you first get familiar with the POD Farm 2 MIDI Control features 
and configuration covered in the POD Farm 2 Basic User Guide, as well as in the Plug-In chapter 
on page 3•7.

Logic requires some slightly different steps from most DAW applications to route the MIDI input from 
a connected external MIDI controller device into an audio Plug-In such as POD Farm 2. Logic requires 
you insert the Plug-In on a Software Instrument track so that it can receive MIDI input. Any audio 
track that you then want to have POD Farm 2 Plug-In applied to must then be then fed to the Plug-In 
using the Logic “Side Chain” audio routing. Here are the steps:

•	 Connect your external MIDI controller device to your computer, and then launch Logic. In most 
cases, the Logic application will automatically receive MIDI control & Note input from your 
connected device, with no special settings needed within Logic Preferences. 

•	 Do not add POD Farm 2 AU Plug-In as an insert on your Logic audio track. 

•	 Go to Logic’s Track menu and create a new “Software Instrument” track.

•	 In the Software Instrument track’s Input field, select AU MIDI-controlled effects > Line 6 > 
POD Farm 2 > Stereo (or select “Mono”, whichever matches the output of your Audio track 
you will be feeding through the plug-in). This inserts the plug-in on the Software Instrument 
track, which establishes MIDI input into the POD Farm 2 Plug-In instance.

•	 At the top right of the POD Farm 2 Plug-In window, click the Logic Side Chain menu and select 
your audio track here that you want fed through POD Farm 2 Plug-In. 

Logic’s Plug-In Side Chain menu - Audio 1 track selected
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This completes the configuration. You should now be able to access the “pre-configured” MIDI control 
assignments within POD Farm 2 Tone Presets, or utilize the POD Farm 2 MIDI Learn feature to “map” 
your controller to POD Farm 2 parameters (see “External MIDI Control with POD Farm 2 Plug-In” on 
page 3•7). On playback of your Logic project, your audio track output will be fed through the POD Farm 
2 Plug-In, and you can control the plug-in parameter(s) as desired. Note that you might also still hear 
the (dry) output of your audio track since it also remains fed to the master output. You can balance 
the audio and software instrument tracks’ outputs for the desired dry & POD Farm 2-processed mix, or 
simply set the audio track to “No Output” from its output menu.

Plug-In Parameter Automation in Logic

Logic offers robust features for “writing” and editing AU plug-in parameter automation, and POD 
Farm 2 and POD Farm Elements Plug-Ins all allow you to take full advantage of them! Please first refer 
to the information on configuring POD Farm 2 and Elements Plug-Ins for automation in “Parameter 
Automation with POD Farm 2 & Elements Plug-Ins” on page 3•10. To follow we have provided some 
specifics for accessing plug-in parameters for automation within Logic.

To display the parameter menu 
for the track’s automation lane, 
click on the parameter slot (after 
selecting “Track Automation” 
from the “View” menu).

Click on the twirl-down arrow 
to show an additional automa-
tion lanes, as needed. You can 
repeat the above steps to display 
as many POD Farm 2 parameters 
as you like (as well as Logic 
mix and global parameters, or 
parameters for any other inserted 
Plug-in).

Click on the inserted POD 
Farm 2 Plug-In to see the sub-
menu, where all the “Knob,” 
“Switch” and “Fixed” param-
eters are available. Select 
any parameter to display its 
envelope on the track.
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Manually Editing Logic Automation Envelopes

With your Plug-In parameter displayed in the automation lane, you can now manually click on the 
envelope line on the lane to add “node” points and adjust the parameter over time, as we’ve done here 
for POD Farm 2 Plug-In “Knob 1” and “Knob 2” parameters:

Automation lanes 
for POD Farm 2 
Plug-In Knob 1 and 
Knob 2 parameters

To allow the auto-
mation be utilized 
during playback, set 
the track’s automa-
tion mode to “Read”

“Node” points have been added manually to the envelope, 
allowing the parameter to be adjusted over time

Using the Logic Automation Write Modes

Automation can also be “written” by setting the audio track to one of the automation “write” modes, 
and then accessing the desired parameter’s control directly within the plug-in edit panel.

Note that to access POD Farm 2 Plug-In model parameters, you must first assign each desired parameter 
to one of the POD Farm 2 Automation Slots - please see page 3•12.

In the following example, we’ve inserted the Elements POD Farm Wahs Plug-In on our Logic Audio 
1 track, and selected the POD Farm Wahs - Pedal Position parameter to the Automation Slot. Then 
we’ve set the track’s automation mode to the “Touch” mode. With these settings made, once Logic 
playback is started, the Plug-Ins Wah Position knob can be manipulated during playback (either by 
using the mouse directly in the Wah panel, or via external MIDI control) and the Wah “performance” 
is captured by Logic via the Nodes added to the parameter envelope. 
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Automation lane for the Elements 
Wah - Position parameter

To write automation, set the 
track’s automation option to one 
of the “write” settings (Touch, 
Latch or Write)

“Node” points have been written automatically, in response to adjustments 
made with the Plug-In’s Wah Position knob during playback

For more info about parameter automation, please see your Logic documentation.
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Digidesign Pro Tools® LE 8 Setup 
Digidesign has designed Pro Tools® software so it can only be used with a Digidesign or M-Audio® 

audio interface. Therefore, you cannot use your Line 6 hardware as the primary audio interface for a 
Pro Tools system. But you can still utilize the RTAS® POD Farm™ 2 & POD Farm™ Elements Plug-
Ins in any Pro Tools setup! Additionally you can also connect the outputs of your Line 6 audio device 
to a Digidesign (or M-Audio) interface’s inputs to record your processed POD Farm™ 2 or POD® 
processed tones directly into Pro Tools. UX2, UX8, KB37, POD® X3 and POD®xt Pro even let you do 
this with a direct, digital connection.

For this document, we’ll be showing how to connect to the Digidesign Mbox® 2 unit with Pro Tools LE 
8. These steps are similar for connecting to the Digi 002® or other Digidesign and M-Audio hardware 
as well. There are two methods described here – Recording from a Line 6 USB device’s analog outputs 
or from its digital S/PDIF outputs.

Note: If you want to record a “dry”, unprocessed input signal into Pro Tools, and use POD Farm 2 & 
Elements Plug-Ins on the Pro Tools audio track, then you can simply plug your instrument or Mic directly 
into your Digidesign/M-Audio hardware and monitor your input signal through the Pro Tools software. 
More about using POD Farm 2 & Elements Plug-Ins later in this chapter.

Recording from Your Line 6 Hardware’s Analog Outputs 

In this setup example, we’ll show how to connect a Line 6 (POD Studio™ or TonePort™) UX2 to a 
Digidesign Mbox 2 unit, and then use POD Farm 2 in standalone operation to dial in Tones and choose 
what type of signal to feed into the Pro Tools audio track (Processed or Dry). This allows us to take 
advantage of the POD Farm 2 ToneDirect Monitoring™ feature for super low latency. These steps are 
much the same for any Line 6 POD Studio™, TonePort™ or GuitarPort™ device with an Mbox 2. 

If you are using a POD X3 or PODxt device it is not necessary to connect your POD to a computer via 
USB for this type of analog connection since Tones can be by called up & edited, and output levels 
configured completely on your POD device! (If you are to be using POD Farm 2 and/or POD Farm 
Elements Plug-Ins, you will need your Line 6 hardware connected to the USB port for the Plug-Ins to 
be authorized to run on the computer.)

Be sure to connect the USB cable from UX2 into your computer’s USB port, and then proceed with 
the following steps.

Connect the Analog Outputs* from your Line 6 hardware to the Digidesign Mbox 2:

Using two ¼” to ¼” shielded TS or 
TRS audio cables, plug each into the 
Analog Outs of your device

Connect a USB cable to your  
device & computer’s USB port



Digidesign Pro Tools LE 8 - Mac

5•38

*Note: If you are using a GuitarPort device, the Analog Outs are the RCA style jacks labelled “L” and 
“R”. If using a UX8, you should connect to the “Out 1” and “Out 2” jacks on the back.

Plug the other end of the left audio cable into the Mbox Input 1 input, and the right audio cable into 
the Mbox Source 2 input.

From your Line 6 device’s Left Analog Out 
(or “Out 1”), connect to the Mbox 2 Input 
1 - Line input

From your Line 6 device’s Right Analog 
Out (or “Out 2”), connect to the Mbox 2 
Input 2 - Line input

Connect a USB cable to your 
Mbox 2 & computer’s USB port

Use the Mbox 2 Mon Outputs to hear playback of all Pro Tools LE audio. The Line 6 Hardware output 
audio will be mixed with the Pro Tools LE audio as well. Therefore, if you are using headphones, you’ll 
want to plug them into the Mbox 2 headphone jack to hear everything:

From the Mbox Mon Out jacks, connect to the 
Left and Right inputs for your powered speakers 
or monitoring system

If you want to use headphones for 
monitoring, plug them in to the 
Mbox 2 Headphone Out

POD Farm 2 Standalone Operation

Launch POD Farm 2 in standalone operation, connect your guitar, Mic or other instrument to your 
Line 6 device, and then dial in the POD Farm 2 Tone you want recorded in Pro Tools. Note that since 
you’ll be recording the signal from the Analog Outputs of your Line 6 hardware, the Output knob on 
your POD Studio/TonePort/GuitarPort will affect the level fed into Pro Tools. Additionally, the  POD 
Farm 2 Mixer’s Tone A & B controls, as well as the Master Output knob will affect your output signal 
(the POD Farm 2 Mixer Record Send controls will not affect your signal in this scenario).
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Use the Master Output knob and the Mixer View Tone A & Tone B 
Mixer controls to adjust the signal fed to Pro Tools for recording

The POD Farm 2 Standalone Application Mixer View

Please also see the “Mixer View” on page 4•1 for details on specific controls.  

POD X3 & PODxt Devices

If you are using POD X3, you’ll want to check out the POD X3 Output screen options in your POD X3 
Pilot’s Handbook - In particular, the Reference: Configuration & Setup chapter covers the options 
for choosing your inputs (Mic, Line, Instrument, or multiple input sources) as well as things such as a 
“Tone Blend” versus a “Tone Pair” setting, panning tones and effects, etc. Basically, this is the point 
where you’ll want to have your instrument or mic plugged into POD X3 and have your Tone sounding 
the way you want it to be recorded from X3’s 1/4 inch Analog Outputs. You’ll also want to be sure the 
panning and levels of the tones and effects feeding to the POD X3 Left and Right analog outs are the 
way you want each to be recorded into your Pro Tools track(s).

If you are using PODxt, you’ll want to select the Studio Direct Mode within the PODxt Output Mode 
screen since you’ll be feeding the signal from your Analog Outputs into the Pro Tools hardware. See 
your PODxt Pilot’s Handbook  for information about these output settings.

Create a New Pro Tools LE Session

Once you have your Line 6 hardware and/or POD Farm 2 configured, then the next step is to launch 
Pro Tools LE and set up a Session for recording.

To start a new Session in Pro Tools LE, 
choose New Session from the File menu

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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You can choose to create a new session 
from a template, or a blank one

Choose the Sample Rate - 44.1 kHz is 
generally a good rate, unless you have 
specific needs for your project

Audio File Type - BWF (.WAV) is a 
good choice here since this file type is 
compatible with both Mac® and Win-
dows®

Bit Depth - 24 Bit is the higher fidelity 
choice here

Click OK when done, and then type 
in a name for the new Session when 
prompted

Create and Configure a New Audio Track

Next you’ll need to create at least one new audio track in the session to record into. You can, of course, 
also create more audio tracks if you want to import existing audio files into this session.

In the Track menu, select New

Choose how many
Tracks to create 

Choose Mono or Stereo* for 
your audio track format

Choose Audio Track for 
the Track type

Choose Samples 

...Then click Create 

*You’ll need to decide before creating each recording track here if you want to record the output from 
your Line 6 hardware as Mono or Stereo. Mono will, of course, only record one of your Line 6 device’s 
(Left or Right) outputs, and you’ll choose which once the track is created. If you have stereo effects 
active on your POD Farm 2 or POD tone, then you’ll probably want to choose Stereo to record both 
channels into a stereo track. 
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On the new audio track, click on the Input & Output 
Selectors and choose the Mbox Interface In 1-2 (Stereo) 
and Out 1-2 (Stereo) options, respectively

At the top left of the Edit Window, click the 
View selector and enable the I/O display for 
your tracks

Or, if you created a mono audio track, you’ll have the option for the track input to choose either In 1 
(Mono) to capture the LEFT signal, or In 2 (Mono) to capture the RIGHT signal

Click the audio track’s Record Enable 
button to arm the audio track for recording 

The track meters will now measure the 
Line 6 Device’s signal level 

Click the M button to mute 
the track while recording*

*Muting the track during recording disables the Pro Tools LE software monitoring feature, which 
allows your Line 6 hardware analog signal to be monitored with the lowest latency possible. Adjust 
the Mbox MIX knob to balance the Pro Tools session audio playback with the input audio (see your 
Mbox documentation for details). Once you are done recording, un-mute the track so you can hear 
playback.

Note to Digi 002 users: When using the Digi 002 hardware with Pro Tools LE, an additional Low Latency 
Monitoring option is available within Pro Tools LE Operations menu. You can alternatively keep your 
track un-muted and activate this option to hear your input monitoring signal when recording (see your Digi 
002/Pro Tools LE documentation for more on this feature).

Set your Recording Levels - As shown above, once your audio track is armed, you can use the track’s  
meters to gauge your recording levels. In addition to using your POD Farm 2 Mixer and Line 6 hardware 
controls, the Mbox unit includes level knobs for Inputs 1 & 2 to adjust the recording levels. The best 
practice is to set all of these controls to roughly half way to start, and then adjust each of them slightly 
to achieve the optimum level. You want to avoid setting any one control very high or very low to avoid 
excess noise or degrading the signal quality. 
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Be sure the input switches are set so that the green 
Mic light is illuminated for both Inputs 1 & 2 
(since we’re plugging into these Mic/Line inputs) 

Use the Input 1 & 2 knobs to adjust 
the recording levels

Keep both the Mono and 48V 
(phantom power) switches off 

Start Recording

Click the transport Record button to place Pro Tools LE into 
record mode, then press the Play button to start recording! 

Recording from Your Line 6 Hardware’s S/PDIF Outputs

POD Studio/TonePort UX2, UX8, POD X3 and PODxt Live units all include S/PDIF outputs, therefore 
you can optionally connect these outputs to your Digidesign hardware to record digitally into Pro Tools 
or Pro Tools LE! In this setup example, we’ll show how to connect a Line 6 UX2 to a Digidesign Mbox 
2 unit, and we’ll call out where different steps might be necessary for the other Line 6 devices. 

For more information regarding using your Line 6 device’s S/PDIF connections, please also see “S/PDIF 
Digital Output from Line 6 Hardware to an External Device” on page 2•33 . The Pilot’s Handbook that 
comes with POD X3 & PODxt devices includes more useful information as well. 
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Connect Your Hardware

Using a 75-Ohm, coaxial S/PDIF cable, plug 
one end into the S/PDIF Digital Out of 
your Line 6 device

Plug the other end of the S/PDIF 
cable into the Mbox S/PDIF In 

From the Mbox Mon Out jacks, connect 
to the Left and Right inputs for your 
powered speakers or monitoring system

If you want to use headphones for 
monitoring, plug them in to the 
Mbox 2 Headphone Out 

You will still use the Mbox Mon Out jacks (or Headphone Output) to hear playback of all Pro Tools LE 
audio. The Line 6 Hardware audio will be mixed with the Pro Tools LE audio if you use the Pro Tools 
software monitoring function. See the later section regarding monitoring for more on this.

UX2, UX8 & KB37 Configuration

When connecting two hardware devices digitally, it is necessary that both units are set to operate at 
the same sample rate. For POD Studio and TonePort devices, this is configured in the Line 6 Audio-
MIDI Devices application. Note that you will need to have your Line 6 device connected to your 
computer’s USB port, but you must not have the POD Farm 2 standalone application running - this 
is necessary to change sample rate settings. To get to this dialog, go to the Mac® System Preferences 
and launch the Line 6 Audio-MIDI Devices application - Go to the Driver tab:
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The Mac OS® X 10.4 & 10.5 Audio MIDI Setup utility:

Choose your Line 6 
Device

Then set the preferred  
sample rate for the 
Format. Mbox 2 
supports 44100 or 
48000 Hz - we’ll use 
44100 Hz for this 
example 

The Mac OS® X 10.6 Audio MIDI Setup utility:

Select your Line 6 
Device

Then set the preferred  
sample rate for the 
Format. Mbox 2 
supports 44100 or 
48000 Hz - we’ll use 
44100 Hz for this 
example 
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POD X3 S/PDIF Configuration

Connect the S/PDIF Out on the 
rear panel of your POD X3 device 
to the S/PDIF Input on the Mbox

POD X3 POD X3 Pro

POD X3 Live

The S/PDIF Out carries 24-bit digital versions of the Left & Right Outputs. Press the OUTPUTS 
button to access additional S/PDIF options:

For S/PDIF, you likely want 
the MATCH STUDIO/
DIRECT option* 

For the S/P SR options, set 
the sample rate to the same 
as your Pro Tools Session 

Use the S/PLVL if you need 
to slightly raise or lower 
the S/PDIF signal level for 
optimum recording levels

*This S/PDIF setting defines what type of audio carried by the S/PDIF Out. These options are:

•	 Match Studio/Direct – S/PDIF outputs the Tone and Pan settings as shown.

•	 Studio/Direct Tone 1 – S/PDIF outputs Tone 1 only, panned center.

•	 Studio/Direct Tone 2 – S/PDIF outputs Tone 2 only, panned center.

•	 Dry Inputs – S/PDIF Left outputs the unprocessed input(s) to Tone 1, and S/PDIF right outputs 
the unprocessed input(s) to Tone 2.
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PODxt Pro - Digital Output Configuration

Connect the S/PDIF Out on 
the rear panel of your device to 
the S/PDIF Input on the Mbox

Press the Tune/System button and turn the Select knob clockwise until the display reads, What are 
you connecting to?

Set the DIGOUT option to 
SPDIF

Set the DEST option to 
STUDIO DIRECT 

Press the I/O & Dig Select button once to access the Digital Out page:

For the FORMAT options, set 
the sample rate to the same as 
your Pro Tools Session, and 24 
BIT

Set the MODE to NORMAL 
for  your fully processed tone 
to be sent out the S/PDIF 
connection (or to DRYGTR for 
an unprocessed signal) 

Use the GAIN if you need 
to slightly raise or lower 
the S/PDIF signal level for 
optimum recording levels

Configure Mbox 2/Pro Tools LE for Digital Recording

Now, launch the Pro Tools LE application and set it up to receive the S/PDIF Digital Input as 
follows:

From the Pro Tools LE Setup menu, 
select Hardware
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Choose S/PDIF as the 
Clock Source so that 
the Mbox 2 follows the 
digital clock of your Line 6 
hardware

Click OK when done

You will now see the S/PDIF light solidly 
illuminated on the front of the Mbox 2, 
indicating it is in S/PDIF digital input mode

Note that when receiving S/PDIF input, the Input 1 & 2 level knobs on the front of the Mbox 2 do not 
adjust the incoming digital signal level. To adjust the recording level, use the POD Farm 2 software’s Tone 
volumes & output level controls, or your PODxt or POD X3 S/PDIF Gain controls.

Creating a New Pro Tools LE Session

Once you have your Line 6 hardware and POD Farm 2 standalone application configured (if using 
POD Studio 2/TonePort hardware), then the next step is to launch Pro Tools LE and set up a Session 
for recording.

To start a new Session in Pro Tools LE, 
choose New Session from the File menu
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You can choose to create a new session 
from a template, or a blank one

Choose the Sample Rate - 44.1 kHz is 
generally a good rate*

Audio File Type - BWF (.WAV) is a 
good choice here since this file type is 
compatible with both Mac® and Win-
dows®

Bit Depth - 24 Bit is the higher fidelity 
choice here

Click OK when done, and then type 
in a name for the new Session when 
prompted

*Note: If you prefer to use the 48 kHz Sample Rate, then you can choose it here in the Pro Tools dialog, 
but you will need to also go back to the Mac® Audio-MIDI Setup dialog (or to your POD X3 or PODxt       
S/PDIF settings) and set the sample rate value for your Line 6 hardware to match. 

Create and Configure a New Audio Track

Next you’ll need to create at least one new audio track in the session to record into. You can of course 
also create more audio tracks if you want to import existing audio files into this session.

In the Track menu, select New

Choose how many
Tracks to create 

Choose Mono or Stereo* for 
your audio track format

Choose Audio Track for 
the Track type

Choose Samples 

...Then click Create 

*You’ll need to decide before creating your recording track here if you want to record the output from 
your Line 6 hardware as Mono or Stereo. Mono, of course, only records from one of your Line 6 device’s 
(Left or Right) output channels, and you’ll choose which channel, once the track is created. If you 
have stereo effects active in POD Farm 2 or on your POD device, then you’ll probably want to choose 
Stereo to record both channels into a stereo track.
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On the new audio track, click on the Input Selector and 
choose the Mbox input source. Since we created a Stereo 
track here, we’ll select the S/PDIF In L-R (Stereo)

At the top left of the Edit Window, click the 
View selector and enable the I/O View

Or, if you create a mono audio track, you’ll 
have the option for the track input to choose 
either S/PDIF L (Mono) to capture the LEFT 
signal, or S/PDIF R (Mono) to capture the 
RIGHT signal

Click the Record Ready 
button to Arm the track for 
recording 

Once armed, the track’s meters will measure 
the Line 6 device’s S/PDIF signal level 

Keep the track’s Mute button set 
to un-muted to monitor your Line 
6 device’s incoming signal*

*When receiving a S/PDIF input, the Mbox 2 will only allow the signal to be monitored through the Pro 
Tools LE software. With the audio track armed and not muted, the track’s volume control will adjust 
the monitor signal coming from your Line 6 hardware, allowing you to balance your listening levels 
independently of your recording level. The Pro Tools LE software monitoring is also subject to latency, 
which is affected by your Pro Tools LE Hardware Buffer settings (see your Mbox documentation for more 
information regarding latency and monitoring).

Note to Digi 002 users: When using the Digi 002 hardware with Pro Tools LE, an additional Low 
Latency Monitoring option is available in the Pro Tools LE Operations menu. It is best to activate this 
option to hear your input monitoring signal with the lowest latency when recording (see your Digi 
002/Pro Tools LE documentation for more about this feature).

Adjusting the Pro Tools LE Hardware Buffers

Go to the Pro Tools LE Setup menu 
and choose Playback Engine 
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The lower the H/W Buffer Size value that is selected, the lower the 
latency. However, lower values can also result in less stability for session 
playback and recording. 256 Samples is a good starting value to try

TIP: Alternative Mbox monitoring option… If monitoring your Line 6 hardware recording signal through 
the Pro Tools LE software results in excessive latency, you can alternatively connect your device’s Analog 
Outs to an external Mixing Console and manually mix the device signal with the output of your Mbox. This 
allows you to hear the Line 6 device signal with no added latency from Pro Tools LE. In this configuration, 
you should Mute your Pro Tools LE track while recording, to silence its software monitoring signal.

Start Recording…

Click the transport Record button to place Pro Tools LE into 
record mode, then press the Play button to start recording! 

Using the RTAS® POD Farm 2 Plug-Ins in Digidesign Pro Tools® LE

The POD Farm 2 & POD Farm Elements Plug-Ins support the Digidesign Real Time Audio Suite 
(RTAS) Plug-In format for Pro Tools and Pro Tools LE software. Once you have the POD Farm 2 
license activated for your Line 6 hardware or iLok, you are ready to jump right into a whole new level 
of Tone possibilities right within your Pro Tools session! To follow we’ve provided an overview for how 
to insert, configure and automate parameters using POD Farm 2 Plug-In in Pro Tools LE 8. There are, 
of course, some differences for using RTAS Plug-Ins on different Pro Tools software versions, so you 
should also consult your Digidesign documentation for more details.

Inserting the Plug-In

The most common way to apply an RTAS effect Plug-In within Pro Tools LE is to add it as an insert on 
the audio track. You can access the insert slots either directly on an audio track’s channel strip in the 
Mix window, or at the left of the track in the Edit window (you may need to enable the “Inserts A-E” 
module to be visible from the Track View Menu). 
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Mix window Insert slot Edit window Insert slot

When you click on a track’s Insert Selector, you’ll find POD Farm 2 Plug-In selectable within the Other 
sub-menu. You will find the individual POD Farm Elements Plug-Ins within the other categorized 
effects sub-menus (e.g. -  the “POD Farm Dynamics” Elements Plug-In is found in the “Dynamics” 
submenu). Note that the Plug-In options will be different if your track is a stereo or mono track.

On a stereo track, you’ll have 
the option for the POD Farm 2 
(stereo) Plug-In  

On a mono track, you’ll have two options: 

If your track’s output is set to a mono 
Interface or Bus, then it is best to choose 
POD Farm 2 (mono) to retain a mono 
channel output signal

If your track’s output is set to a stereo 
Interface or Bus, then it is best to choose 
POD Farm 2 (mono/stereo) to feed to the 
stereo output 

To remove the inserted Plug-In, simply click on the Insert Selector where the Plug-In is loaded and 
choose No Insert from the menu. 

 
TIP: You might want SAVE your Tone settings within POD Farm 2 Plug-In as a Tone Preset before you 
remove it so you can recall the same settings again any time you load the Plug-In again!  
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You can load as many instances of the POD Farm 2 & Elements Plug-Ins as you like in your session. 
Note that the number of Plug-In instances you insert in your session, will determine how much of your 
computer’s resources are utilized (RTAS Plug-Ins are powered by your computer’s CPU). Remember, 
you are not limited to just using the Line 6 Plug-Ins for guitar. Try using some of the Amps, Preamps 
or individual Effects models on any instrument or vocal track - there are no rules here! When you save 
your Pro Tools session, the loaded POD Farm 2 & Elements Plug-In instances, as well as all Plug-In 
settings, are all saved as part of the session.

Configuring POD Farm 2 Plug-In 

Once loaded as an Insert, the POD Farm 2 Plug-In Graphical User Interface (GUI) is automatically 
launched. Here you can choose from any of your  saved POD Farm 2 Tone presets, or tweak the 
individual Amp, Cab, Mic and Effects settings as desired - please see the Plug-In chapter in the POD 
Farm Basic User Guide for details on all the POD Farm 2 GUI controls. 

You’ll see that the Plug-In GUI is contained within an RTAS Plug-In window, and at the top are some 
Pro Tools LE specific controls. These are the same controls for all RTAS Plug-Ins (including the POD 
Farm Elements Plug-Ins) and allow you to switch to other tracks, save session-related presets, and 
more. Please check your Pro Tools LE documentation for more on these controls. 

Use the Bypass button to 
bypass the entire Plug-In

Master Input Knob & Meter - 
Set the Plug-In Input level here

Master Output Knob & Meter - 
Set the Plug-In Output level here
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For POD Farm 2 Plug-In, you can additionally use the Tone A & Tone B controls within the POD 
Farm 2  Mixer View. It is important to watch your levels in and out of the Plug-In. If the audio recorded 
in the audio track is already rather high, then adding some POD Farm 2 Amp and Effects models 
(especially distortion and compressor effects) can raise the gain further, resulting in clipping. Use 
the Amp & Effects’ volume and gain controls moderately, and then use the Master Input and Output 
knobs and Mixer controls in POD Farm 2 Plug-In to keep the levels consistent. (See the POD Farm 
2 Basic User Guide for more on the Mixer View controls and optimizing POD Farm 2 Plug-In input 
levels.)

Monitoring with POD Farm 2 Plug-In

As described in the preceding Pro Tools LE recording setup sections, there are some specifics to 
configuring your audio track and Mbox 2 (or other Digidesign hardware) to monitor your input signal 
while recording. If you do not own one of the Line 6 USB audio devices, and running POD Farm 2 
off of an iLok, you’ll want to use the Pro tools Software monitoring feature. If using POD Farm 2 in 
standalone operation with a Line 6 USB device, or if using a POD device to hear your monitor signal, 
then you’ll want to use only the external monitoring setup.

Pro Tools LE Software Monitoring

One practice is to plug your instrument or mic directly into your Mbox 2 and record its unprocessed 
signal into the audio track so that you can use a Plug-In on the track to then non-destructively add 
amp, cab and effects to it. For this setup you’ll need to load POD Farm 2 and/or Elements Plug-In on 
the audio track Insert, then arm the track and keep it un-muted so that you can adjust the Mbox 2 Mix 
knob to hear your input signal running through the audio track. 

You can use any POD Farm 2 or Elements Plug-In settings you like since it is “non-destructively” 
effecting the track monitoring and playback. This allows you to hear your input signal with your Plug-
In processing applied, while the raw, unprocessed input signal gets recorded. 

The drawback with this setup is that it takes a fraction of a second for the input signal to pass through 
the Pro Tools software, through any insert Plug-Ins and then back out your speakers or headphones. 
This amount of delay is referred to as “latency” and what you hear all the computer recording geeks 
rant about on all the computer audio forums. You can minimize the latency by lowering your Pro Tools 
audio engine buffer size (see “Adjusting the Pro Tools LE Hardware Buffers” on page 5•49), but note that 
the lower the buffer setting, the more CPU demands are placed on your computer. 

Using Line 6 Hardware for Monitoring Externally

If you own a Line 6 USB audio device, another option is to use an external hardware mixing console 
as follows to allow you to split the input of your instrument or Mic into two signals. Then plug one of 
these inputs into your Line 6 device, and the other input into your Digidesign interface:

•	 Plug your Instrument or Mic into a channel on your mixing console.

•	 From this mixer channel, route the signal out two of the mixer’s Sends so that you can then plug 
one into the Mic/Instrument input of your Line 6 hardware, and the other into the Mic/Line In 
of your Mbox 2 or other Digidesign hardware. 

•	 Connect the Analog Outs from your Line 6 hardware back into another channel of the mixing 
console and route the channel to your monitor system. This channel will monitor only the 
output of your Line 6 device. 

•	 Connect the Mon Outs from your Mbox 2 into its own stereo channel on the mixing console 
and route the channel to your monitor system. This channel will monitor the playback of your 
Pro Tools session.  
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•	 Launch the POD Farm 2 standalone application and dial in whatever tone you want for your 
monitoring signal, which you’ll be able to hear with nearly zero latency. (Or, if you are using a 
PODxt or POD X3, dial up your preferred Tone on it.)

•	 Configure your audio track in Pro Tools to record from the Digidesign hardware’s Mic/Line Input 
you are connected to and Arm the track for recording. You should keep the track Muted while 
recording since you do not want to hear the unprocessed signal coming into the track. 

•	 Once you are done recording, you can then un-mute the Pro Tools track and load POD Farm 2 
Plug-In as an insert on the track.  It is now up to you to either call up the same settings you used 
in the POD Farm 2 standalone application (or PODxt/POD X3) to monitor with, or tweak the 
Plug-In to achieve any tone you want for the track.  

Using POD Farm 2 & Elements Plug-Ins with Aux Sends

Another method to using your Line 6 Plug-Ins in Pro Tools LE is to add one instance of a Plug-In as an 
Insert on a Pro Tools Aux track, and then route a Send from multiple audio tracks to feed into the Aux 
track, so that  all the tracks can be processed with the same, single Plug-In. This can be very useful if 
you want to do something like use the same Analog Delay effect on several different tracks - it is a very 
inefficient use of CPU power to load several separate instances of POD Farm 2 or Elements Plug-Ins as 
inserts on multiple audio tracks. The better practice is to load one Plug-In instance on an Aux track, 
and then route a Send. This can all be accomplished in the Pro Tools LE Mix window, as shown here:

In this example, both Audio 
Track 1 and 2 each have a Send 
established, with the output 
set to Bus 7-8. This allows the 
playback signal of the tracks 
to be “tapped” and routed to a 
common destination track. 

Note that the Track Output is 
still set to the Mbox 2 Interface 
Out 1-2. 

The track slider still controls 
the playback level of the (non-
effected) Audio track that is 
routed to the main output. 

POD Farm 2 Plug-In is added as 
an Insert only on this stereo Aux 1 
track.

The Input for this Aux 1 track is 
set to Bus 7-8, therefore, the Send 
signals coming from Audio Tracks 1 
and 2 are fed into this Aux 1 track, 
and both effected by POD Farm 2 
Plug-In. 

Use the Aux 1 track’s volume slider 
to blend the POD Farm 2-effected 
signal with the (non-effected) Audio 
Track 1 and 2 signals at the main 
Mbox Out 1-2.



Digidesign Pro Tools LE 8 - Mac

5•55

The Pro Tools LE Mix window - Two Audio Tracks routed to a Send, returning into Aux 1 

Click on the Send 
assignment to launch 
the Send Controls 

The Pan and Level 
knobs allow you to 
independently control 
the Audio Track 1 pan 
position and volume  that 
are fed out to Bus 7-8 
(and thus, through POD 
Farm 2 Plug-In that is 
inserted on Aux 1) 

The Send Controls for Send A routed from Audio Track 1

It is also possible to add your POD Farm 2 or Elements Plug-Ins as Insert effects on a Master track in 
your session, which can then effect all the audio tracks in the session! Pro Tools LE offers quite a few 
more signal routing options that allow you to get very creative with the mix of your session - please 
check your Digidesign documentation for details. 

External MIDI Control of POD Farm 2 Plug-In in Pro Tools

Pro Tools software offers the ability to access the knobs, sliders & switches of any inserted RTAS Plug-
In remotely, via a hardware MIDI controller device, provided the RTAS Plug-In supports this ability. 
And POD Farm 2 Plug-In does indeed support MIDI Control to allow you to take full advantage of 
these MIDI  features! It is recommended that you first get familiar with the POD Farm 2 MIDI Control 
features and configuration covered in the POD Farm 2 Basic User Guide, as well as the MIDI Control 
items covered in the Plug-In chapter on page 3•7.

As described in the Plug-In chapter, Pro Tools, like most DAWs, requires that you configure a MIDI 
track to route your MIDI controller device’s MIDI commands into the inserted POD Farm 2 Plug-In. 
The first step is to make sure your MIDI controller device is connected to your computer and accessible 
within Pro Tools. For example, our USB-connected Line 6 FBV Shortboard MkII is automatically 
detected by Pro Tools LE, and appears as an available MIDI device within a Pro Tools MIDI track’s 
Input menu. If you do not see your MIDI controller device available within your Pro Tools application,  
please see your Digidesign documentation for help on detecting MIDI hardware.
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To route MIDI to an instance of the POD Farm 2 Plug-in, insert POD Farm 2 Plug-In on one of your 
audio track’s effects Inserts. For our example, we’ve inserted the Plug-In on the Audio 1 track. 

POD Farm 2 Plug-In loaded as an 
Insert on the Audio 1 track

Next, create a new MIDI track in your project. The MIDI track’s Input & Output settings need to be 
configured so that the track receives MIDI communication from your external MIDI controller device, 
and feeds the MIDI to the specific POD Farm 2 Plug-In inserted on the Audio  track.

Click the MIDI track’s Input selector - choose Predefined and then the Port from your external 
MIDI controller device. We’re using a Line 6 FBV Shortboard Mk II Controller, so we’ll receive 
its MIDI from its Port 1, and choose “all channels” to receive from all 16 MIDI channels on this 
port.

Click the MIDI track’s Output selector and choose the 
POD Farm 2 Plug-In. You can choose to send the MIDI 
output on any of the offered channels. This feeds your 
MIDI controller’s commands into POD Farm 2 Plug-In, al-
lowing you to remotely control parameters in the Plug-In!

Pro Tools MIDI track options - routing MIDI to an inserted Plug-In

This completes the configuration. You should now be able to access the “pre-configured” MIDI control 
assignments within POD Farm 2 Tone Presets, or utilize the POD Farm 2 MIDI Learn feature to “map” 
your controller to POD Farm 2 parameters (see “External MIDI Control with POD Farm 2 Plug-In” on 
page 3•7). Please see your Digidesign documentation for more about its MIDI control features.

Plug-In Parameter Automation in Pro Tools LE

Pro Tools applications offer robust features for “writing” and editing RTAS Plug-In parameter 
automation, and POD Farm 2 and POD Farm Elements Plug-Ins all allow you to take full advantage of 
these Pro Tools features! Please first refer to the information on configuring POD Farm 2 and Elements 
Plug-Ins for automation in “Parameter Automation with POD Farm 2 & Elements Plug-Ins” on page 3•10. 

Parameter automation can be done in Pro Tools by manually shaping an envelope across the track, or 
in real-time by recording parameter moves. Here is an example on how to configure a Pro Tools LE 
track to automate the POD Farm 2 Analog Delay’s Mix parameter so that the amount of delay changes 
over time on the track.
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Start by adding a stereo Audio track to your session and insert or record a stereo audio file. For this 
example, we’ll automate the POD Farm 2 Delay - Mix parameter, so we’ll first assign the Delay - Mix 
parameter to the POD Farm 2 “Knob 1” Automation Slot.* 

*To access POD Farm 2 Plug-In model parameters, you must first assign the desired parameter to one of 
the POD Farm 2 “Knob” or “Switch” Automation Slots - please see page 3•12.

With POD Farm 2 Plug-In loaded as an Insert on the Audio track, launch the Plug-In window and 
click on the top Auto button to launch the Plug-In Automation dialog. 

Select the desired Plug-In Parameters in the left pane and click 
the Add>> button to allow them to be automated on your trackClick the Auto button

In the Pro Tools LE Plug-In Automation window, you’ll see all the automatable POD Farm 2 parameters 
listed in the left pane (the assignable 1 - 16 “Knob” & 1 - 16 “Switch” Automation Slots, plus “fixed”  
parameters - scroll down the list to see them all). For this example, we’ll select Knob 1 (to which our 
Delay-Mix parameter is assigned) and click the Add >> button and then click OK to enable this 
parameter for automation on the Audio track. You can add as many parameters as you like for the track 
and automate any of them, but for this example we’ll keep it simple. 
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Once the parameter is added, configure the Audio track to display this “Knob 1” envelope in an 
Automation Lane.

Click on the arrow button to 
display the track’s Automation 
Lanes

Click the Lane View Selector 
and choose POD Farm 2 Plug-
In - Knob 1

With your Plug-In parameter displayed in the Automation Lane, you can now manually click on the 
envelope line on the lane to add “node” points and adjust the parameter over time, as we’ve done here:

“Node” points have been added manually to the envelope, 
allowing the parameter to be adjusted over time

To allow the automation be utilized during playback, set 
the track’s automation mode to “Read”

TIP: You can also use the Pro Tools Pencil tool to draw to draw in multiple-node “curves” for your 
automation envelope - see your Pro Tools documentation.

Now just play your session and you’ll hear the assigned POD Farm 2 Delay - Mix parameter respond to 
the envelope changes. If you view the POD Farm 2 Plug-In window, with the Delay effect’s Edit Panel 
in view, you’ll also see the Delay Mix knob move automatically during playback. You can use the above 
steps with any of the POD Farm Elements Plug-Ins to automate their parameters as well!

Using the Pro Tools Automation Write Modes

Automation can also be “written” by setting the Pro Tools track to one of the automation “write” 
modes, and then accessing the desired parameter’s control directly within the plug-in edit panel. 

Note that to access POD Farm 2 Plug-In model parameters, you must first assign each desired parameter 
to one of the POD Farm 2 “Knob” or “Switch” Automation Slots - please see page 3•12.



Digidesign Pro Tools LE 8 - Mac

5•59

In the following example, we’ve assigned the POD Farm 2 Plug-In, Wah - Pedal Position parameter 
to the “Knob 1” Automation Slot. Then we’ve set the Pro Tools Audio track’s automation mode to 
“Touch”. With these settings made, once Pro Tools playback is started, the POD Farm 2 Plug-In Wah 
Pedal Position knob can be manipulated during playback (either by using the mouse directly in the 
Plug-In - Wah panel, or via external MIDI control) and the Wah “performance” is captured by Pro 
Tools via the Nodes added to the Knob 1 envelope. 

To write automation, set the track’s 
automation option to one of the “write” 
settings (Touch, Latch or Write). 

Adjust the Plug-In’s Wah Position knob 
during playback

“Node” points have been written automatically, in response to adjustments 
made with the plug-in’s Wah Position knob during playback

Set the track’s Automation Mode to read if you are done writing automation on the track. Now when 
you rewind and play the track back, you’ll see the POD Farm 2 Wah knob move automatically in 
response to the automation, and you’ll hear your Wah pedal performance! You can, of course, manually 
click and drag the individual envelope node points to further fine-tune things if you like.

You can also use the above steps to write and edit parameter automation for any of the POD Farm 
Elements Plug-Ins.  For more info about parameter automation, please see your Pro Tools documentation.
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MOTU Digital Performer® 6 Setup
For this chapter, we’ll show how to configure Mark of the Unicorn Digital Performer® 6 to work 
with Line 6 POD Studio™, TonePort™, GuitarPort™, POD X3 or PODxt as the USB audio device, 
as well as optionally using POD Farm™ 2 Plug-In and/or POD Farm™ 2 in standalone operation on 
your Mac® computer. The steps are very similar for the setup of other recent Digital Performer versions 
as well.

Choose Your Line 6 Gear Configuration

Before you record your first track in any DAW software, you have a few options to consider  with your 
Line 6 hardware & POD Farm 2 gear. You should decide if you want to record a “dry” signal into the 
audio track, such as if you want to utilize POD Farm 2 Plug-In to “non-destructively” apply your POD 
Farm 2 Tone onto the recorded track. Or, if you prefer to record a “processed” signal, where the POD 
Farm 2 Amp/Preamp and Effects are already applied and recorded permanently on the track. We’ll 
cover the steps to record either of these ways, but first it is helpful to understand the options with your 
particular Line 6 gear.

POD Studio, TonePort, GuitarPort devices 

•	 Using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into your 
device and launch POD Farm 2 in standalone operation. Use the Mixer View - Record Send 
Source options to choose the type of signal fed to your Record Sends. Also see “POD Farm™ 2 
Standalone Operation” on page 4•1 for more about the Mixer View. 

•	 Tone A, Tone B or Tone A+B - Feeds the same fully processed signal from the respective 
Tone path(s) that you hear out to the Record Send.

•	 Tone A (semi) - This option is available only when a single Tone A exists in POD Farm 2.  
It feeds only the signal processed with the Amp group of models (Amp/Cab/Mic/Preamp 
models) plus any effects inserted to the left of the Amp group within Tone A. Note that 
you’ll still hear the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ 
Monitoring output. (Useful, for example, if you want to hear a delay or reverb effect inserted 
after the Amp group, but do not want that delay effect recorded!)

•	 Dry Input - Feeds a completely unprocessed signal to the Record Send, even though you can 
listen to the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ Monitoring 
output. (This is a great option if you want to insert POD Farm 2 or Elements Plug-Ins on the 
recorded audio track in the DAW later!)

•	 Without using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into 
your device and configure the Line 6 Audio-MIDI Settings  dialog to feed your “dry” input 
source to your device’s Record Sends. See “Mac® Driver Settings” on page 2•1 for more about this. 
Note that when using this option, you won’t have the benefit of POD Farm 2 ToneDirect™ 
Monitoring when not running POD Farm 2 in Standalone mode, so you’ll need to enable your 
DAW software’s monitoring feature on the audio track (more on this in the next section).

POD X3 devices - Plug a Mic or Instrument into your POD X3 and configure the options within 
X3’s onboard Outputs - Studio/Direct Mix settings screen to determine what type of signal is fed 
to the X3’s Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your POD X3 Pilot’s Handbook for 
details on X3’s Output screen options. 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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PODxt devices - Plug a Mic or Instrument directly into your PODxt device and configure the 
options within the Line 6 Audio-MIDI Settings dialog for the type of signal (Processed or Dry) that 
is fed to the Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your PODxt Pilot’s Handbook for 
details about output options.

Monitoring through the DAW software - If you are using POD Studio/TonePort/GuitarPort hardware 
and not running POD Farm 2 in standalone operation, then you’ll need to use the DAW software’s own 
monitoring feature to hear your input signal routed through the DAW software’s audio track, as called 
out in the following steps. This also means you’ll hear the input signal effected with any Plug-Ins, such 
as if you have POD Farm 2 Plug-In inserted on the same audio track. You may need to set your DAW 
software’s buffer size fairly low to minimize the “latency” (the time between when you pluck a note 
on your guitar to the time you actually hear it after feeding through your DAW software and out your 
speakers). We’ll cover all these steps here.

Configuring Digital Performer to Use the Line 6 Core Audio Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps.

Launch Digital Performer and click on the Setup menu.

First, go to the Digital Performer Setup > 
Audio System menu and select MOTU 
Audio System so that it is active

Next, choose Configure Audio System > Configure Hardware Driver from the Setup menu to set 
the application to use your Line 6 USB audio device.

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Select Core Audio as your driver type

Choose your Line 6 hardware first as your 
Core Audio device, and then as your Master 
Device

Choose 44100 as the Sample Rate - 
alternatively 48000, 88200 or 96000 can also 
be used if your project requires it 

A Buffer Size of 256 and Multiplier of 1 are 
good settings to start with

Set Work Priority to High for snappy 
performance

Click OK to exit

Configure an Audio Track for Recording 

Now that your Line 6 hardware is set up, you are ready to start working in a DP Project!  Create a New 
DP Project (or open an existing one) and create a new audio track to record into. 

Project Sample Format

Before recording, it is a good idea to check your project’s Sample Rate and Sample Format (also known 
as the “Bit Depth”). DP offers easy access to this at the right of the “Control Panel” transport bar. Your 
Sample Rate is likely the same as the (default) Sample Rate you set in the previous step within the 
Hardware Driver dialog. For the Sample Format, it is recommended to choose either 24 or 32 bit for 
the highest audio recording quality. Line 6 audio devices will record at 24 bit for either of these DP 
settings.

The Project Sample Format settings

Add an Audio Track

You can choose to add either a Mono or Stereo audio track to your current Project. This track type also 
determines which Line 6 device’s Record Sends become available to choose from as the track’s input 
(Mono or Stereo). 
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Selecting Track Input and Output Devices

Once your Audio Track is created, you can select your track Input and Output device for Recording 
and Playback specifically for this track. (Note that the following screenshots show DP’s “Sequence” 
view layout - this makes it easy to see your track settings at the left of the work area.) We’ve created a 
Stereo audio track in our example here. 

When you first set up your Project with your audio hardware, you need to select one or more New 
Stereo Bundles (or Mono Bundles if your track is Mono) to make them available as selectable track 
inputs. To do this, open the Track Menu for your audio track and select Input > New Stereo Bundle. 
You will see a list of all available items that can be assigned. Your Line 6 stereo inputs should appear at 
the top of this list, as shown here for a UX2:

Click the Track Menu button 
for your audio track Line 6 device stereo input options

Select each Line 6 hardware input that you’ll potentially want to record from for your Project to create 
each as a “Stereo Bundle” input. Once you do, you’ll then see them as selectable in the track Input 
menu and you can choose the one you want here for all future audio tracks. 

New Stereo Bundles created now appear 
here in the Input menu. We’ve selected 
the UX2 Record Send 1-2 1-2 as this 
stereo audio track’s input
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About Input Options for Your Device

In the Input > New Mono/Stereo Bundle menus for audio tracks in DP, you will see slightly different 
options depending on your specific Line 6 device.

POD Studio & TonePort GX, D.I. UX1, UX2 and KB37: You’ll see the following:

•	 The Stereo “Record Send 1-2 1-2” and “Record Send 3-4 3-4” options receive input from the Line 
6 device’s respective Record Sends 1-2 and 3-4, and record a stereo file (See above screenshots.) 

•	 The individual “Record Send 1-2 1” thru “Record Send 3-4 4”  options receive input from the 
Line 6 device’s respective Record Sends 1 thru 4, and record a mono file.

 Note that if you have POD Farm 2 running in standalone operation, the type of signal fed into Record 
Sends 1-2 and 3-4 is determined by the Source options you select in the POD Farm 2 “Mixer View”. 

TonePort UX8: You’ll see the following:

•	 The Stereo “Send 1-2 1-2” thru “Send 7-8 7-8” options receive input from TonePort UX8’s 
respective Record Send 1-2 thru 7-8, and record a stereo file. 

•	 The Stereo “Send 9-10” and “Send 11-12 11-12” options receive input from the POD Farm 2 
Record Sends 9-10 and 11-12 (if you have POD Farm 2 running in standalone operation) and 
record a stereo file.

•	 The individual Mono “Send 1-2 1” thru “Send 7-8 8” options receive input from the respective 
TonePort UX8 Record Sends 1 thru 8, and record a mono file.

•	 The individual Mono “Send 9-10 9” thru “Send 11-12 12” options receive input from the POD 
Farm 2 Record Sends 9 thru 12 (if you have POD Farm 2 running in standalone operation), and 
record a mono file.

 

* Note that the type of signal fed into Record Sends 9-10 and 11-12 is determined by the Source options 
you select in the POD Farm 2 “Mixer View”. UX8’s driver also offers multiple Inputs and Sends with 
many flexible options for routing and monitoring. Please see “Line 6 Audio-MIDI Settings - Inputs & 
Recording Tab (UX8 Only)” on page 2•7. 



MOTU Digital Performer 6 - Mac

5•65

POD X3 devices: You’ll see the following:

•	 The Stereo “Send 1-2 1-2” thru “Send 7-8 7-8” options receive input from the respective POD 
X3 Record Sends 1-2 thru 7-8, and record a stereo file.

•	 The individual “Send 1-2 1” thru “Send 7-8 8” options will receive input from the respective 
POD X3 Record Sends 1 thru 8, and record a mono file.

POD X3 offers onboard options for the type of signal that is fed to Record Sends 1-2 within its onboard 
Output screen options, while Record Sends 3-8 all carry Dry input signals. For more info about POD X3 
Sends, please see page 2•5 and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see the following:

•	 The Stereo “Main In 1-2” receive input from the respective PODxt Record Send 1-2 and record 
a stereo file. 

•	 The individual “Main In 1” and “Main In 2” options receive input from the respective PODxt 
Record Send 1 and 2, and records a mono file.

PODxt offers options for the type of signal fed to the Record Sends within the Line 6 Audio-MIDI Settings 
dialog. For more info about the PODxt Sends, please see page 2•6 and your PODxt Pilot’s Handbook.

Select a Track Output

Choosing a track output is much the same process as described above for the track input - you may 
need to first create the New Stereo/Mono Bundle for each Output you’ll want to be available for your 
audio tracks. For all Line 6 devices, this will be the “Main Out 1-2” . UX8 offers multiple Output 
options and can additionally be configured for different monitoring or even multi-channel Surround 
operation - please see your TonePort UX8 Pilot’s Handbook for more about these advanced features. 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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For our example, we’ll choose the Main Out 1-2 for our UX2 as the track Output for our stereo audio 
track:

Audio track output set to the UX2’s 
Main Out 1-2

Set Input Monitoring Options

As mentioned in the previous Choose your Line 6 Gear Configuration section, you’ll want to keep 
the DP audio track’s Input Monitoring feature “off” if you are utilizing POD Farm 2 in standalone 
operation, or if using POD X3 or PODxt for their Monitoring capabilities. 

Input Monitoring On/Off button

If you are using POD Studio/TonePort/GuitarPort and not running POD Farm 2 in standalone operation, 
then you’ll want to turn the Input Monitoring feature “on” for the audio track to hear your input signal 
through the DP software. You’ll likely also want to insert POD Farm 2 and/or POD Farm Elements 
Plug-Ins on this audio track now and dial in some Amp & Effects models to hear them applied to your 
input signal while recording. See DP’s documentation for more about its Input Monitor options.

Arm Your Track & Set Your Levels

Note that the track meters measure the input level  
once the track is armed

Press the Arm button to enable your 
track for recording audio

Set Your Recording Levels

Be sure to set your record levels before you start recording. The signal coming into the audio track, and 
how you adjust its level, depends upon the configuration of Line 6 gear you’ve selected, as covered at 
the start of this chapter. 

•	 If you are using POD Studio/TonePort/GuitarPort hardware and not running POD Farm 2 in 
standalone operation, then you’ll need to use your guitar’s volume knob, the hardware’s Mic 
Gain knob, or the volume on the external device plugged into any Line In.

•	 If you are using POD X3/PODxt hardware, adjust your levels using the onboard Output controls 
for what is routed to the Record Send you’ve selected for the audio track’s inputs.
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•	 If you are using POD Farm 2 in standalone operation, use the POD Farm 2 Mixer View. Note 
that here you can choose the type of signal fed to either Record Send and adjust the levels 
independently of the signal you hear coming from the ToneDirect™ Monitoring signal!

Adjust the Record 
Send Levels

Choose the type of “Source” signal 
that is fed to each Send*

If the Record Send output 
is still very low, activate the 
+18 boost 

POD Farm 2 standalone Mixer - Record Send controls

*Note that you’ll have different options for POD Farm 2 Record Send Sources depending on if you 
currently have a Single or Dual Tone running. Please see the “Mixer View” on page 4•1.

Start Recording!

Once your record level is set, just click on the Digital 
Performer transport Record button and start riffing!
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Using POD Farm 2 & POD Farm Elements Plug-Ins

Digital Performer supports the AU Plug-In format, and if you installed the POD Farm 2 & Elements 
AU format Plug-Ins during your POD Farm 2 installation, they should automatically appear in your 
audio tracks’ Insert menus. To insert a Line 6 Plug-In on your audio track, switch to DP’s “Mixer” view 
layout and, click on one of the Insert slots and choose the desired Plug-In from the list of effects. 

Note that if your audio track is Stereo, you’ll see a “Stereo” versions of the POD Farm 2 & Elements 
Plug-Ins. 

Choose the Mixing Board tab

Click one of the Insert selectors for your audio 
track and select POD Farm 2 or an Elements 
Plug-In from the list of effects.

In this example, we’re inserting the POD Farm 
2 Plug-In on a stereo audio track, therefore, 
the Plug-In option are all “Stereo”.

If your track is Mono, you’ll have the option of choosing either “Mono” or “Mono-Stereo” for the Plug-
In. You’ll want to choose the option that best matches your audio track’s signal routing in DP. Also 
note that when using any stereo effects within your POD Farm 2/Elements  Plug-In, if you choose the 
“Mono” option then the stereo output of these effect models will be “folded down” to mono.
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When clicking on the Insert selector 
for a mono audio track, you’ll see that 
all the Plug-In options are “Mono” or 
“Mono > Stereo”.

External MIDI Control of POD Farm 2 Plug-In in Digital Performer

Digital Performer offers the ability to access the knobs, sliders & switches of any inserted AU Plug-In 
remotely, via a hardware MIDI controller device, provided the AU Plug-In supports this ability. And 
POD Farm 2 Plug-In does indeed support MIDI Control to allow you to take full advantage of these 
DP features! It is recommended that you first get familiar with the POD Farm 2 MIDI Control features 
and configuration covered in the POD Farm 2 Basic User Guide, as well as the MIDI Control items 
covered in the Plug-In chapter on page 3•7.

As described in the Plug-In chapter, DP, like most DAWs, requires that you configure a MIDI track to 
route your MIDI controller device’s MIDI commands into the POD Farm 2 Plug-In. The first step is to 
make sure your MIDI controller device is connected to your computer, and accessible within DP. For 
example, our USB-connected Line 6 FBV Shortboard MkII is automatically detected by DP, and when 
we access one of its controls, the MIDI Monitor displays an indicator lighting up in response. You can 
launch the DP MIDI Monitor window from the DP - Setup menu.

The DP MIDI Monitor dialog - receiving MIDI from our FBV device’s Port 1, Channel 1
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If you do not see your MIDI device listed in the DP MIDI Monitor,  please see your DP documentation 
for help on detecting MIDI hardware.

To route MIDI to an instance of POD Farm 2 Plug-in, first insert POD Farm 2 Plug-In on one of your 
audio track’s effects Inserts, and make note of which Track and Insert slot you’ve loaded it into. For 
our example, we’ve inserted the Plug-In on the Audio-1 track, in Insert “A” (the top insert slot in the 
Audio-1 track strip within the DP Mixing Board screen).  

POD Farm 2 Plug-In loaded into  
“Insert A” of the Audio-1 track

Next, create a new MIDI track in your project. It should automatically receive MIDI data from your 
connected MIDI controller device. In the MIDI track’s Output selector, you’ll be able to select “POD 
Farm 2 Plug-In” for the audio track you have it inserted on, and choose the specific Insert slot on that 
track where it is loaded. You’ll see that the sub-menu for Insert A offers 16 options (A-1 through A-16) 
- you can choose any one of these to feed MIDI to POD Farm 2 Plug-In.

In Mixing Board View, click the 
Output selector for your MIDI 
track

Select the POD Farm 2 Plug-In - 
Insert A and choose one of the 16 
sub-menu options

This configures the MIDI track to 
receive MIDI from your connect-
ed controller and feed it to the 
POD Farm 2 Plug-In, allowing 
you to remotely control param-
eters in the Plug-In!

DP’s MIDI track output options - routing MIDI to an inserted Plug-In

This completes the configuration. You should now be able to access the “pre-configured” MIDI control 
assignments within POD Farm 2 Tone Presets, or utilize the POD Farm 2 MIDI Learn feature to “map” 
your controller to POD Farm 2 parameters (see “External MIDI Control with POD Farm 2 Plug-In” on 
page 3•7).  Please see your DP documentation for more about its MIDI control features.
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Plug-In Parameter Automation in Digital Performer

Digital Performer offers robust features for “writing” and editing AU plug-in parameter automation, 
and POD Farm 2 and POD Farm Elements Plug-Ins all allow you to take full advantage of these DP 
features! Please first refer to the configuration steps in “Parameter Automation with POD Farm 2 
& Elements Plug-Ins” on page 3•10. To follow we’ve provided some specifics for accessing the plug-in 
parameters for automation within Digital Performer 6.

First, insert POD Farm 2 Plug-In on one of your audio track’s effects Inserts, and make note of which 
Track and Insert slot you’ve loaded it into. For our example, we’ve inserted the Plug-In on the Audio-1 
track, in Insert “A” (the top insert slot in the Audio-1 track strip within the DP Mixing Board screen). 

POD Farm 2 Plug-In loaded into  
“Insert A” of the Audio-1 track

Next, you can select the POD Farm 2 Plug-In parameter(s) you’d like displayed on the track to allow 
automation.

To display the parameter menu for the track, 
click on the Insert button at the left of your au-
dio track where POD Farm 2 Plug-In is inserted

Select the POD Farm 2 Plug-In to display its sub-
menu of “Knob,” “Switch” and “Fixed” param-
eters (it appears as “Insert A” in our example). 
Select a parameter to display it in the current 
lane

You can repeat the above steps to display as many 
POD Farm 2 parameters as you like (as well as to 
display DP mix and global parameters, or param-
eters for any other inserted Plug-in).
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Once you’ve selected a parameter, you’ll see it selected in the 
track’s Audio Edit selector. This allows an editable envelope 
line to be displayed for the parameter across the track

Manually Editing DP Automation Envelopes

Note that to access POD Farm 2 Plug-In model parameters, you must first assign each desired parameter 
to one of the POD Farm 2 “Knob” or “Switch” Automation Slots - please see page 3•12.

With your plug-in parameter displayed on the audio track, you can now manually click on the envelope 
line on the lane to add “node” points and adjust the parameter over time, as we’ve done here for the 
POD Farm 2 Plug-In “Knob 1” parameter:

To allow the automation 
be utilized during play-
back, set the track’s auto-
mation mode to “Read”

Click at the desired locations on the visible envelope line “Node” points 
to the envelope, allowing the parameter to be adjusted over time

Now hit Play to hear the POD Farm 2 parameter you have assigned to “Knob 1” respond to the 
envelope adjustments. 

Using the DP Automation Write Modes

Automation can also be “written” by setting the audio track to one of the automation “write” modes, 
and then accessing the desired parameter’s control directly within the plug-in edit panel.

Note that to access POD Farm 2 Plug-In model parameters, you must first assign each desired parameter 
to one of the POD Farm 2 “Knob” or “Switch” Automation Slots - please see page 3•12.

In the following example, we’ve assigned the POD Farm 2 Plug-In, Wah - Pedal Position parameter to 
the “Knob 1” Automation Slot. Then we’ve set the DP Audio-1 track’s automation mode options to 
“Record” and “Touch”. With these settings made, once the DP project playback is started, the POD 
Farm 2 Plug-In  - Wah Pedal Position knob can be manipulated during playback (either by using 
the mouse directly in the Wah panel, or via external MIDI control) and the Wah “performance” is 
captured by DP via the Nodes added to the Knob 1 envelope.
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To write automation, set the 
track’s automation settings 
to Record and one of the 
“write” settings (Latch is 
usually a good one - see your 
DP Help for details)

“Node” points have been written automatically, in response to adjustments 
made with the plug-in’s Wah Position knob during playback

You can also use the above steps to write and edit parameter automation for any of the POD Farm 
Elements Plug-Ins. For more info about parameter automation, please see your Digital Performer  
documentation.
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Propellerhead Reason® 4 Setup
Propellerhead Software’s Reason® is an amazing virtual studio filled with synthesizers, drums and 
effects, all combined with a MIDI sequencer for easy pattern-based music creation. Reason does not 
offer a feature for recording audio, therefore, POD Farm™ 2 and Line 6 USB audio devices cannot 
be used for input directly into Reason.* However, you do, of course, need a sound card device for 
playback, and your POD Studio™, TonePort™, GuitarPort™, POD® X3 or POD®xt is the perfect 
high quality audio interface for this task! 

 *If you are a Reason user looking to add audio recording ability, then the recently released Propellerhead 
Record application might be just the thing for you. It is designed to work with Line 6 USB audio devices 
and includes powerful POD Farm Tones built right in! Please visit the Propellerhead Site.

When using your Line 6 device, you can also simultaneously plug in your instrument and jam along 
with the playback of your Reason project. Or, utilize the Reason ReWire® technology to combine a 
Reason project with that of another ReWire capable DAW host application, and use your Line 6 device 
and POD Farm 2 & POD Farm Elements Plug-Ins with your DAW host software! For this document, 
we’ll be showing how to set up a Line 6 USB audio device with Propellerhead Reason version 4.0.3 - 
Setup is similar with other recent Reason versions. 

Configure Your Mac® to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Mac® System Preferences and select the 
Line 6 Audio-MIDI Devices dialog to access the Audio Driver settings. Please see “Mac® Driver 
Settings” on page 2•1 for details on Driver settings for your specific Line 6 hardware. 

Configuring Reason to Use the Line 6 Core Audio Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps.

Launch the Reason’s Preferences dialog:

Select Preferences from the Reason menu

http://www.propellerheads.se/products/record/
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Select the Audio page

For Audio Output, choose your Line 
6 device

Choose a Sample Rate – 44100 is a 
good choice for most projects, but you 
can choose 4800, 88200, or 96000 
if your project requires one of these 
specific sample rates

Set the Buffer Size to 256 as a good 
starting point. If your Reason playback 
starts experiencing audio drop-outs, 
come back and raise the slider slightly

Close the Preferences dialog when 
done 

Now just hit the Play button in Reason’s transport to hear the 
Reason audio playback through your Line 6 hardware!

To Jam Along with Reason…

You can also use POD Farm 2 in standalone operation, or configure your POD X3/PODxt for your Mic 
and Instrument Tones to sing or jam along while Reason is playing. Just plug in your Mic or Instrument 
and use POD Farm 2 in standalone operation or your POD just as you normally do. Note that you can 
adjust the level of your Mic or Instrument independently of the level of the Reason playback.

Use the Master Output knob and the Mixer View Tone A & Tone B Mixer controls to 
adjust your POD Farm 2 volume independently of your Reason playback volume
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Use the Master slider in the Reason Mixer to 
control Reason’s playback volume

If you are using POD X3, use the Tone Volume and Master Volume to balance out your Mic/
Instrument volume versus the Reason playback:

The Tone Volume knob affects only your Mic/
Instrument Tone  level

The Master Volume knob controls the combined Mic/
Instrument + Reason output sent to your speakers or 
headphones

If you are using PODxt, use the Channel Volume knob to balance out your Instrument volume 
versus the Reason playback:

The Channel Volume knob affects only your 
Instrument Tone  level

With this configuration, both the Reason project playback and your Mic/Instrument tones are heard 
through your speakers, and sent to your device’s outputs. This also allows you to connect the Line 6 
hardware’s outputs to an external device, such as a tape recorder, mixer, P.A. system, etc., to record or 
amplify this stereo output signal!

Using your Line 6 Hardware with Reason in a ReWire Setup

The Propellerhead ReWire® technology allows the Reason modules’ outputs to be directly routed into 
any ReWire “Host” application. Using ReWire, the Host application can send a MIDI track’s output to 
Reason’s synth modules, and Reason then feeds audio playback directly into the ReWire Host, which 
is mixed with the audio of the Host application. When Reason is configured as a ReWire “Slave” in 
this manner, it is controlled by the Host application and does not utilize an audio driver connection 
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itself. Therefore, if you want to use your Line 6 hardware as your audio interface in a ReWire setup like 
this, it is necessary for you to choose your device as the assigned audio device within the ReWire Host 
application. To read more about the ReWire technology and the latest about ReWire Host support, 
please visit the Propellerheads web site. 

Using Reason with Ableton Live as a ReWire Host

The Ableton Live® DAW software is capable of functioning as a ReWire Host application. The 
following steps show you how to set POD Studio as the audio device for the Ableton Live software, 
and then configure Live to connect with Reason 4 as a ReWire Slave device. This enables you to do 
audio recording and playback with Ableton Live, allowing Reason’s output(s) to be automatically 
played in sync and channeled through Live’s audio tracks via ReWire. The setup process is similar in 
other ReWire Host applications (Steinberg Cubase®, Cakewalk SONAR®, etc.) and you can certainly 
use your Line 6 hardware & POD Farm 2 Plug-Ins with these other ReWire Host applications with 
Reason as well!

 Some Line 6 POD Studio and TonePort packages come with a special Ableton Live Lite, Line 6 version 
software included. This Live version also supports Propellerheads ReWire technology! Configuring the 
Live Lite Line 6 version is much the same as the following steps for the Ableton Live version.

You first want to be sure to exit Reason if it is currently running. The ReWire Host application must 
always be launched first. Launch Ableton Live and make the following settings to set your Line 6 
hardware as the Live audio device.

Launch the Ableton Live Preferences dialog:

Go to the Live menu 
and choose Preferences

Just as with most DAW software, in Live you also need to configure the 
individual inputs and outputs once a Multi-in/out device is selected. Click on 
the Input Config button to access the Inputs

Go to the Audio tab

Choose Core Audio as the driver type…

Then choose your Line 6 device for both 
the Input and Output Audio Device. In 
this example, we’ll choose our connected 
UX2

Set a Sample Rate – 44,100 is a good 
choice here, or you can use 48,000, 
88,200 or 96,000 Hz if your Project 
requires a higher sample rate

http://www.propellerheads.se/
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Activate Inputs:

Here you can “activate” all the inputs from your 
Line 6 hardware that you want to be accessible 
for any audio track as a track input for recording

Click OK when done

You’ll want at least the 1 (mono) & 2 (mono) and the 1/2 (stereo) inputs activated. Each additional 
activated input utilizes more CPU, so only activate the ones you need!

Note that you’ll see a different number of inputs listed in the Input Config dialog depending on 
the specific Line 6 device you are using. Typically these enumerated inputs correspond to the Line 6 
device’s Sends of the same number (i.e. - Live’s input “3/4 (stereo)” is the UX2’s Record Send 3-4).  

Activate Outputs:

To access the outputs, click the Output Config button back in the Live Preferences > Audio tab. This 
will show you all outputs available for your selected Line 6 Output Device. 

For all Line 6 devices (except UX8), the Core Audio driver offers Output 1/2, therefore, the dialog 
shows two mono and 1 stereo output options, and they are automatically selected. 

UX8: You’ll see 8 mono and 4 stereo outputs. For most Live projects, you likely only need to enable 
the Output 1/2 mono and stereo options and assign all track playback to one common output. UX8 
does offer some very flexible monitoring and signal routing options using its additional outputs - 
please see “Line 6 Audio-MIDI Settings - Inputs & Recording Tab (UX8 Only)” on page 2•7 for more 
information.

Note: The Ableton Live Lite versions have a restriction that allows only one stereo output to be used at a 
time. To be able to choose two or more different output devices in a Live Set, you must switch into Demo 
mode, or upgrade to a full version of Ableton Live.
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Now that Ableton Live is configured to use your Line 6 device, launch Reason. Reason will automatically 
set itself to ReWire Mode. You can check this mode in the Reason Preferences: 

Select the Audio settings

When Reason is in ReWire mode, the Audio 
Output will be non-selectable and this message 
appears 

Now in Ableton Live, you can simply access the Output menu of any MIDI track to route its MIDI to 
any of the Reason synth modules.

In any of Live’s MIDI tracks, choose 
Reason as the MIDI To output

Then click on the Output Channel 
selector to choose any Reason module

To receive the audio output from Reason, set the Input of any of Live’s audio tracks to receive the 
audio from any of Reason’s outputs.

In one of Live’s Audio tracks, choose 
Reason as the Audio From input

Then click on the Input Channel 
selector to choose any Reason output

(Note that the 1/2 Mix L, Mix R 
channel receives the full Reason project 
audio mix)
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Now just hit the Play button in either Live or Reason, 
and both projects will play in sync, with all the audio 
being routed into Ableton Live and played through 
your Line 6 hardware!

You can utilize your Line 6 device and POD Farm 2 in standalone operation (or your POD X3/PODxt)
to also plug in a Mic or Instrument, dial in your tone, and record audio tracks right into the Ableton 
Live Set. This ReWire configuration is especially slick since the “ReWired” Reason audio can be 
treated as part of your Live Set - you can mix, add effects plug-ins (such as POD Farm 2 or POD 
Farm Elements Plug-Ins) on the incoming Reason ReWire audio track, and all will be incorporated 
into your audio mix-down when you do an Export from Live! It is important to note, however, that 
running all these programs at one time can require some hefty usage of your computers processor, RAM 
and disk access, especially as you add more tracks, Reason modules and real-time effects. Your actual 
performance will depend on the specifications of your computer. Also see the “Using the POD Farm 2  
VST or AU Plug-In” on page 3•4 .
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Steinberg Cubase® 5 Setup

For this chapter, we’ll show how to configure Steinberg Cubase® 5 to work with Line 6 POD Studio™, 
TonePort™, GuitarPort™, POD X3 or PODxt as the USB audio device, as well as optionally using 
POD Farm™ 2 Plug-In and/or POD Farm™ 2 in standalone operation on your Mac® computer.  The 
steps are very similar for the setup of other recent Steinberg Cubase® Studio & Nuendo® versions. 
Steinberg’s Cubase® & Nuendo® 64-bit versions are also supported by your Line 6 hardware and POD 
Farm 2!

Choose Your Line 6 Gear Configuration

Before you record your first track in any DAW software, you have a few options to consider  with your 
Line 6 hardware & POD Farm 2 gear! You should decide if you want to record a “dry” signal into the 
audio track, such as if you want to utilize POD Farm 2 Plug-In to “non-destructively” apply your POD 
Farm 2 Tone onto the recorded track. Or, if you prefer to record a “processed” signal, where the POD 
Farm 2 Amp/Preamp and Effects are already applied and recorded permanently on the track. We’ll 
cover the steps to record either of these ways, but first it is helpful to understand the options with your 
particular Line 6 gear.

POD Studio, TonePort, GuitarPort devices 

•	 Using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into your 
device and launch POD Farm 2 in standalone operation. Use the Mixer View - Record Send 
Source options to choose the type of signal fed to your Record Sends. Also see “POD Farm™ 2 
Standalone Operation” on page 4•1 for more about the Mixer View. 

•	 Tone A, Tone B or Tone A+B - Feeds the same fully processed signal from the respective 
Tone path(s) that you hear out to the Record Send.

•	 Tone A (semi) - This option is available only when a single Tone A exists in POD Farm 2.  
It feeds only the signal processed with the Amp group of models (Amp/Cab/Mic/Preamp 
models) plus any effects inserted to the left of the Amp group within Tone A. Note that 
you’ll still hear the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ 
Monitoring output. (Useful, for example, if you want to hear a delay or reverb effect inserted 
after the Amp group, but do not want that delay effect recorded!)

•	 Dry Input - Feeds a completely unprocessed signal to the Record Send, even though you can 
listen to the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ Monitoring 
output. (This is a great option if you want to insert POD Farm 2 or Elements Plug-Ins on the 
recorded audio track in the DAW later!)

•	 Without using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into 
your device and configure the Line 6 Audio-MIDI Settings  dialog to feed your “dry” input 
source to your device’s Record Sends. See “Mac® Driver Settings” on page 2•1 for more about this. 
Note that when using this option, you won’t have the benefit of POD Farm 2 ToneDirect™ 
Monitoring when not running POD Farm 2 in Standalone mode, so you’ll need to enable your 
DAW software’s monitoring feature on the audio track (more on this in the next section).

POD X3 devices - Plug a Mic or Instrument into your POD X3 and configure the options within 
X3’s onboard Outputs - Studio/Direct Mix settings screen to determine what type of signal is fed 
to the X3’s Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your POD X3 Pilot’s Handbook for 
details on X3’s Output screen options. 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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PODxt devices - Plug a Mic or Instrument directly into your PODxt device and configure the 
options within the Line 6 Audio-MIDI Settings dialog for the type of signal (Processed or Dry) that 
is fed to the Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your PODxt Pilot’s Handbook for 
details about output options.

Monitoring through the DAW software - If you are using POD Studio/TonePort/GuitarPort hardware 
and not running POD Farm 2 in standalone operation, then you’ll need to use the DAW software’s own 
monitoring feature to hear your input signal routed through the DAW software’s audio track, as called 
out in the following steps. This also means you’ll hear the input signal effected with any Plug-Ins, such 
as if you have POD Farm 2 Plug-In inserted on the same audio track. You may need to set your DAW 
software’s buffer size fairly low to minimize the “latency” (the time between when you pluck a note 
on your guitar to the time you actually hear it after feeding through your DAW software and out your 
speakers). We’ll cover all these steps here.

Configuring Cubase to Use the Line 6 Audio Driver

Launch Cubase and Open the Device Setup Dialog:

Go to the Cubase Devices menu 
and choose Device Setup

Click on VST Audio System 
Select your Line 6 
device for the ASIO®  
Driver 

If you are prompted to “switch the ASIO driver” after selecting 
your Line 6 device, go ahead and click on Switch

You can then exit the Device Setup dialog.

http://line6.com/support/manuals/
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Establish Your Inputs and Outputs:

Next we need to configure the Inputs and Outputs from the Line 6 hardware so they can be accessed 
within your Cubase Projects. This can get a bit fiddly in Cubase, but you only need to do this once for 
your audio device, so hang in there!

Return the Cubase Devices menu 
and select VST® Connections

Go to the Inputs tab

Initially, you’ll likely see that at least one Stereo In “Bus” has automatically been created for you 
using your  Line 6 device, and its Send 1 and 2 audio channels are each assigned as the Left and Right 
channels for this initial Bus. POD Studio, TonePort, GuitarPort and POD X3 devices offer more than 
just the one stereo Record Send 1-2, however, so for these devices you’ll want to create an additional 
stereo Bus for each Send. Also, you’ll want to create mono Buses for all the individual Send audio 
channels to allow you to record from any one of them as a mono input to a Cubase audio track. In our 
example we’re using UX2, and just as with GX, D.I., UX1, KB37, and GuitarPort devices, there is also 
a Send 3-4 available. UX8 offers 6 stereo Sends, and POD X3 offers 4 stereo Sends. 

Follow these steps in the dialog to add additional Buses for all your device’s Sends:

Add Buses

Press the Add Bus button, create 1 Stereo Bus, then repeat and add 4 Mono 
Buses using the Add Input Bus dialog
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Next, each Bus channel needs to be correctly assigned to the desired hardware Send. The Stereo In 2 
Bus likely has already been correctly assigned to the Line 6 device’s next stereo Send (Send 3-4 for our 
UX2). But the Mono In Buses all defaulted to “Send 1”, which is not what we want. Click directly on 
the Device Port field for each of the Mono Buses and select a different Send channel for each. For our 
UX2, we’ll assign one each to Send 1, 2, 3, & 4.

Click on the Device 
Port to choose 
the desired Line 6 
device Send channel 
assignment - do this for 
each input Bus

The result should now look like this, 
with each Stereo In and Mono In 
Bus assigned to its own specific Line 6 
hardware Send.  

(Make a mistake? No worries, you 
can right click or Ctrl+click on any 
Bus Name and “Remove” it and add 
another if needed.)

Now to the Outputs tab... The procedure is the same here. You should see a Stereo Out Bus already 
created here for you and correctly assigned to your Line 6 device’s main Output 1 & 2 for its Left and 
Right channels.
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This one Bus is fine for most Cubase Projects, since you’ll likely just assign all audio tracks to this one, 
common stereo output. But you can optionally create Mono Buses for each of these Outputs if you need 
them. Or, if you have a UX8, your device includes 4 Stereo outputs (8 Mono outputs) which means you 
can do the Add Bus thing here and create Stereo and Mono Buses utilizing all the additional Outputs 
if you like - even for a 5.1 Surround system if needed! 

 
UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and monitoring. 
Please see “Line 6 Audio-MIDI Settings - Inputs & Recording Tab (UX8 Only)” on page 2•7.

Create a Preset

Finally, it’s a good idea to now save all these settings as a Preset. You can even create several different 
Bus scenarios for your Line 6 hardware and save each as a different Preset to recall them easily any 
time!

Click the little Add button 

Then type in a name for your Preset and click 
OK to finish it up

You can now exit the VST Connections dialog

 

TIP: Be sure to open the VST Connections window and select this Preset before you open or create a 
Cubase Project so that it will use this set of Inputs and Outputs! It’s also pretty handy to create a Project 
Template with a Cubase Project so that you don’t need to go through the repetitive task of creating a bunch 
of tracks and assigning them to the same Ins & Outs every time you start a new Project. See the Cubase 
documentation regarding creating a Project Template.

Open or Create a New Cubase Project

Go to File > New Project to start a new Cubase Project. Once your Project is open, look at the bottom 
left of the Cubase screen to check its Sample Rate & Bit Depth. If these are not what you want, then 
you can go to the Project > Project Setup dialog. 
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Look at the Cubase Project’s Sample Rate & Bit Depth 
here (at the bottom of your Cubase Project window)

44,100 Hz is a good choice for your Sample 
Rate, or you can choose 48,000, 88,200 or 
96,000 Hz if your project specifically requires one 
of these higher rates

Choose 32 Bit as your Record Format

Configuring an Audio Track for Recording 

Now that your Line 6 hardware and Cubase Buses are set up, you are ready to start working in your 
Cubase Project!  

Add an Audio Track

This launches the Add Audio Track dialog, 
where you can choose the type of track, and 
how many to add. We’ll add one Stereo track 
for our example

In the Cubase Project menu, select to 
add an Audio track
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Select Your Audio Track’s Input and Output

Click on the Audio track’s Input Routing 
selector to choose the recording input. You’ll 
see all the Input Buses here that you created 
in the VST Connections - Input dialog. You 
can choose either a stereo or mono input*

The Audio tracks’ Output Routing should 
default to your Line 6 device’s Output 1-2
(Or, if you created additional Output Buses in 
the VST Connections dialog, you can choose 
the preferred one here)

*Note that for a stereo audio track, choosing a Stereo Input Bus will record a stereo file. Choosing a 
Mono Input Bus will record a mono file. If you create a mono audio track, then you can only choose 
a Mono Input Bus (or only one channel of your Stereo Bus) as the track input, and this will record a 
mono file. 

Set Input Monitoring Options

As mentioned in the previous Choose your Line 6 Gear Configuration section, you’ll want to keep 
the Cubase Monitor function “off” on the audio track if you are utilizing POD Farm in 2 standalone 
operation, or if using POD X3 or PODxt for their Monitoring capabilities. This way, your input is not 
also fed through the Cubase software.

Keep the audio track’s Monitor button set to OFF
(You can access this and most other track controls on both the Track 
Header or to the left in the “Inspector”)

If you are using POD Studio/TonePort/GuitarPort and not running the POD Farm 2 standalone 
application, then you’ll want to turn the Cubase track’s Monitor button “ON” to hear your input signal 
through the Cubase software. You’ll likely also want to insert POD Farm 2 and/or POD Farm Elements 
Plug-Ins on this audio track now and dial in some Amp & Effects models to hear them applied to your 
input signal while recording. See the Cubase documentation for more about its Monitor options.
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Arm Your Track & Set Your Levels

Click the Record Enable button “ON” 
to arm the audio track for recording*

*Note that the track meters in Cubase will not measure the input signal unless the track’s Input Monitoring 
feature is on (which of course we just turned OFF in the last step). You can display the Cubase Mixer and 
the level meters there are active for inputs with the Monitor function on or off. 

If desired, launch the Cubase Mixer and you can 
view the meters for the respective Audio track to 
gauge your input levels before you start recording 
(the Mixer meters always show the input signal, 
regardless if the track’s Monitoring in On or Off)

The signal coming into the Cubase track, and how you adjust its level, depends upon the configuration 
of Line 6 gear you’ve selected, as covered at the start of this chapter. 

•	 If you are using POD Studio/TonePort/GuitarPort hardware and not running POD Farm 2 in 
standalone operation, then you’ll need to use your guitar’s volume knob, the hardware’s Mic 
Gain knob, or the volume on the external device plugged into any Line In.

•	 If you are using POD X3/PODxt hardware, adjust your levels using the onboard Output controls 
for what is routed to the Record Send you’ve selected for the audio track’s inputs.

•	 If you are using POD Farm 2 in standalone operation, use the POD Farm 2 Mixer View. Note 
that here you can choose the type of signal fed to either Record Send and adjust the levels 
independently of the signal you hear coming from the ToneDirect™ Monitoring signal!
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Adjust the Record 
Send Levels

Choose the type of “Source” signal 
that is fed to each Send*

If the Record Send output 
is still very low, activate the 
+18 boost 

POD Farm 2 standalone Mixer - Record Send controls

*Note that you’ll have different options for POD Farm 2 Record Send Sources depending on if you 
currently have a Single or Dual Tone running. Please see the “Mixer View” on page 4•1.

Start Recording!

Once your record level is set, click on the transport Record button and start riffing!

Using POD Farm 2 & POD Farm Elements Plug-Ins in Cubase

If you want to insert the POD Farm 2 or any of the POD Farm Elements Plug-Ins on your Cubase track, 
just click on one of the Inserts menus, found both in the Cubase Track Inspector to the left of the track, 
and in the Cubase Mixer.  
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Click on one of the Insert slots for your 
audio track and choose POD Farm 2 or 
one of the Elements Plug-In from the 
list

Cubase supports the VST Plug-In format on Mac®, so if you installed the VST POD Farm 2 & Elements 
Plug-Ins during your POD Farm 2 installation, they should be available in Cubase, as shown above. 
If the Plug-Ins do not appear within the Cubase Insert menu, you may need to set Cubase to find the 
POD Farm 2 VST directory. To do this go to the Cubase Devices menu:

In the Devices menu, select Plug-in 
Information

In the VST Plug-ins screen, click the 
VST 2.x Plug-in Paths button
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Click the Add button and browse to 
the directory where your POD Farm 2 
VST Plug-Ins are installed. The default 
directory is: 
/Library/Audio/Plug-Ins/VST 

Once you’ve added the new path, click 
OK 

Now, back in the VST Plug-ins dialog, click the Update button to have Cubase 
rescan your system, and you should see the POD Farm 2 & POD Farm Elements 
Plug-In appear in the VST list below. All Plug-Ins should then be available 
within the Cubase Insert menus

External MIDI Control of POD Farm 2 Plug-In in Cubase

Cubase offers the ability to access the knobs, sliders & switches of any inserted VST Plug-In remotely, 
via a hardware MIDI controller device, provided the VST Plug-In supports this ability. And POD 
Farm 2 Plug-In does indeed support MIDI Control to allow you to take full advantage of these MIDI  
features! It is recommended that you first get familiar with the POD Farm 2 MIDI Control features 
and configuration covered in the POD Farm 2 Basic User Guide, as well as in the Plug-In chapter 
on page 3•7.

As described in the Plug-In chapter, Cubase, like most DAWs, requires that you configure a MIDI 
track to route your MIDI controller device’s MIDI commands into the POD Farm 2 Plug-In. The first 
step is to make sure your MIDI controller device is connected to your computer, and accessible within 
Cubase. For example, our USB-connected Line 6 UX2 & FBV Shortboard Express devices are both are 
automatically detected by Cubase, and appear as available input to a Cubase MIDI track. If your MIDI 
controller device is not detected, please consult the Cubase documentation.

To route MIDI to an instance of POD Farm 2 Plug-in, insert POD Farm 2 Plug-In on one of your audio 
track’s effects Inserts, and make note of which Track and Insert slot you’ve loaded it into. For our 
example, we’ve inserted the Plug-In on the Audio 01 track, in Insert “1” (the top slot).
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POD Farm 2 Plug-In loaded into  
“Insert 1” of the Audio 01 track

Next, create a new MIDI track in your project and configure its MIDI Input & Output options. We’ll 
select our Line 6 FBV Shortboard MkII-Port 1 as the Input (our MIDI controller device). For the MIDI 
track’s Output we need to select the specific track & Insert slot for the desired “POD Farm 2 Plug-In”.

Select your MIDI controller device as the 
MIDI track Input

Select the “Audio 01 Ins. 1 - POD Farm 2 
Plug-In” as the MIDI track output to route 
the MIDI to the specific Plug-In

Important - you must keep the MIDI track’s Monitor 
option ON to allow MIDI to be fed to the track output!

This completes the configuration. You should now be able to access the “pre-configured” MIDI control 
assignments within POD Farm 2 Tone Presets, or utilize the POD Farm 2 MIDI Learn feature to “map” 
your controller to POD Farm 2 parameters (see “External MIDI Control with POD Farm 2 Plug-In” on 
page 3•7).  Please see your Cubase documentation for more about its MIDI control features.

Plug-In Parameter Automation in Cubase

Cubase offers robust features for “writing” and editing VST plug-in parameter automation, and 
POD Farm 2 and POD Farm Elements Plug-Ins all allow you to take full advantage of them! We’ve 
provided step by step instructions for assigning POD Farm 2 Plug-In parameters, displaying and editing 
automation envelopes, as well as for using the Cubase automation “Write” modes in the Plug-In 
chapter. Please see “Parameter Automation with POD Farm 2 & Elements Plug-Ins” on page 3•10.
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Windows® Audio Applications
The following chapters cover the setup of Line 6 POD Studio™, TonePort™, GuitarPort™, POD® 
X3 or POD®xt as the USB audio device, as well as optionally using POD Farm™ 2 Plug-In and/
or POD Farm™ in Standalone operation, with several popular Windows® DAW applications. The 
examples used in these Setup chapters all utilize Windows® XP, however, the steps are the same within 
Windows® 7 & Windows Vista®, unless otherwise noted.

For the latest news and developments on POD Farm 2, audio drivers and Windows® support, please visit 
the POD Farm Online Help site.

Use the following links to jump to the chapter that covers your specific DAW 
application:

“Ableton Live® 8 Setup” on page 6•2

“Cakewalk SONAR® 8 Studio/Producer Setup” on page 6•17

“Digidesign Pro Tools® LE 8 Setup” on page 6•31

“Propellerhead Reason® 4 Setup” on page 6•55

“Steinberg Cubase® 5 Setup” on page 6•62

“Mac® Audio Applications” on page 5•1

http://line6.com/dispatch/index.html?page=manuals&appid=2097217554
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Ableton Live® 8 Setup
For this chapter, we’ll show how to configure Ableton Live® version 8 to work with Line 6 POD 
Studio™, TonePort™, GuitarPort™, POD® X3 or POD®xt as the USB audio device, as well as 
optionally using POD Farm 2 & POD Farm 2 Elements Plug-Ins, and/or POD Farm 2 in standalone 
operation on your Windows® computer.  The steps are very similar for the setup of other Live versions 
as well, including the special Ableton Live Lite - Line 6 Edition versions.

Choose Your Line 6 Gear Configuration

Before you record your first track in any DAW software, you have a few options to consider  with your 
Line 6 hardware & POD Farm 2 gear! You should decide if you want to record a “dry” signal into the 
audio track, such as if you want to utilize POD Farm 2 Plug-In to “non-destructively” apply your POD 
Farm 2 Tone onto the recorded track. Or, if you prefer to record a “processed” signal, where the POD 
Farm 2 Amp/Preamp and Effects are already applied and recorded permanently on the track. We’ll 
cover the steps to record either of these ways, but first it is helpful to understand the options with your 
particular Line 6 gear.

POD Studio, TonePort, GuitarPort devices 

•	 Using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into your 
device and launch POD Farm 2 in standalone operation. Use the Mixer View - Record Send 
Source options to choose the type of signal fed to your Record Sends. Also see “POD Farm™ 2 
Standalone Operation” on page 4•1 for more about the Mixer View. 

•	 Tone A, Tone B or Tone A+B - Feeds the same fully processed signal from the respective 
Tone path(s) that you hear out to the Record Send.

•	 Tone A (semi) - This option is available only when a single Tone A exists in POD Farm 2.  
It feeds only the signal processed with the Amp group of models (Amp/Cab/Mic/Preamp 
models) plus any effects inserted to the left of the Amp group within Tone A. Note that 
you’ll still hear the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ 
Monitoring output. (Useful, for example, if you want to hear a delay or reverb effect inserted 
after the Amp group, but do not want that delay effect recorded!)

•	 Dry Input - Feeds a completely unprocessed signal to the Record Send, even though you can 
listen to the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ Monitoring 
output. (This is a great option if you want to insert POD Farm 2 or Elements Plug-Ins on the 
recorded audio track in the DAW later!)

•	 Without using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into 
your device and configure the Line 6 Audio-MIDI Settings  dialog to feed your “dry” input 
source to your device’s Record Sends. See “Inputs & Recording Tab - Windows” on page 2•22 for 
more about this. Note that when using this option, you won’t have the benefit of POD Farm 2 
ToneDirect™ Monitoring when not running POD Farm 2 in standalone mode, so you’ll need 
to enable your DAW software’s monitoring feature on the audio track (more on this in the next 
section).

POD X3 devices - Plug a Mic or Instrument into your POD X3 and configure the options within 
X3’s onboard Outputs - Studio/Direct Mix settings screen to determine what type of signal is fed 
to the X3’s Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your POD X3 Pilot’s Handbook for 
details on X3’s Output screen options. 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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PODxt devices - Plug a Mic or Instrument directly into your PODxt device and configure the 
options within the Line 6 Audio-MIDI Settings dialog for the type of signal (Processed or Dry) that 
is fed to the Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your PODxt Pilot’s Handbook for 
details about output options.

Monitoring through the DAW software - If you are using POD Studio/TonePort/GuitarPort hardware 
and not running POD Farm 2 in standalone operation, then you’ll need to use the DAW software’s own 
monitoring feature to hear your input signal routed through the DAW software’s audio track, as called 
out in the following steps. This also means you’ll hear the input signal effected with any Plug-Ins, such 
as if you have POD Farm 2 Plug-In inserted on the same audio track. You may need to set your DAW 
software’s buffer size fairly low to minimize the “latency” (the time between when you pluck a note 
on your guitar to the time you actually hear it after feeding through your DAW software and out your 
speakers). We’ll cover all these steps here.

 Info View

First a handy tip... If you are new to Ableton Live then you might want to turn on the Info View panel. 
This displays a brief description of the user interface element within Live that your mouse is currently 
over. You can show/hide this panel by choosing it from Live’s View menu:

Configure Your Windows® PC to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Windows® Control Panel and select the 
Line 6 Audio-MIDI Devices utility to access the Audio Driver settings. 

Go to the Driver tab

Set the ASIO Buffer Size to 
256 as a good starting point - 
or, you can try a lower value if 
your PC is snappy enough*

Set the Bit Depth to 24 bit

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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 * If you are to be using POD Studio/TonePort/GuitarPort to record “dry” and using your DAW software’s 
Monitoring feature rather than running POD Farm in standalone operation, you will likely need to set the 
ASIO Buffer as low as possible here to minimize latency. 

Please see “Windows® Driver Settings” on page 2•19 for details on Driver options for your specific Line 6 
hardware. 

Configure Live to Use the Line 6 ASIO® Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps.

Launch the Ableton Live Preferences dialog:

Go to the Live Options 
menu and choose 
Preferences

Make the following settings within Live’s Preferences - Audio tab

Just as with most Multitrack DAW software, in Live you 
also need to configure the individual inputs and outputs 
once a Multi-in/out ASIO device is selected. Click on 
the Input Config button to access the Inputs.

Go to the Audio tab

Choose ASIO as the driver type…

Then choose your Line 6 device for the 
Audio Device. In this example, we’ll 
choose our connected UX2

Since we’re using the ASIO driver, the 
Buffer Size is adjusted in the Line 6 
Audio-MIDI Devices dialog - click the 
Hardware Setup button to launch it (see 
previous section)

Set a Sample Rate – 44,100 is a good 
choice here, or you can use 48,000, 
88,200 or 96,000 Hz if your Project 
requires a higher sample rate
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Activate Inputs:

Here you can “activate” all the inputs from your 
Line 6 hardware that you want to be accessible 
for any audio track as a track input for recording

Click OK when done

You’ll want at least the 1 (mono) & 2 (mono) and the 1/2 (stereo) inputs activated. Each additional 
activated input utilizes more CPU, so only activate the ones you need!

Note that you’ll see a different number of inputs listed in the Input Config dialog depending on the 
specific Line 6 device you are using. Typically, these inputs are fed by your Line 6 hardware’s Record 
Sends of the same number (e.g. - Live’s Input 1/2 is fed by UX2’s Record Send 1-2).

POD Studio, TonePort & GuitarPort devices: You will see 4 Mono inputs and 2 Stereo inputs, as 
pictured above. 

TonePort UX8: You’ll see 12 Mono inputs and 6 Stereo inputs.

If you are running POD Farm  2 in standalone operation, the POD Farm 2 Record Sends 1-2 & 3-4 will 
be fed into Live on (Mono and Stereo) Inputs 1-2 & 3-4. For UX8, its Record Sends 9-10 & 11-12 are fed 
into Live on Inputs 9-10 & 11-12, as configured in the POD Farm 2 Mixer View.

The UX8 driver offers multiple Inputs and Sends with many flexible options for routing and monitoring. 
Please see “Line 6 Audio-MIDI Devices - Inputs & Recording Tab (UX8 only)” on page 2•25.

POD X3 devices: You’ll see 8 Mono inputs and 4 Stereo inputs.

POD X3 offers several onboard options for the type of signal that is assigned to each Send. For more info 
about POD X3 Sends, please see page 2•22 and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see 2 Mono inputs and 1 Stereo input.

PODxt offers onboard options, as well as options within the Line 6 Audio-MIDI Settings dialog for the 
type of signal that is assigned to the Record Send. For more info about the PODxt Sends, please see page 2•22 
and your PODxt Pilot’s Handbook.
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Activate Outputs:

To access the outputs, click the Output Config button back in the Live Preferences > Audio tab. This 
will show you all outputs available for your selected Line 6 Output Device. 

For all Line 6 devices (except UX8), the ASIO driver offers only Output 1/2, therefore, the dialog 
shows its two mono and one stereo output options automatically selected. 

UX8: You’ll see 8 mono and 4 stereo outputs. For most Live projects, you likely only need to enable 
the Output 1/2 mono and stereo options and assign all track playback to one common (Master) 
output. UX8 offers some very flexible monitoring and signal routing options using its additional 
outputs - please see the “Line 6 Audio-MIDI Devices - Inputs & Recording Tab (UX8 only)” on 
page 2•25 section, as well as your TonePort UX8 Pilot’s Handbook for more information.

Note: The Ableton Live Lite versions typically have a restriction that allows only one stereo output to be 
used at a time. To be able to choose two or more different output devices in a Live Set, you must switch 
into Demo mode, or upgrade to a “full” version of Ableton Live.

Configure Record Options

Back to the Live Preferences dialog, now select the Record options.

Select the Record 
Warp Launch tab

For File Type you can 
select WAV

For Bit Depth, select 24 
Bit

http://line6.com/support/manuals/
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Configure an Audio Track for Recording 

Now that your Line 6 gear is set up, you are ready to start working in a Live Set! Create a new Live Set 
(or open an existing one) and insert a new audio track to record into.

Choose Insert Audio Track from 
Live’s Insert menu

In the following example, we’ve inserted two audio tracks, assigned their outputs to the “Master” track, 
and assigned the Master Output to the stereo Main 1/2 output of our Line 6 device (UX2). For Audio 
track inputs, you can select from the mono or stereo ASIO inputs of your Line 6 device, which you 
“activated” in the previous steps. If you choose a stereo input, a stereo audio file will be recorded into 
the track, and likewise, if you choose a singular mono input, a mono file will be recorded.

Choose the 
Arrangement View

(Alternatively, you can 
access all these same 
settings in the Session 
View if you prefer)

Click the I-O toggle 
button to display the 
Input/Output settings 
for the tracks

To configure your Audio 
tracks

Choose Ext. In for the 
Input Type

Then choose the stereo or 
mono input you want to 
record from

Set your Audio tracks’ 
Output to Master

Note that here we’ve cho-
sen to record from UX2  
Send 1-2 for track 1, and 
Send 1 for track 2

On the Master track, choose the 
stereo Out 1/2 of your Line 6 device 
for both the Cue Out and Master 
Out*

* Note that the Master Track offers two Output selectors. The top selector is to set a “Cue Out”, which 
allows you to route a separate output for playback of browser clips and previews. If you have a UX8, then 
you can set this Cue Out to a different stereo output to allow you to listen to previews on a completely 
separate headphone or speaker out. Please see Live’s documentation regarding the Cue Out feature. For all 
other Line 6 hardware, set both Master Outs to the same Out 1/2.
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Set Input Monitoring Options

As mentioned in the previous Choose your Line 6 Gear Configuration section, you’ll want to keep 
Live’s Monitor function “off” if you are utilizing POD Farm 2 in standalone operation, or if using POD 
X3 or PODxt for their monitoring capabilities. 

Click the audio track’s Monitor Off 
button

If you are using POD Studio/TonePort/GuitarPort and not running POD Farm 2 in standalone operation, 
then you’ll want to turn Live’s Monitor feature to “Auto” on this track to hear your input signal 
through the Live software. You’ll likely also want to insert POD Farm 2 Plug-In on this audio track 
now and dial in a Tone to hear applied to your input signal while recording. See Live’s documentation 
for more about its software monitoring options.

Arm Your Track & Set Your Levels

Click the Arm button to arm the audio track for recording

Note that you’ll see the meters measure your input recording 
level once the track is armed

The signal coming into the audio track, and how you adjust its level, depends upon the configuration 
of Line 6 gear you’ve selected, as covered at the start of this chapter. 

•	 If you are using POD Studio/TonePort/GuitarPort hardware and not running POD Farm 2 in 
standalone operation, then you’ll need to use your guitar’s volume knob, the hardware’s Mic 
Gain knob, or the volume on the external device plugged into any Line In. 

•	 If you are using POD X3/PODxt hardware, adjust your levels using the onboard Output controls 
for what is routed to the Record Send you’ve selected for the audio track’s inputs.

•	 If you are using POD Farm 2 in standalone operation, use the POD Farm 2 Mixer View. Note 
that here you can choose the type of signal fed to either Record Send and adjust the levels 
independently of the signal you hear coming from the ToneDirect™ Monitoring signal!

TIP: As always, your signal levels are very important for quality recordings - be sure to always adjust your 
instrument or input source’s volume to avoid “clipping” on all meters!
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Adjust the Record 
Send Levels

Choose the type of “Source” signal 
that is fed to each Send*

If the Record Send output 
is still very low, activate the 
+18 boost 

POD Farm 2 standalone Mixer - Record Send controls

*Note that you’ll have different options for POD Farm 2 Record Send Sources depending on if you 
currently have a Single or Dual Tone running. Please see the “Mixer View” on page 4•1.

Start Recording

Once your record level is set, click on Live’s transport Record button to put it 
into Record Mode, then press Play and start riffing!

Using POD Farm 2 & POD Farm Elements Plug-Ins within Ableton Live

To follow we’ve provided some pointers for using POD Farm 2 & Elements Plug-Ins within Ableton 
Live. Please also see the additional plug-in tutorials in the POD Farm 2 & POD Farm Elements Plug-In 
chapter, on page 3•2.
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Activating Effects Plug-Ins in Live

To access all VST effects plug-ins within Live, select the Plug-In Device Browser at the top left of 
the application. If you don’t automatically see the POD Farm 2 & Elements VST plug-ins listed here, 
then you’ll probably see an Activate button, meaning you need  Live to “activate” all plug-ins on your 
system (this has nothing to do with the Line 6 “Plug-In Activation” by the way, it is strictly a Live 
feature for all effects plug-ins):

Click the Activate button   

Click on the button to 
display the Plug-In Device 
Browser  

Clicking the Activate button displays the Preferences dialog - click on the File Folder tab to get to the 
VST options. You’ll also need to manually point Live to the Line 6 directory (or your custom Plug-In 
install directory) so that Live can find your Line 6 VST Plug-Ins: 

Click the Use VST Custom Folder 
button so that it becomes “On”, then 
click Browse to choose the folder where 
POD Farm 2 VSTs are installed

Choose the Program Files\Line 6\POD 
Farm\VST folder* and click OK  
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 *TIP: If you have additional Line 6 VST Plug-Ins (POD Farm 1 or GearBox) installed, you can alternatively 
select the Program Files\Line 6 folder - Ableton Live will then find all VST Plug-Ins within this directory, 
as well as within all sub-directories.

Once the appropriate folder is selected, Live will perform a scan and display all found VST Plug-Ins in 
the Plug-In Devices browser panel like this:

If POD Farm 2 & all Elements VST Plug-Ins do not appear in the browser, try clicking the Rescan 
button in the Live > Preferences > File Folder window.

Insert POD Farm 2 Plug-In

To to insert POD Farm 2 or any Elements Plug-In on your track, simply drag and drop!

Click on the desired plug-in within the Live Plug-In Device Browser and drag 
& drop it directly onto an Audio or Bus Track to “insert” it on the track

Hit play and you’ll hear the plug-in do its thing to the playback of the audio within your track. Tweak 
the POD Farm 2 or Elements Plug-In settings to dial in the perfect tone. 

Plug-In Parameter Automation in Ableton Live

Ableton Live offers features for creating and editing automation envelopes for AU or VST plug-in 
parameters, and POD Farm 2 and POD Farm Elements Plug-Ins all allow you to take full advantage 
of this feature! To follow, we’ve provided some specifics for accessing the plug-in parameters within a 
Live audio or bus track. 
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Ableton Live functions much like other DAW applications in respect to displaying automation 
envelopes and “writing” Plug-In parameter automation. It is highly recommended to first read through 
“Parameter Automation with POD Farm 2 & Elements Plug-Ins” on page 3•10  for a good example of how 
this is typically accomplished in DAW applications. 

Ableton Live requires some additional, specific configuration steps before you’ll be able to see the 
POD Farm 2 Plug-In Automation Slots within its audio or bus tracks’ “Control Chooser” (automation 
parameter) menus. 

These confiration steps are not necessary for Elements Plug-Ins. The Elements Plug-Ins’ parameters will 
automatically appear in the Live track’s Control Chooser. If using an Elements Plug-In, skip ahead to 
“Adjusting a Plug-In Parameter Envelope” on page 6•13.

•	 Once POD Farm 2 VST or AU Plug-In is inserted on a track in your Ableton Live project, assign 
the POD Farm 2 Knob & Switch parameters that you wish to expose for automation (follow the 
steps as described in “Assigning POD Farm 2 Parameters to Automation Slots” on page 3•12).

•	 In the Live “Device Panel,” place the inserted POD Farm 2 Plug-In into “Configure Mode.”

Click the arrow button to 
expand the Live “Plug-In 
Device” window

Click the Configure button 
to put the Plug-In into 
“Configure Mode” 

Placing the inserted POD Farm 2 Plug-In into Configure Mode in Ableton Live

•	 Next, go into the POD Farm 2 Plug-In GUI, display the Edit Panel for the Amp or Effect to 
which you have assigned a Knob or Switch parameter to an Automation Slot, and click once on 
the specific Knob or Switch control. For example, we assigned the Analog Delay W/Mod effect’s 
Mix knob to the Knob 2 Automation Slot. So we’ll click on this Mix knob in the POD Farm 
Plug-In GUI: 

Click on the Delay’s assigned 
Mix knob... 

The “Knob 2” Automation 
Slot then appears within the 
Live project’s POD Farm 2 
Plug-In “device” window

Configuring an “assigned” POD Farm 2 Plug-In parameter in Ableton Live
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•	 Repeat the above steps to configure all your assigned POD Farm 2 Plug-In parameters, and then 
go to the Ableton Live “Control Chooser” for your track and you’ll be able to access each of 
these as automatable parameters. 

The assigned Automation Slots we 
configured now appear in the Live 
Control Chooser list as automatable 
parameters

The Ableton Live track Control Chooser showing “configured” POD Farm 2 Plug-In parameters

Adjusting a Plug-In Parameter Envelope

To access the “automation envelope” for a POD Farm 2 or Elements Plug-In parameter, select the 
desired parameter from the Live track’s Control Chooser selector (see previous section) where the 
Plug-In is inserted. We’ll choose the POD Farm 2 Plug-In -  Knob 2 to access its assigned Analog 
Delay W/Mod - Mix knob. (If you inserted an Elements Plug-In, you can choose any of its parameters 
from the list.) 

Once a parameter is selected, a red envelope line appears 
across the track - you can click and drag this line up/down to 
adjust the selected parameter

Click on the track’s Control 
Chooser and select Knob 2

Double click on the envelope line to create a 
“breakpoint”.  Here, breakpoints are added where we 
want to start and end the parameter change. Note 
that when the mouse cursor is over a breakpoint, the 
parameter value at this position is displayed

Now you can add additional breakpoints and drag them 
up/down to have the Analog Delay-Mix parameter value 
change over time. Here, the results are that no Delay 
effect is heard until bar 13, then it goes to a 50% Mix, and 
gradually back to no Delay by the end of Bar 20
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Ableton Live also features a Draw Mode tool, which allows you to literally “draw” the parameter 
envelope right over the track. You can select the Draw Mode tool from Live’s control bar at the top of 
the window, then use it like a pencil to draw on the track.

Click on the Draw Mode tool Then “draw” your parameter changes directly on the track

Turn off the Draw Mode tool and you can click any individual breakpoint and adjust it up/down to 
fine tune your adjustments, as shown above. Now open the POD Farm 2 Plug-In GUI and select the 
Analog delay W/Mod effect in Panel View and hit Rewind and Play in Live. You’ll see the Delay’s Mix 
knob move in response to this recorded automation, and you’ll hear the Mix change over time!

Using the Automation Write Modes in Ableton Live

Suppose you want to add some “Wah” effect to your recorded guitar track. A great way to do this is 
to tweak and record your Wah Position knob moves while you are playing back the track, so you can 
hear and record your Wah tweaks in real-time. First, load the Elements “POD Farm Wahs” Plug-In 
on your audio track, and select one of its Wah models. (Alternatively, you can insert POD Farm 2 
Plug-In, choose one of its Wah models on your Tone, and assign the Wah Position knob to a “Knob” 
Automation Slot, as shown in the previous steps.) 

Within the Live audio track’s header, use the Device Chooser and Control Chooser as in the previous 
example - this time we’ll select the POD Farm Wahs Plug-In - Pedal Pos parameter.*

 

* Note: It is not actually necessary to select the POD Farm Wahs Plug-In or the specific parameter in 
Live’s Track Chooser selectors, since when you go into the Record mode in the next steps, any POD Farm 
2 Plug-In or Ableton Live track parameters’ adjustments will be recorded, whether the envelope on the 
track is currently displayed or not. However, selecting the specific parameter in the track’s Chooser allows 
you to see your adjustments being written to the track envelope in real-time. 

You’ll want to have the POD Farm Wahs Plug-In GUI open, and so that you have access to the Wah  
position knob for tweaking.
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Next, click on Live’s Transport Record button to place it in “Record Ready” mode - note that you do 
not want your audio track’s Record Arm button on since that will record audio into your track (and 
possibly overwrite your current audio clip). When ready, press the transport Play button and start 
tweaking the Wah Position knob. You’ll hear the effect applied as the track plays, and you’ll see your 
adjustments being “recorded” via the envelope on the track. Do not adjust any other plug-in or Live 
track parameters while in this Record mode, since any such settings changes will be recorded as well. 
Hit your spacebar to stop Live when done. If you didn’t like what you just did, just select Edit > Undo 
in Live before you do any other edits and try again. 

Now start tweaking the Wah position knob 
and you’ll see your adjustments recorded on 
the Live track

Click on the Transport’s Record button, 
and then the Play button when ready

TIP: Instead of using your mouse to adjust the Wah knob, you can alternatively assign a MIDI controller 
pedal to the Wah Position parameter and wangle it just like your trusty old wah pedal - see “External MIDI 
Control with POD Farm 2 Plug-In” on page 3•7.

Once stopped, you’ll see the Device and Control Choosers show red dots to indicate the parameter has 
been “edited”. Further, if you click on the Control Chooser to expand the menu, any plug-in parameter 
that has “edited” automation is shown here with a red dot. You can also now zoom in and further adjust 
the individual “breakpoints” on the envelope, as in the earlier example, to fine tune your automation.
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Red dotes indicate the 
parameter has been edited

Click and drag to adjust the 
envelope’s breakpoints

Once done with your automation for the Wah parameter, it is a good idea to right-click on the track 
and choose “Lock Envelopes” to prevent the envelope from being overwritten. Or, you can leave 
envelopes “unlocked” and repeat the previous steps to record automation for any number of Elements 
or POD Farm 2 Plug-In parameters. 
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Cakewalk SONAR® 8 Studio/Producer Setup

For this chapter, we’ll show how to configure Cakewalk SONAR® 8 Producer Edition to work with 
Line 6 POD Studio™, TonePort™, GuitarPort™, POD® X3 or POD®xt as the USB audio device, 
as well as optionally using POD Farm 2 & POD Farm 2 Elements Plug-Ins, and/or POD Farm 2 in 
standalone operation on your Windows® computer. The steps are very similar for the setup of other 
recent Cakewalk SONAR® Producer, Studio, Home Studio® & Guitar Tracks Pro® versions as well.

Choose Your Line 6 Gear Configuration

Before you record your first track in any DAW software, you have a few options to consider  with your 
Line 6 hardware & POD Farm 2 gear! You should decide if you want to record a “dry” signal into the 
audio track, such as if you want to utilize POD Farm 2 Plug-In to “non-destructively” apply your POD 
Farm 2 Tone onto the recorded track. Or, if you prefer to record a “processed” signal, where the POD 
Farm 2 Amp/Preamp and Effects are already applied and recorded permanently on the track. We’ll 
cover the steps to record either of these ways, but first it is helpful to understand the options with your 
particular Line 6 gear.

POD Studio, TonePort, GuitarPort devices 

•	 Using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into your 
device and launch POD Farm 2 in standalone operation. Use the Mixer View - Record Send 
Source options to choose the type of signal fed to your Record Sends. Also see “POD Farm™ 2 
Standalone Operation” on page 4•1 for more about the Mixer View. 

•	 Tone A, Tone B or Tone A+B - Feeds the same fully processed signal from the respective 
Tone path(s) that you hear out to the Record Send.

•	 Tone A (semi) - This option is available only when a single Tone A exists in POD Farm 2.  
It feeds only the signal processed with the Amp group of models (Amp/Cab/Mic/Preamp 
models) plus any effects inserted to the left of the Amp group within Tone A. Note that 
you’ll still hear the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ 
Monitoring output. (Useful, for example, if you want to hear a delay or reverb effect inserted 
after the Amp group, but do not want that delay effect recorded!)

•	 Dry Input - Feeds a completely unprocessed signal to the Record Send, even though you can 
listen to the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ Monitoring 
output. (This is a great option if you want to insert POD Farm 2 or Elements Plug-Ins on the 
recorded audio track in the DAW later!)

•	 Without using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into 
your device and configure the Line 6 Audio-MIDI Settings  dialog to feed your “dry” input source 
to your device’s Record Sends. See “Windows® Driver Settings” on page 2•19 for more about this. 
Note that when using this option, you won’t have the benefit of POD Farm 2 ToneDirect™ 
Monitoring when not running POD Farm 2 in standalone mode, so you’ll need to enable your 
DAW software’s monitoring feature on the audio track (more on this in the next section).

POD X3 devices - Plug a Mic or Instrument into your POD X3 and configure the options within 
X3’s onboard Outputs - Studio/Direct Mix settings screen to determine what type of signal is fed 
to the X3’s Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your POD X3 Pilot’s Handbook for 
details on X3’s Output screen options. 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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PODxt devices - Plug a Mic or Instrument directly into your PODxt device and configure the options 
within the Line 6 Audio-MIDI Settings dialog for the type of signal (Processed or Unprocessed) 
that is fed to the Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-
MIDI Settings dialog to control your Monitor level. Please refer to your PODxt Pilot’s Handbook 
for details about output options.

Monitoring through the DAW software - If you are using POD Studio/TonePort/GuitarPort hardware 
and not running POD Farm 2 in standalone operation, then you’ll need to use the DAW software’s own 
monitoring feature to hear your input signal routed through the DAW software’s audio track, as called 
out in the following steps. This also means you’ll hear the input signal effected with any Plug-Ins, such 
as if you have POD Farm 2 Plug-In inserted on the same audio track. You may need to set your DAW 
software’s buffer size fairly low to minimize the “latency” (the time between when you pluck a note 
on your guitar to the time you actually hear it after feeding through your DAW software and out your 
speakers). We’ll cover all these steps here.

Configure Your Windows® PC to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Windows® Control Panel and select the 
Line 6 Audio-MIDI Devices to access the Audio Driver settings. 

Go to the Driver tab

Set the ASIO Buffer Size to 
256 as a good starting point - 
or, you can try a lower value if 
your PC is snappy enough*

Set the Bit Depth to 24 bit**

* If you are to be using POD Studio/TonePort/GuitarPort to record “dry” and using your DAW software’s 
Monitoring feature rather than running POD Farm 2 in standalone operation, you will likely need to set 
the ASIO Buffer as low as possible here to minimize latency. 

**IMPORTANT! For all Cakewalk SONAR, Home Studio and Guitar Tracks applications, the highest 
ASIO bit depth supported by the application with Line 6 devices is 24 bit. Before launching your Cakewalk 
software, be sure to set the bit depth in the Line 6 Audio-MIDI Devices dialog specifically to 24 bit.

Please see “Windows® Driver Settings” on page 2•19 for details on Driver options for your specific Line 6 
hardware. 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Configure SONAR to Use the Line 6 ASIO® Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps.

Launch the SONAR Audio settings:

Go to the SONAR Options 
menu and choose Audio

Go to the Advanced tab and select the ASIO driver

Go to the Advanced tab

Choose ASIO as the Driver Mode*

Click OK when done

*It is possible to use the WDM or MME driver modes, but using the ASIO driver type for Line 6 
hardware is recommended since it offers the best performance and multiple input/output channels. For 
more about ASIO Buffer settings, please see “Windows® Driver Settings” on page 2•19.

 Important: If you are switching to ASIO Driver Mode from a different Mode, you will may be prompted 
with the following alert to exit and restart SONAR - if prompted, you must do so before making the next 
settings.
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Activate Inputs & Outputs:

Once you’ve restarted SONAR, go to Options > Audio once again and go to the Drivers tab.

Go to the Drivers tab

Here you will see all ASIO Inputs and 
Outputs for your Line 6 hardware

You can “activate” all the Input Drivers 
& Output Drivers for your Line 6 
hardware that you want to be accessible 
for any audio tracks within a SONAR 
Project

Input Drivers:

Note that you’ll see a different number of inputs depending on the specific Line 6 device you are using.  
Each Input Driver represents one stereo pair of (or two mono)  audio channels, (i.e. - “ASIO UX2 
Send 1-2”). You can select as many as you think you’ll want to record from into SONAR audio tracks, 
but keep in mind that each additional activated input utilizes more CPU, so only activate the ones 
you need!

POD Studio/TonePort/GuitarPort devices (except UX8): You will see 2 ASIO Input Sends, as 
pictured above.

UX8: You’ll see 6 UX8 Input Sends. UX8 offers many flexible routing options for its multiple inputs 
and outputs. Please see “Line 6 Audio-MIDI Devices - Inputs & Recording Tab (UX8 only)” on 
page 2•25 for info.

If you are running POD Farm 2 in standalone operation, the POD Farm 2 Record Sends 1-2 & 3-4 will be 
fed into SONAR on (Mono and Stereo)  Inputs 1-2 & 3-4. For UX8, its Record Sends 9-10 & 11-12 are 
fed into SONAR on Inputs 9-10 & 11-12, as configured in POD Farm’s Mixer View.

POD X3 devices: You’ll see 8 Mono inputs and 4 Stereo inputs.

POD X3 offers several onboard options for the type of signal that is assigned to each Send. For more info 
about POD X3 Sends, please see page 2•22 and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see 2 Mono inputs and 1 Stereo input.

PODxt offers onboard options, as well as options within the Line 6 Audio-MIDI Settings dialog for the 
type of signal that is assigned to the Record Send. For more info about the PODxt Sends, please see page 2•22 
and your PODxt Pilot’s Handbook.
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Output Drivers:

For all Line 6 devices (except UX8), the ASIO driver offers  one stereo output, therefore, you’ll see one 
Output Send, and it will likely already be automatically selected. 

UX8: You’ll see 4 UX8 Output Drivers. For most SONAR projects, you likely only need to enable 
the Output 1-2 mono and stereo options and assign all track playback to one common (Master) 
output. 

Additional Audio settings

Now click on the General tab in the Audio dialog to check a few final settings.

For the Playback Timing Master, select 
the primary ASIO “Output 1-2” of your 
Line 6 device

For the Recording Timing Master, select 
the primary ASIO “Send 1-2” of your 
Line 6 device

The Audio Driver Bit Depth likely is 
grayed out here. You’ll want to set it to 24 
bit if it is not already. If needed, go to the 
Global Options to change this setting*

44100 is a good Sampling Rate to 
choose, or you can select 48000, 88200, 
or 96000 if your Project requires a higher, 
specific rate 

The ASIO Panel button launches the 
Line 6 Audio-MIDI Devices dialog, 
where you can adjust the ASIO Buffer or  
Bit Depth if needed

Click OK when done

*If the Audio Bit Depth was not automatically set to 24 Bit in the previous step, then you can go to 
SONAR’s Options > Global > Audio Data tab and change this setting.
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For the Record Bit Depth, select 24. 
Click OK when done to exit

Configuring a SONAR Audio Track for Recording 

Now that your Line 6 hardware is set up, you are ready to start working in a SONAR Project! Create a 
new Project File (or open an existing one) and insert a new audio track to record into.

Choose Insert Audio Track from 
SONAR’s Insert menu

Select your Audio track’s Input and Output

You’ll see that you have the option of choosing either a “Left” or “Right”  
mono, or a “Stereo” input for any Audio track’s recording input* 

Click on the Audio track’s 
Input selector to choose a 
mono or stereo input

Set your Audio tracks’ Output 
to your Line 6 device’s stereo 
Output 1-2. Or, you can 
optionally set this to the 
“Master” Bus, which SONAR 
often configures as the default 
audio track output
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*Note that the “Left” and “Right” labeled ASIO UX2 Send 1 and ASIO UX2 Send 3 options will 
record from either the Line 6 Device Send 1-2 or Send 3-4, respectively, where “Left” is always the 
odd-numbered channel and “Right” is always the even-numbered channel of the Send. These “Left” 
and “Right” labeled inputs will record a mono file. 

The “Stereo” labeled options will record from the correspondingly numbered Line 6 hardware’s Send 
1-2, Send 3-4, etc., and will record a stereo file.

Set Input Monitoring Options

As mentioned in the previous Choose your Line 6 Gear Configuration section, you’ll want to keep 
the SONAR software monitoring (which SONAR refers to as “Input Echo”) function “off” if you are 
utilizing POD Farm 2 in standalone operation, or if using POD X3 or PODxt for their monitoring 
capabilities. To do this, click the Input Echo button in the audio track’s header.

Click the audio track’s Input Echo button 
to OFF to turn off software monitoring

If you are using POD Studio/TonePort/GuitarPort and not running POD Farm 2 in standalone 
operation, then you’ll want to turn SONAR’s monitoring feature “ON” for this track to hear your 
input signal through the SONAR software. You’ll likely also want to insert POD Farm 2 and/or POD 
Farm Elements Plug-Ins on this audio track now and dial in a few Amp & Effects to hear  them applied 
to your input signal while recording. See SONAR’s documentation for more about these Input Echo 
options.

Click the audio track’s Input Echo button 
to ON to activate software monitoring

Arm Your Track & Set Your Levels

Click the R button “ON” to enable the audio track 
for recording

Note that you’ll see the meters measure your input 
recording level once the track is armed

The signal coming into the audio track, and how you adjust its level, depends upon the configuration 
of Line 6 gear you’ve selected, as covered at the start of this chapter. 

•	 If you are using POD Studio/TonePort/GuitarPort hardware and not running POD Farm 2 in 
standalone operation, then you’ll need to use your guitar’s volume knob, the hardware’s Mic 
Gain knob, or the volume on the external device plugged into any Line In.



Cakewalk SONAR 8 - Windows

6•24

TIP: As always, your signal levels are very important for quality recordings - be sure to always adjust your 
instrument or input source’s volume to avoid “clipping” on all meters!

•	 If you are using POD X3/PODxt hardware, adjust your levels using the onboard Output controls 
for what is routed to the Record Send you’ve selected for the audio track’s inputs.

•	 If you are using POD Farm 2 in standalone operation, use the POD Farm 2 Mixer View. Note 
that here you can choose the type of signal fed to either Record Send and adjust the levels 
independently of the signal you hear coming from the ToneDirect™ Monitoring signal!

Adjust the Record 
Send Levels

Choose the type of “Source” signal 
that is fed to each Send*

If the Record Send output 
is still very low, activate the 
+18 boost 

POD Farm 2 standalone Mixer - Record Send controls

*Note that you’ll have different options for POD Farm 2 Record Send Sources depending on if you 
currently have a Single or Dual Tone running. Please see the “Mixer View” on page 4•1.

Start Recording!

Once your record level is set, click on the transport Record button and start riffing!
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Using POD Farm 2 & POD Farm Elements Plug-In within SONAR

To follow we’ve provided some pointers for using POD Farm 2 & Elements VST Plug-Ins within 
SONAR. Please also see the additional Plug-In tutorials in the POD Farm 2 & POD Farm Elements 
Plug-In chapter, on page 3•2.

Insert POD Farm 2 Plug-In

To insert POD Farm 2 or any of the POD Farm Elements Plug-Ins on your track, simply right-click 
within the audio track’s FX Bin at the left of your track (or within the track’s FX Bin in the SONAR 
Mixer panel) and select one from the Audio FX - Line 6 menu. 

If the Line 6 Plug-Ins do not appear in the Audio FX menu, you may need to set SONAR to find them. 
To do this go to the SONAR - Options > Global > VST Plug-Ins tab, click the Add button and 
Browse to the directory where the POD Farm 2 VST Plug-Ins were installed. By default, this location 
is \Program Files\Line6\POD Farm 2\VST. If you specified a different VST directory during your 
POD Farm 2 installation, then you’ll need to Browse to it.* Then click the Scan VST Folders and 
SONAR should find the POD Farm 2 & Elements Plug-Ins and add them to its FX menus.

POD Farm 2 VST Plug-In path added in the SONAR VST Plug-Ins dialog



Cakewalk SONAR 8 - Windows

6•26

*TIP: If you have other Line 6 VST Plug-Ins (POD Farm 1 or GearBox) installed you can alternatively 
select the \Program Files\Line6 folder and SONAR will then find all VST Plug-Ins within this directory, 
and all its sub-directories.

Mono versus Stereo Plug-In Functionality 

SONAR is rather unique among DAWs in the way it offers mono versus stereo input & output audio 
routing through VST Plug-Ins inserted on its audio tracks. It is possible to configure POD Farm 2 
and Elements Plug-Ins for the desired functionality by way of the SONAR audio track input and 
“Interleave” switch options. The following behaviors apply:

•	  Mono audio track input - When you set a SONAR audio track record from a mono sound card 
input, this records a mono audio file in the track. When you insert a POD Farm 2 or Elements 
Plug-In on such a track, it will automatically detect this as a mono track and insert a mono input 
- mono output instance of the plug-in. This means that even if you’ve utilized any  stereo-capable 
effect models within the Plug-In (e.g. - Stereo Delay, Stereo Expo Chorus, etc.), the output of 
these effects will be “folded-down” to mono at the final output of the Plug-In. This is true even 
if your  audio track’s output is set to a stereo Master, Bus, or sound card output.

•	 To achieve stereo output from plug-ins inserted on a mono input audio track, you can toggle 
the SONAR track’s “Interleave” switch to “Stereo”.  This still allows you to record a mono 
audio file into the track, but it switches the inserted plug-ins to stereo, allowing stereo-
capable effects to be heard with stereo output (provided the audio track is set to a stereo 
output). Please see the SONAR documentation for more info on the Interleave mono/
stereo switch.

•	 Stereo audio track input - When you set a SONAR audio track record from a stereo sound card 
input, this records a stereo audio file in the track. When you insert a POD Farm 2 or Elements 
Plug-In on such a track, it will automatically detect this as a stereo track and insert a stereo input 
- stereo output instance of the plug-in. The result here, as you might expect, is that all stereo-
cable effect models in the plug-in process the audio and output in the full, glorious stereo sound 
(provided the audio track is set to a stereo output).

External MIDI Control of POD Farm 2 Plug-In in SONAR

SONAR offers the ability to access the knobs, sliders & switches of any inserted VST Plug-In remotely, 
via a hardware MIDI controller device, provided the VST Plug-In supports this ability. And POD 
Farm 2 Plug-In does indeed support MIDI Control to allow you to take full advantage of these MIDI  
features! It is recommended that you first get familiar with the POD Farm 2 MIDI Control features and 
configuration covered in the POD Farm 2 Basic User Guide, and in the Plug-In chapter on page 3•7.

Cakewalk SONAR MIDI Configuration

Cakewalk SONAR is slightly different than most DAWs in that it requires that you designate an 
Audio VST Plug-In as a “VSTi” (software instrument) plug-in before it can receive MIDI input. To 
follow are the steps to configure POD Farm 2 VST Plug-In this way in SONAR (we’re using SONAR  
Professional version 8, but the steps are similar in most recent SONAR versions):

•	 Connect your external MIDI controller device to your computer, and then launch SONAR.

•	 If you did not already do so after installing POD Farm 2, go to the SONAR Options > Global > 
VST Plug-Ins dialog and add your POD Farm 2 VST folder to the list of directories so that the 
VST Plug-In scan will find it and make it available in your projects. 
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•	  Go to the SONAR Options > MIDI Devices dialog, and select your MIDI Controller device 
as a MIDI Input to allow SONAR to receive MIDI Control commands. We’ll select our Line 
6 KB37 so that we can use its knobs, footswitch and pedal controllers to control POD Farm 2 
Plug-In parameters.

•	 Go to the SONAR Tools > Cakewalk Plug-In Manager and select the following options:

Select VST Audio Effects

Select POD Farm 2

Then click the Plug-in 
properties button

•	 Now, in the Plug-In Properties dialog, check the box for Configure as Synth. This re-classifies 
POD Farm 2 Plug-In as a “VSTi” instrument Plug-In, which allows it receive MIDI input within 
SONAR.

The VST Plug-In Properties dialog - selecting to configure a VST as a VSTi
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IMPORTANT: Once you set the above “configure as synth” option, the POD Farm 2 Plug-In will then 
only appear within the SONAR Soft-Synths sub-menu rather than the Audio FX sub-menu. POD Farm 2 
Plug-In will still function the same for audio, but will have the added ability to receive MIDI input.

•	 Insert POD Farm 2 Plug-In on one of your audio tracks. Right click in the track’s FX Bin and 
select the POD Farm 2 Plug-In from the Soft-Synths sub-menu.

•	 Create a new MIDI track in your SONAR project and select the following track Input and 
Output settings.

Insert POD Farm 2 “VSTi” Plug-In on your audio 
track

In a MIDI track, set the Input to your  MIDI 
Control device port. Choose “Omni” to receive 
from all the port’s MIDI channels

Select the POD Farm 2 Plug-In as the track 
Output

Set the MIDI Out Channel to any channel 
(POD Farm 2 will receive on any, but you must 
choose one here)

SONAR track settings

This completes the configuration. You should now be able to access the “pre-configured” MIDI control 
assignments within POD Farm 2 Tone Presets, or utilize the POD Farm 2 MIDI Learn feature to “map” 
your controller to POD Farm 2 parameters (see “External MIDI Control with POD Farm 2 Plug-In” on 
page 3•7). Please also see your SONAR documentation for more about its MIDI control features.

Plug-In Parameter Automation in SONAR

SONAR offers several features for “writing” and editing VST plug-in parameter automation, and POD 
Farm 2 and POD Farm Elements Plug-Ins all allow you to take full advantage of them! Please first refer 
to “Parameter Automation with POD Farm 2 & Elements Plug-Ins” on page 3•10 for more about these 
features and settings within the Line 6 Plug-Ins. To follow we’ve provided some specifics for accessing 
the Plug-In parameters for automation within SONAR.

Note that to access POD Farm 2 Plug-In model parameters, you must first assign each desired parameter 
to one of the POD Farm 2 “Knob” or “Switch” Automation Slots - please see page 3•12.

For our example, we’ve inserted POD Farm 2 Plug-In on our Audio 1 SONAR track, and assigned the 
POD Farm 2 Delay model’s “Mix” knob to the “Knob 1” Automation Slot. This will allow us to select 
the POD Farm 2 “Knob 1” parameter for automation in SONAR, and control the Delay’s Wet/Dry 
Mix over time!
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Right click on the clip in your audio track and choose Envelopes > Create Track Envelope > 
POD Farm 2-1. This launches a dialog showing all automatable parameters for the inserted POD 
Farm 2 Plug-In.

In the dialog you can check as many of the POD 
Farm 2 “Knob,” “Switch” or “Fixed” parameters 
as you like - an individual track envelope will 
be displayed across the track for each parameter. 
We’ll select the POD Farm 2 Plug-In’s Knob 1, 
since this is the Automation Slot where we’ve 
assigned the Delay Wet/Dry parameter. Click OK 
when done.

Manually Editing SONAR Automation Envelopes

With your Plug-In parameter displayed in the automation lane, you can now manually click on the 
envelope line on the lane to add “node” points and adjust the parameter over time, as we’ve done here 
for POD Farm 2 Plug-In “Knob 1” parameter.

To allow the envelope to 
be edited & utilized during 
playback, set the track’s 
automation “Read” button 
on

“Node” points have been added manually to the envelope, 
allowing the parameter to be adjusted over time
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Now when you play back your SONAR session, you’ll see (and hear) your POD Farm 2 Delay’s Mix 
knob move in response to your Parameter 1 Envelope edits!

Using the SONAR Automation Write Modes

Note that to access POD Farm 2 Plug-In model parameters, you must first assign each desired parameter 
to one of the POD Farm 2 “Knob” or “Switch” Automation Slots - please see page 3•12.

Automation can also be “written” by setting the Plug-In window’s automation “Write” feature on, and 
then accessing the desired parameter’s control directly within the Plug-In edit panel. In the following 
example, we’ve assigned the POD Farm 2 Plug-In, Wah - Pedal Position parameter to the “Knob 1” 
Automation Slot and activated the Plug-In Write mode. With these settings made, once SONAR 
playback is started, the POD Farm 2 Plug-In Wah Pedal Position knob can be manipulated during 
playback (either by using the mouse directly in the Wah panel, or via external MIDI control) and the 
Wah “performance” is captured by SONAR. 

Enable the “Write” 
button within the POD 
Farm 2 Plug-In window.

Start SONAR playback

“Node” points are writ-
ten automatically on the 
“Knob 1” Track Enve-
lope, in response to ad-
justments made with the 
plug-in’s Wah Position 
knob during playback

Now when you play back your SONAR session, you’ll see (and hear!) your POD Farm 2 Wah Position 
knob move in response to the Knob 1 automation. You can also use the above steps to write and edit 
parameter automation for any of the POD Farm Elements Plug-Ins. For more info about parameter 
automation, please see your SONAR documentation.
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Digidesign Pro Tools® LE 8 Setup 
Digidesign has designed Pro Tools® software so it can only be used with a Digidesign or M-Audio® 

audio interface. You cannot use your Line 6 hardware as the primary audio interface for a Pro Tools 
system. But you can still utilize the RTAS® POD Farm™ 2 & POD Farm™ Elements Plug-Ins in 
any Pro Tools setup! Additionally you can also connect the outputs of your Line 6 audio device to a 
Digidesign (or M-Audio) interface’s inputs to record your processed POD Farm™ 2 or POD® processed 
tones directly into Pro Tools. UX2, UX8, KB37, POD® X3 and POD®xt Pro even let you do this with 
a direct, digital connection.

For this document, we’ll be showing how to connect to the Digidesign Mbox® 2 unit with Pro Tools LE 
8. These steps are similar for connecting to the Digi 002® or other Digidesign and M-Audio hardware 
as well. There are two methods described here – Recording from a Line 6 USB device’s analog outputs 
or from its digital S/PDIF outputs.

Note: If you want to record a “dry”, unprocessed input signal into Pro Tools and use POD Farm 2 & 
Elements Plug-Ins on the Pro Tools audio track, then you can simply plug your instrument or Mic directly 
into your Digidesign/M-Audio hardware and monitor your input signal through the Pro Tools software. 
More about using POD Farm 2 & Elements Plug-Ins later in this chapter.

Recording from your Line 6 Hardware’s Analog Outputs 

In this setup example, we’ll show how to connect a Line 6 (POD Studio™ or TonePort™) UX2 to a 
Digidesign Mbox 2 unit, and then use POD Farm 2 in standalone operation to dial in Tones and choose 
what type of signal to feed into the Pro Tools audio track (Processed or Dry). This allows us to take 
advantage of the POD Farm 2 ToneDirect Monitoring™ feature for super low latency. These steps are 
much the same for any Line 6 POD Studio™, TonePort™ or GuitarPort™ device with an Mbox 2. 

If you are using a POD X3 or PODxt device it is not necessary to connect your POD to a computer 
via USB at all for this type of analog connection since Tones can be by called up & edited, and output 
levels configured completely on your POD device! (If you are to be using POD Farm 2 Plug-In, you 
will need your Line 6 hardware connected to the USB port for POD Farm Plug-In to be authorized to 
run on the computer.)

Be sure to connect the USB cable from UX2 into your computer’s USB port, and then proceed with 
the following steps.

Connect the Analog Outputs* from your Line 6 hardware to the Digidesign Mbox 2:

Using two ¼” to ¼” shielded TS or 
TRS audio cables, plug each into the 
Analog Outs of your device

Connect a USB cable to your  
device & computer’s USB port
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*Note: If you are using a GuitarPort device, the Analog Outs are the RCA style jacks labelled “L” and 
“R”. If using a UX8, you should connect to the “Out 1” and “Out 2” jacks on the back.

Plug the other end of the Left audio cable into the Mbox Input 1 input, and the right audio cable into 
the Mbox Source 2 input.

From your Line 6 device’s Left Analog Out 
(or “Out 1”), connect to the Mbox 2 Input 
1 - Line input

From your Line 6 device’s Right Analog 
Out (or “Out 2”), connect to the Mbox 2 
Input 2 - Line input

Connect a USB cable to your 
Mbox 2 & computer’s USB port

Use the Mbox 2 Mon Outputs to hear playback of all Pro Tools LE audio. The Line 6 Hardware output 
audio will be mixed with the Pro Tools LE audio as well. Therefore, if you are using headphones, you’ll 
want to plug them into the Mbox 2 headphone jack to hear everything:

From the Mbox Mon Out jacks, connect to the 
Left and Right inputs for your powered speakers 
or monitoring system

If you want to use headphones for 
monitoring, plug them in to the 
Mbox 2 Headphone Out

POD Farm 2 Standalone Operation

Launch POD Farm 2 in standalone operation, connect your guitar, Mic or other instrument to your 
Line 6 device, and then dial in the POD Farm 2 Tone you want recorded in Pro Tools. Note that since 
you’ll be recording the signal from the Analog Outputs of your Line 6 hardware, the Output knob on 
your POD Studio/TonePort/GuitarPort will affect the level fed into Pro Tools. Additionally, the  POD 
Farm 2 Mixer’s Tone A & B controls, as well as the Master Output knob will affect your output signal 
(the POD Farm 2 Mixer Record Send controls will not affect your signal in this scenario).
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Use the Master Output knob and the Mixer View Tone A & Tone B 
Mixer controls to adjust the signal fed to Pro Tools for recording

The POD Farm 2 Standalone Application Mixer View

Please also see the “Mixer View” on page 4•1 for details on specific controls.

 

POD X3 & PODxt Devices

If you are using POD X3, you’ll want to check out the POD X3 Output screen options in your POD X3 
Pilot’s Handbook - In particular, the Reference: Configuration & Setup chapter covers the options 
for choosing your inputs (Mic, Line, Instrument, or multiple input sources) as well as things such as 
a Tone Blend versus Tone Pair tone setting, panning tones and effects, etc. Basically, this is the point 
where you’ll want to have your instrument or mic plugged into POD X3 and have your Tone sounding 
the way you want it to be recorded from X3’s 1/4 inch Analog Outputs. You’ll also want to be sure the 
panning and levels of the Tones and effects feeding to the POD X3 Left and Right analog outs are the 
way you want each to be recorded into your Pro Tools track(s).

If you are using PODxt, you’ll want to select the Studio Direct Mode within PODxt’s Output Mode 
screen since you’ll be feeding the signal from your Analog Outputs into the Pro Tools hardware. See 
your PODxt Pilot’s Handbook  for information about these output settings.

Create a New Pro Tools LE Session

Once you have your Line 6 hardware and/or POD Farm 2 configured, then the next step is to launch 
Pro Tools LE and set up a Session for recording.

To start a new Session in Pro Tools LE, 
choose New Session from the File menu

http://www.line6.com/support/manuals/
http://www.line6.com/support/manuals/
http://www.line6.com/support/manuals/
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You can choose to create a new session 
from a template, or a blank one

Choose the Sample Rate - 44.1 kHz is 
generally a good rate, unless you have 
specific needs for your project

Audio File Type - BWF (.WAV) is a 
good choice here since this file type is 
compatible with both Mac® and Win-
dows®

Bit Depth - 24 Bit is the higher fidelity 
choice here

Click OK when done, and then type 
in a name for the new Session when 
prompted

Create and Configure a New Audio Track

Next create at least one new audio track in the session to record into. You can of course also create 
more audio tracks if you want to import existing audio files into this session.

In the Track menu, select New

Choose how many
Tracks to create 

Choose Mono or Stereo* for 
your audio track format

Choose Audio Track for 
the Track type

Choose Samples 

...Then click Create 

*You’ll need to decide before creating each recording track, if you want to record the output from your 
Line 6 hardware as Mono or Stereo. Mono, of course, only records from one of your Line 6 device’s 
(Left or Right) output channels. You can choose which output channel once the track is created. If 
you have stereo effects active on your POD Farm 2 or POD tone, then you’ll probably want to choose 
Stereo to record both channels. 
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On the new audio track, click on the Input & Output 
Selectors and choose the Mbox Interface In 1-2 (Stereo) 
and Out 1-2 (Stereo) options, respectively.

At the top left of the Edit Window, click the 
View selector and enable the I/O display for 
your tracks

Or, if you created a mono audio track, you’ll have the option for the track input to choose either In 1 
(Mono) to capture the LEFT signal, or In 2 (Mono) to capture the RIGHT signal.

Click the audio track’s Record Enable 
button to arm the audio track for recording 

The track meters will now measure the 
Line 6 Device’s signal level 

Click the M button to mute 
the track while recording*

*Muting the track during recording disables the Pro Tools LE software monitoring feature, which 
allows your Line 6 hardware analog signal to be monitored with the lowest latency possible. Adjust the 
Mbox MIX knob to balance the Pro Tools session audio playback with the input audio (see your Mbox 
documentation for details). Once you are done recording, un-mute the track so you can hear playback.

Note to Digi 002 users: When using the Digi 002 hardware with Pro Tools LE, an additional Low Latency 
Monitoring option is available within Pro Tools LE Operations menu. You can alternatively keep your 
track un-muted and activate this option to hear your input monitoring signal when recording (see your Digi 
002/Pro Tools LE documentation for more on this feature).

Set your Recording Levels - As shown above, once your audio track is armed, you can use the track’s  
meters to gauge your recording levels. In addition to using your POD Farm 2 Mixer and Line 6 hardware 
controls, the Mbox unit includes level knobs for Inputs 1 & 2 to adjust the recording levels. The best 
practice is to set all of these controls to roughly half way to start, and then adjust each of them slightly 
to achieve the optimum level. You want to avoid setting any one control very high or very low to avoid 
excess noise or degrading the signal quality. 
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Be sure the input switches are set so that the green 
Mic light is illuminated for both Inputs 1 & 2 
(since we’re plugging into these Mic/Line inputs) 

Use the Input 1 & 2 knobs to adjust 
the recording levels

Keep both the Mono and 48V 
(phantom power) switches off 

Start Recording

Click the transport Record button to place Pro Tools LE into record 
mode, then press the Play button to start recording! 

Recording from Your Line 6 Hardware’s S/PDIF Outputs

POD Studio/TonePort UX2, UX8, POD X3 and PODxt Live units all include S/PDIF outputs, therefore 
you can optionally connect these outputs to your Digidesign hardware to record digitally into Pro Tools 
or Pro Tools LE! In this setup example, we’ll show how to connect a Line 6 UX2 to a Digidesign Mbox 
2 unit, and we’ll call out where different steps might be necessary for the other Line 6 devices. 

For more information regarding using your Line 6 device’s S/PDIF connections, please also see “S/PDIF 
Digital Output from Line 6 Hardware to an External Device” on page 2•33 . The Pilot’s Handbook that 
comes with POD X3 & PODxt devices includes more useful information as well. 
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Connect Your Hardware

Using a 75-Ohm, coaxial S/PDIF cable, plug 
one end into the S/PDIF Digital Out of 
your Line 6 device

Plug the other end of the S/PDIF 
cable into the Mbox S/PDIF In 

From the Mbox Mon Out jacks, connect 
to the Left and Right inputs for your 
powered speakers or monitoring system

If you want to use headphones for 
monitoring, plug them in to the 
Mbox 2 Headphone Out 

You will still use the Mbox Mon Out jacks (or Headphone Output) to hear playback of all Pro Tools LE 
audio. The Line 6 Hardware audio will be mixed with the Pro Tools LE audio if you use the Pro Tools 
software monitoring function. See the later section regarding monitoring for more on this.

UX2, UX8 & KB37 Configuration

When connecting two hardware devices digitally, it is necessary that both units are set to operate at the 
same sample rate. For POD Studio and TonePort devices, this is configured in the Line 6 Audio-MIDI 
Devices dialog. Note that you will need to have your Line 6 device connected to your computer’s USB 
port, but you must not have the POD Farm 2 standalone application running - this is necessary to 
change the device’s sample rate settings. 
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On Windows® XP: To get to this dialog, go to the Windows® Control Panel and launch the Line 6 
Audio-MIDI Devices. In the dialog, go to the Driver tab:

Choose your connected Line 6 
Device

Set the preferred  sample rate 
for the Format. Mbox 2 supports 
44100 or 48000 Hz - we’ll use 
44100 Hz for this example 

Choose 24 bit

Check the box so that the settings 
are locked 

Click OK when done

On Windows® 7 & Windows Vista®: Go to the Windows® Control Panel and launch the Sound 
utility. In the dialog, go to the Playback tab:

Select your Line 6 audio device, then click the 
Properties button

In the Advanced tab, set the preferred  bit & 
sample rate. Mbox 2 supports 16 or 24 bit and 
44100 or 48000 Hz - we’ll use 24 bit, 44100 Hz 
for this example 

Click OK to exit both dialogs when done
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POD X3 S/PDIF Configuration

Connect the S/PDIF Out on the 
rear panel of your POD X3 device 
to the S/PDIF Input on the Mbox

POD X3 POD X3 Pro

POD X3 Live

The S/PDIF Out sends out 24-bit digital versions of the Left & Right Outputs. Press the OUTPUTS 
button on POD X3 to access additional S/PDIF options:

For S/PDIF, you likely want 
the MATCH STUDIO/
DIRECT option* 

For the S/P SR options, set 
the sample rate to the same 
as your Pro Tools Session 
(44.1 kHz is a good option) 

Use the S/PLVL if you need 
to slightly raise or lower 
the outgoing S/PDIF signal 
level for optimum recording 
levels

*This S/PDIF setting defines what type of audio is sent out the S/PDIF Out. These options are:

•	 Match Studio/Direct – S/PDIF outputs the Tone and Pan settings as shown.

•	 Studio/Direct Tone 1 – S/PDIF outputs Tone 1 only, panned center.

•	 Studio/Direct Tone 2 – S/PDIF outputs Tone 2 only, panned center.

•	 Dry Inputs – S/PDIF Left outputs the unprocessed input(s) to Tone 1, and S/PDIF right outputs 
the unprocessed input(s) to Tone 2.
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PODxt Pro - Digital Output Configuration

Connect the S/PDIF Out on 
the rear panel of your device to 
the S/PDIF Input on the Mbox

Press the Tune/System button and turn the Select knob clockwise until the display reads, What are 
you connecting to?

Set the DIGOUT option to 
SPDIF

Set the DEST option to 
STUDIO DIRECT 

Press the I/O & Dig Select button once to access the Digital Out page:

For the FORMAT options, set 
the sample rate to the same as 
your Pro Tools Session (44.1 
kHz is a good option) and 24 
BIT

Set the MODE to NORMAL 
for  your fully processed tone 
to be sent out the S/PDIF 
connection (or to DRYGTR for 
an unprocessed signal) 

Use the GAIN if you need 
to slightly raise or lower 
the S/PDIF signal level for 
optimum recording levels

Configure Mbox 2/Pro Tools LE for Digital Recording

Now, launch the Pro Tools LE application and set it up to receive the S/PDIF Digital Input as 
follows:

From the Pro Tools LE Setup menu, 
select Hardware
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Choose S/PDIF as the 
Clock Source so that 
the Mbox 2 follows 
the digital clock of 
your Line 6 hardware

The Sample Rate 
option here is 
determined by the 
Session setting (next 
step)
Click OK when done

You will now see the S/PDIF light solidly 
illuminated on the front of the Mbox 2, 
indicating it is in S/PDIF digital input mode

Note that when receiving S/PDIF input, the Input 1 & 2 level knobs on the front of the Mbox 2 do not 
adjust the digital signal level. To adjust the recording level, use the POD Farm 2 software’s Tone volume 
and output level controls, or your PODxt or POD X3 S/PDIF Gain controls.

Creating a New Pro Tools LE Session

Once you have your Line 6 hardware and POD Farm 2 standalone application configured (if using 
POD Studio/TonePort hardware), then the next step is to launch Pro Tools LE and set up a Session 
for recording.

To start a new Session in Pro Tools LE, 
choose New Session from the File menu
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You can choose to create a new session 
from a template, or a blank one

Choose the Sample Rate - 44.1 kHz is gen-
erally a good rate, unless you have specific 
needs for your project*

Audio File Type - BWF (.WAV) is a good 
choice here since this file type is compat-
ible with both Mac® and Windows®

Bit Depth - 24 Bit is the higher fidelity 
choice here

Click OK when done, and then type in a 
name for the new Session when prompted

*Note: If you prefer to use the 48 kHz Sample Rate, then you can choose these here in the Pro Tools 
dialog, but you will need to also go back to the Windows® Line 6 Audio-MIDI Devices dialog (or to your 
POD X3 or PODxt S/PDIF settings) and set the sample rate value for your Line 6 hardware to match. 
Matching sample rates is required on both hardware units when using a digital connection.

Create and Configure a New Audio Track

Next you’ll need to create at least one new audio track in the session to record into. You can, of course, 
also create more audio tracks if you want to import existing audio files into this session.

In the Track menu, select New

Choose how many
Tracks to create 

Choose Mono or Stereo* for 
your audio track format

Choose Audio Track for 
the Track type

Choose Samples 

...Then click Create 

*You’ll need to decide before creating your recording track here if you want to record the output from 
your Line 6 hardware as Mono or Stereo. Mono, of course, only records from one of your Line 6 device’s 
(Left or Right) output channels, and you’ll choose which channel once the track is created. If you have 
stereo effects active in POD Farm 2 or on your POD device, then you’ll probably want to choose Stereo 
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to record both channels into a stereo track.

On the new audio track, click on the Input Selector and 
choose the Mbox input source. Since we created a Stereo 
track here, we’ll select the S/PDIF In L-R (Stereo)

At the top left of the Edit Window, click the 
View selector and enable the I/O View

Or, if you create a mono audio track, you’ll 
have the option for the track input to choose 
either S/PDIF L (Mono) to capture the LEFT 
signal, or S/PDIF R (Mono) to capture the 
RIGHT signal

Click the Record Ready 
button to Arm the track for 
recording 

Once armed, the track’s meters will measure 
the Line 6 device’s S/PDIF signal level 

Keep the track’s Mute button set 
to un-muted to monitor your Line 
6 device’s incoming signal*

*When receiving a S/PDIF input, the Mbox 2 will only allow the signal to be monitored through the Pro 
Tools LE software. With the audio track armed and not muted, the track’s volume control will adjust 
the monitor signal coming from your Line 6 hardware, allowing you to balance your listening levels 
independently of your recording level. The Pro Tools LE software monitoring is also subject to latency, 
which is affected by your Pro Tools LE Hardware Buffer settings (see your Mbox documentation for more 
information regarding latency and monitoring).

Note to Digi 002 users: When using the Digi 002 hardware with Pro Tools LE, an additional Low 
Latency Monitoring option is available in the Pro Tools LE Operations menu. It is best to activate this 
option to hear your input monitoring signal with the lowest latency when recording (see your Digi 
002/Pro Tools LE documentation for more about this feature).
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Adjusting the Pro Tools LE Hardware Buffers

Go to the Pro Tools LE Setup menu 
and choose Playback Engine 

The lower the H/W Buffer Size value that is selected, the lower the 
latency. However, lower values can also result in less stability for session 
playback and recording. 256 Samples is a good starting value to try.

TIP: Alternative Mbox monitoring option… If monitoring your Line 6 hardware recording signal through 
the Pro Tools LE software results in excessive latency, you can alternatively connect your device’s Analog 
Outs to an external Mixing Console and manually mix the device signal with the output of your Mbox. This 
allows you to hear the Line 6 device signal with no added latency from Pro Tools LE. In this configuration, 
you should Mute your Pro Tools LE track while recording to silence its software monitoring signal.

Start Recording…

Click the transport Record button to place Pro Tools LE into record 
mode, then press the Play button to start recording! 
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.Using the RTAS® POD Farm 2 Plug-Ins in Digidesign Pro Tools® LE

The POD Farm 2 & POD Farm Elements Plug-Ins support the Digidesign Real Time Audio Suite 
(RTAS) Plug-In format for Pro Tools and Pro Tools LE software. Once you have the POD Farm 2 
license activated for your Line 6 hardware or iLok, you are ready to jump right into a whole new level 
of Tone possibilities right within your Pro Tools session! To follow we’ve provided an overview for how 
to insert, configure and automate parameters using POD Farm 2 Plug-In in Pro Tools LE 8. There are, 
of course, some differences for using RTAS Plug-Ins on different Pro Tools software versions, so you 
should also consult your Digidesign documentation for more details.

Inserting the Plug-In

The most common way to apply an RTAS effect Plug-In within Pro Tools LE is to add it as an insert on 
the audio track. You can access the insert slots either directly on an audio track’s channel strip in the 
Mix window, or at the left of the track in the Edit window (you may need to enable the “Inserts A-E” 
module to be visible from the Track View Menu). 

Mix window Insert slot Edit window Insert slot

When you click on a track’s Insert Selector, you’ll find POD Farm 2 Plug-In selectable within the Other 
sub-menu. You will find the individual POD Farm Elements Plug-Ins within the other categorized 
effects sub-menus (e.g. -  the “POD Farm Dynamics” Elements Plug-In is found in the “Dynamics” sub-
menu). Note that the Plug-In options will be different if your track is a stereo or mono track.

On a stereo track, you’ll have 
the option for the POD Farm 2 
(stereo) Plug-In  
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On a mono track, you’ll have two options: 

If your track’s output is set to a mono 
Interface or Bus, then it is best to choose 
POD Farm 2 (mono) to retain a mono 
channel output signal

If your track’s output is set to a stereo 
Interface or Bus, then it is best to choose 
POD Farm 2 (mono/stereo) to feed to the 
stereo output 

To remove the inserted Plug-In, simply click on the Insert Selector where the Plug-In is loaded and 
choose No Insert from the menu. 

 
TIP: You might want SAVE your Tone settings within POD Farm 2 Plug-In as a Tone Preset before you 
remove it so you can recall the same settings again easily any time you load the Plug-In again!  

You can load as many instances of the POD Farm 2 & Elements Plug-Ins as you like in your session. 
Note that the number of Plug-In instances you insert in your session, will determine how much of your 
computer’s resources are utilized (RTAS Plug-Ins are powered by your computer’s CPU). Remember, 
you are not limited to just using the Line 6 Plug-Ins for guitar. Try using some of the Amps, Preamps 
or individual Effects models on any instrument or vocal track - there are no rules here! When you save 
your Pro Tools session, the loaded POD Farm 2 & Elements Plug-In instances, as well as all Plug-In 
settings, are all saved as part of the session.

Configuring POD Farm 2 Plug-In 

Once loaded as an Insert, the POD Farm 2 Plug-In Graphical User Interface (GUI) is automatically 
launched. Here you can choose from any of your saved POD Farm 2 Tone presets, or tweak the 
individual Amp, Cab, Mic and Effects settings as desired - please see the Plug-In chapter in the POD 
Farm Basic User Guide for details on all the POD Farm 2 GUI controls. 

You’ll see that the Plug-In GUI is contained within an RTAS Plug-In window, and at the top are some 
Pro Tools LE specific controls. These are the same controls for all RTAS Plug-Ins (including the POD 
Farm Elements Plug-Ins) and allow you to switch to other tracks, save session-related presets, and 
more. Please check your Pro Tools LE documentation for more on these controls. 
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Use the Bypass button to 
bypass the entire Plug-In

Master Input Knob & Meter - 
Set the Plug-In Input level here

Master Output Knob & Meter - 
Set the Plug-In Output level here

For POD Farm 2 Plug-In, you can additionally use the Tone A & Tone B controls within the POD 
Farm 2  Mixer View. It is important to watch your levels in and out of the Plug-In. If the audio recorded 
in the audio track is already rather high, then adding some POD Farm 2 Amp and Effects models 
(especially distortion and compressor effects) can raise the gain further, resulting in clipping. Use 
the Amp & Effects’ volume and gain controls moderately, and then use the Master Input and Output 
knobs and Mixer controls in POD Farm 2 Plug-In to keep the levels consistent. (See the POD Farm 
2 Basic User Guide for more on the Mixer View controls and optimizing POD Farm 2 Plug-In input 
levels.)

Monitoring with POD Farm 2 Plug-In

As described in the preceding Pro Tools LE recording setup sections, there are some specifics to 
configuring your audio track and Mbox 2 (or other Digidesign hardware) to monitor your input signal 
while recording. If you do not own one of the Line 6 USB audio devices, and running POD Farm 2 
Plug-In off of an iLok, you’ll want to use the Pro Tools Software Monitoring feature. If using POD Farm 
2 in standalone operation with a Line 6 USB device, or if using a POD device to hear your monitor 
signal, then you’ll want to use only the external monitoring setup. 

Pro Tools LE Software Monitoring

One practice is to plug your instrument or mic directly into your Mbox 2 and record its unprocessed 
signal into the audio track so that you can use a Plug-In on the track to then non-destructively add 
amp, cab and effects to it. For this setup you’ll need to load POD Farm 2 and/or Elements Plug-In on 
the audio track Insert, then arm the track and keep it un-muted so that you can adjust the Mbox 2 Mix 
knob to hear your input signal running through the audio track. 
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You can use any POD Farm 2/Elements Plug-In settings you like since they “non-destructively” 
affect the track monitoring and playback. This allows you to hear your input signal with your Plug-In 
processing applied, while the raw, unprocessed input signal gets recorded. 

The drawback with this setup is that it takes a fraction of a second for the input signal to pass through 
the Pro Tools software, through any insert Plug-Ins and then back out your speakers or headphones. 
This amount of delay is referred to as “latency” and what you hear all the computer recording geeks 
rant about on all the computer audio forums. You can minimize the latency by lowering your Pro Tools 
audio engine buffer size (see “Adjusting the Pro Tools LE Hardware Buffers” on page 5•49), but note that 
the lower the buffer setting, the greater the CPU demands that are placed on your computer. 

Using Line 6 Hardware for Monitoring Externally

If you own a Line 6 USB audio device, another option is to use an external hardware mixing console 
as follows to allow you to split the input of your instrument or Mic into two signals. Then plug one of 
these inputs into your Line 6 device, and the other input into your Digidesign interface:

•	 Plug your Instrument or Mic into a channel on your mixing console.

•	 From this mixer channel, route the signal out two of the mixer’s Sends so that you can then plug 
one into the Mic/Instrument input of your Line 6 hardware, and the other into the Mic/Line In 
of your Mbox 2 or other Digidesign hardware. 

•	 Connect the Analog Outs from your Line 6 hardware back into another channel of the mixing 
console and route the channel to your monitor system. This channel will monitor only the 
output of your Line 6 device. 

•	 Connect the Mon Outs from your Mbox 2 into its own stereo channel on the mixing console 
and route the channel to your monitor system. This channel will monitor the playback of your 
Pro Tools session.  

•	 Launch the POD Farm 2 standalone application and dial in whatever Tone you want for your 
monitoring signal, which you’ll be able to hear with nearly zero latency. (Or, if you are using a 
PODxt or POD X3, dial up your preferred Tone on it.)

•	 Configure your audio track in Pro Tools to record from the Digidesign hardware’s Mic/Line Input 
you are connected to and Arm the track for recording. You should keep the track Muted while 
recording since you do not want to hear the unprocessed signal coming into the track. 

•	 Once you are done recording, you can then un-mute the Pro Tools track and load POD Farm 2 
Plug-In as an insert on the track.  It is now up to you to either call up the same settings you used 
in the POD Farm 2 standalone application (or PODxt/POD X3) to monitor with, or tweak the 
Plug-In to achieve any tone you want for the track.  
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Using POD Farm 2 & Elements Plug-Ins with Aux Sends

Another method to using your Line 6 Plug-Ins in Pro Tools LE is to add one instance of a Plug-In as an 
Insert on a Pro Tools Aux track, and then route Sends from multiple audio tracks to the feed into the 
Aux track, so that  all the tracks can be processed with the same, single Plug-In. This can be very useful 
if you want to do something like use the same Analog Delay effect on several different tracks - it is a 
very inefficient use of CPU power to load several separate instances of POD Farm 2 or Elements Plug-
Ins as inserts on multiple audio tracks. The better practice is to load one Plug-In instance on an Aux 
track, and then route a Send. This is all accomplished in the Pro Tools LE Mix window, as shown here.

In this example, both Audio 
Track 1 and 2 each have a Send 
established, with the output 
set to Bus 7-8. This allows the 
playback signal of the tracks 
to be “tapped” and routed to a 
common destination track. 

Note that the Track Output is 
still set to the Mbox 2 Interface 
Out 1-2. 

The track slider still controls 
the playback level of the (non-
effected) Audio track that is 
routed to the main output. 

POD Farm 2 Plug-In is added as 
an Insert only on this stereo Aux 1 
track.

The Input for this Aux 1 track is 
set to Bus 7-8, therefore, the Send 
signals coming from Audio Tracks 1 
and 2 are fed into this Aux 1 track, 
and both effected by POD Farm 2 
Plug-In. 

Use the Aux 1 track’s volume slider 
to blend the POD Farm 2-processed 
signal with the (unprocessed) Audio 
Track 1 and 2 signals at the main 
Mbox 2 Out 1-2.

The Pro Tools LE Mix window - Two Audio Tracks routed to a Send, returning into Aux 1 
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Click on the Send 
assignment to launch 
the Send Controls 

The Pan and Level 
knobs allow you to 
independently control 
the Audio Track 1 pan 
position and volume  that 
are fed out to Bus 7-8 
(and thus, through POD 
Farm 2 Plug-In that is 
inserted on Aux 1) 

The Send Controls for Send A routed from Audio Track 1

It is also possible to add your POD Farm 2 or Elements Plug-Ins as insert effects on a Master track in 
your session, which can then effect all the audio tracks in the session! Pro Tools LE offers quite a few 
more signal routing options that allow you to get very creative with the mix of your session - please 
check your Digidesign documentation for details.

External MIDI Control of POD Farm 2 Plug-In in Pro Tools LE

Pro Tools software offers the ability to access the knobs, sliders & switches of any inserted RTAS Plug-
In remotely, via a hardware MIDI controller device, provided the RTAS Plug-In supports this ability. 
And POD Farm 2 Plug-In does indeed support MIDI Control to allow you to take full advantage of 
these MIDI  features! It is recommended that you first get familiar with the POD Farm 2 MIDI Control 
features and configuration covered in the POD Farm 2 Basic User Guide, as well as the MIDI Control 
items covered in the Plug-In chapter on page 3•7.

As described in the Plug-In chapter, Pro Tools, like most DAWs, requires that you configure a MIDI 
track to route your MIDI controller device’s MIDI commands into the inserted POD Farm 2 Plug-In. 
The first step is to make sure your MIDI controller device is connected to your computer, and accessible 
within Pro Tools. For example, our USB-connected Line 6 FBV Shortboard MkII is automatically 
detected by Pro Tools LE, and appears as an available MIDI device within a Pro Tools MIDI track’s 
Input menu. If you do not see your MIDI controller device available within your Pro Tools application,  
please see your Digidesign documentation for help on detecting MIDI hardware.
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To route MIDI to an instance of the POD Farm 2 Plug-in, insert POD Farm 2 Plug-In on one of your 
audio track’s effects Inserts. For our example, we’ve inserted the Plug-In on the Audio 1 track. 

POD Farm 2 Plug-In loaded as an 
Insert on the Audio 1 track

Next, create a new MIDI track in your project. The MIDI track’s Input & Output settings need to be 
configured so that the track receives MIDI communication from your external MIDI controller device, 
and feeds the MIDI to the specific POD Farm 2 Plug-In inserted on the Audio  track.

Click the MIDI track’s Input selector - choose Predefined and then the Port from your external 
MIDI controller device. We’re using a Line 6 FBV Shortboard MkII Controller, so we’ll receive 
its MIDI from the first “USB Audio Device” port, and choose “all channels” to receive from all 16 
MIDI channels on this port*

Click the MIDI track’s Output selector and choose the POD 
Farm 2 Plug-In. You can choose to send the MIDI output on 
any of the offered channels. This feeds your MIDI controller’s 
commands into POD Farm 2 Plug-In, allowing you to remotely 
control parameters in the Plug-In!

Pro Tools MIDI track options - routing MIDI to an inserted Plug-In

*Note: In the above example, we’re using Windows® XP, therefore the port naming for the Line 6 FBV 
Shortboard MkII device appears as “USB Audio Device”. On Windows® 7 & Windows Vista® , the FBV 
appears as “FBV Shortboard MkII.”  

This completes the configuration. You should now be able to access the “pre-configured” MIDI control 
assignments within POD Farm 2 Tone Presets, or utilize the POD Farm 2 MIDI Learn feature to “map” 
your controller to POD Farm 2 parameters (see “External MIDI Control with POD Farm 2 Plug-In” on 
page 3•7). Please see your Digidesign documentation for more about its MIDI control features.
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Plug-In Parameter Automation in Pro Tools LE

Pro Tools applications offer robust capabilities for “writing” and editing RTAS Plug-In parameter 
automation, and POD Farm 2 and POD Farm Elements Plug-Ins all allow you to take full advantage of 
Pro Tools automation! Please first refer to the information on configuring POD Farm 2 and Elements 
Plug-Ins  for  automation in “Parameter Automation with POD Farm 2 & Elements Plug-Ins” on page 
3•10. 

Parameter automation can be created in Pro Tools by manually shaping an envelope across the track, 
or by recording parameter moves in real-time. Here is an example on how to configure a Pro Tools LE 
track to automate the POD Farm 2 Analog Delay’s Mix parameter so that the amount of delay changes 
over time on the track.

Start by adding a stereo Audio track to your session and insert or record a stereo audio file. For this 
example, we’ll automate the POD Farm 2 Delay - Mix parameter, so we’ll first assign the Delay - Mix 
parameter to the POD Farm 2 “Knob 1” Automation Slot.* 

*To access POD Farm 2 Plug-In model parameters, you must first assign the desired parameter to one of 
the POD Farm 2 “Knob” or “Switch” Automation Slots - please see page 3•12.

With POD Farm 2 Plug-In loaded as an Insert on the Audio track, launch the Plug-In dialog and click 
on the top Auto button to launch the Plug-In Automation dialog. 

Select the desired Plug-In Parameters in the left pane and click 
the Add>> button to allow them to be automated on your trackClick the Auto button
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In the Pro Tools LE Plug-In Automation dialog, you’ll see all the automatable POD Farm 2 parameters 
listed in the left pane (the assignable 1 - 16 “Knob” & 1 - 16 “Switch” Automation Slots, plus “fixed”  
parameters - scroll down the list to see them all). For this example, we’ll select Knob 1 (to which our 
Delay-Mix parameter is assigned) and click the Add >> button and then click OK to enable this 
parameter for automation on the Audio track. You can add as many parameters as you like for the track 
and automate any of them, but for this example we’ll keep it simple. 

Once the parameter is added, configure the Audio track to display this “Knob 1” envelope in an 
Automation Lane.

Click on the arrow button to 
display the track’s Automation 
Lanes

Click the Lane View Selector 
and choose POD Farm 2 Plug-
In - Knob 1

With your Plug-In parameter displayed in the Automation Lane, you can now manually click on the 
envelope line on the lane to add “node” points and adjust the parameter over time, as we’ve done here:

“Node” points have been added manually to the envelope, 
allowing the parameter to be adjusted over time

To allow the automation be utilized during playback, set 
the track’s automation mode to “Read”

TIP: You can also use the Pro Tools Pencil tool to draw to draw in multiple-node “curves” for your 
automation envelope - see your Pro Tools documentation.

Now just play your session and you’ll hear the assigned POD Farm 2 Delay - Mix parameter respond to 
the envelope changes. If you view the POD Farm 2 Plug-In window, with the Delay effect’s Edit Panel 
in view, you’ll also see the Delay Mix knob move automatically during playback. You can use the above 
steps with any of the POD Farm Elements Plug-Ins to automate their parameters as well!
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Using the Pro Tools Automation Write Modes

Automation can also be “written” by setting the Pro Tools track to one of the automation “write” 
modes, and then accessing the desired parameter’s control directly within the plug-in edit panel. 

Note that to access POD Farm 2 Plug-In model parameters, you must first assign each desired parameter 
to one of the POD Farm 2 “Knob” or “Switch” Automation Slots - please see page 3•12.

In the following example, we’ve assigned the POD Farm 2 Plug-In, Wah - Pedal Position parameter 
to the “Knob 1” Automation Slot. Then we’ve set the Pro Tools Audio track’s automation mode to 
“Touch”. With these settings made, once Pro Tools playback is started, the POD Farm 2 Plug-In Wah 
Pedal Position knob can be manipulated during playback (either by using the mouse directly in the 
Plug-In - Wah panel, or via external MIDI control) and the Wah “performance” is captured by Pro 
Tools via the Nodes added to the Knob 1 envelope. 

To write automation, set the track’s 
automation option to one of the “write” 
settings (Touch, Latch or Write). 

Adjust the Plug-In’s Wah Position knob 
during playback

“Node” points have been written automatically, in response to adjustments 
made with the plug-in’s Wah Position knob during playback

Set the track’s Automation Mode to read if you are done writing automation on the track. Now when 
you rewind and play the track back, you’ll see the POD Farm 2 Wah knob move automatically in 
response to the automation, and you’ll hear your Wah pedal performance! You can, of course, manually 
click and drag the individual envelope node points to further fine-tune things if you like.

You can also use the above steps to write and edit parameter automation for any of the POD Farm 
Elements Plug-Ins.  For more info about parameter automation, please see your Pro Tools documentation.



Propellerhead Reason 4 - Windows

6•55

Propellerhead Reason® 4 Setup
Propellerhead Reason® is an amazing virtual studio filled with synthesizers, drums and effects, all 
combined with a MIDI sequencer for easy pattern-based music creation. Reason does not offer a feature 
for recording audio, therefore, POD Farm™ 2 and Line 6 USB audio devices cannot be used for input 
directly into Reason.* However, you do, of course, need a sound card device for playback, and your 
POD Studio™, TonePort™, GuitarPort™, POD® X3 or POD®xt is the perfect high quality audio 
interface for this task! 

 *If you are a Reason user looking to add audio recording ability, then the recently released Propellerhead 
Record application might be just the thing for you. It is designed to work with Line 6 USB audio devices 
and includes powerful POD Farm Tones built right in! Please visit the Propellerhead Site.

When using your Line 6 device, you can also simultaneously plug in your instrument and jam along 
with the playback of your Reason project. Or, utilize the Reason ReWire® technology to combine a 
Reason project with that of another ReWire capable DAW host application, and use your Line 6 device 
and POD Farm 2 & POD Farm Elements Plug-Ins with your DAW host software!  For this document, 
we’ll be showing how to set up a Line 6 USB audio device with Propellerhead Reason version 4.0.3 - 
Setup is similar with other recent Reason versions. 

Configure Your Windows® PC to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Windows® Control Panel and select 
the Line 6 Audio-MIDI Devices to access the Audio Driver settings. Please see “Windows® Driver 
Settings” on page 2•19 for details on settings for your specific Line 6 hardware. 

Configuring Reason to Use the Line 6 ASIO® Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps.

Launch the Reason’s Preferences dialog:

Select Preferences from the Reason menu

http://www.propellerheads.se/products/record/
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Select the Audio page

For Audio Output, choose the “ASIO” 
driver for your Line 6 device

Choose a Sample Rate – 44100 is a 
good choice for most projects, or you 
can choose 4800, 88200, or 96000 
if your project requires one of these 
specific sample rates

Since we’re using the ASIO driver, the 
Buffer Size is adjusted in the Line 6 
Audio-MIDI Devices dialog - click the 
Control Panel button to launch it

Close the Preferences dialog when done 

Now just hit the Play button in Reason’s transport and to hear 
the Reason playback through your Line 6 hardware!

To Jam Along with Reason…

You can also still use POD Farm 2 in standalone operation, or configure your POD X3/PODxt  for 
your Mic and Instrument Tones, to sing or jam along while Reason is playing. Just plug in your Mic 
or Instrument and use POD Farm 2 in standalone operation or your POD just as you normally do. 
Note that you can adjust the level of your Mic or Instrument independently of the level of the Reason 
playback. 

Use the Master Output knob and the POD Farm 2 Mixer View Tone A & Tone B Mixer 
controls to adjust your POD Farm 2 volume independently of your Reason playback volume
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Use the Master slider in the Reason Mixer to 
control Reason’s playback volume

If you are using POD X3, use the Tone Volume and Master Volume to balance out your Mic/
Instrument volume versus the Reason playback:

The Tone Volume knob affects only your Mic/
Instrument Tone  level

The Master Volume knob controls the combined Mic/
Instrument + Reason output sent to your speakers or 
headphones

If you are using PODxt, use the Channel Volume knob to balance out your Instrument volume 
versus the Reason playback:

The Channel Volume knob affects only your 
Instrument Tone  level

With this configuration, both the Reason project playback and your Mic/Instrument Tones are sent 
to your device’s outputs, and heard through your speakers. This also allows you to connect the Line 6 
hardware’s outputs to an external device, such as a tape recorder, mixer, P.A. system, etc., to record or 
amplify this stereo output signal!

Using your Line 6 Hardware with Reason in a ReWire Setup

The Propellerhead ReWire® technology allows the Reason modules’ outputs to be directly routed 
into any ReWire “Host” DAW application. Using ReWire, the Host application can send MIDI track 
output to Reason’s synth modules, and Reason then feeds audio playback directly into the ReWire 
Host, which is mixed with the audio of the Host application. When Reason is configured as a ReWire 
“Slave” in this manner, it is controlled by the Host application and does not utilize an audio driver 
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connection itself. Therefore, if you want to use your Line 6 hardware as your sound card device in a 
ReWire setup like this, it is necessary for you to choose your device as the assigned audio device within 
the ReWire Host application. To read more about the ReWire technology and the latest about ReWire 
Host support, please visit the Propellerheads web site. 

Using Reason with Ableton Live as a ReWire Host

The Ableton Live® DAW software is capable of functioning as a ReWire Host application. The 
following steps show you how to set POD Studio as the audio device for the Ableton Live software, 
and then configure Live to connect with Reason 4 as a ReWire Slave device. This enables you to do 
audio recording and playback within Ableton Live, allowing Reason’s output(s) to be automatically 
played in sync and channeled through Live’s audio tracks via ReWire. The setup process is similar in 
other ReWire Host applications as well (Steinberg Cubase®, Cakewalk SONAR®, etc.) and you can 
certainly use your Line 6 hardware with these other ReWire Host applications with Reason as well!

 Some Line 6 POD Studio and TonePort packages come with a special Ableton Live Lite, Line 6 version 
software included. This Live version also supports Propellerheads ReWire technology! Configuring the 
Live Lite Line 6 version is much the same as the following steps for the Ableton Live version.

You first want to be sure to exit Reason if it is currently running. The ReWire Host application must 
always be launched first. Launch Ableton Live and make the following settings to set your Line 6 
hardware as the Live audio device.

Launch the Ableton Live Preferences dialog:

Go to the Live Options 
menu and choose 
Preferences

Just as with most DAW software, in Live you also need 
to configure the individual inputs and outputs once a 
Multi-in/out device is selected. Click on the Input Config 
button to access the Inputs

Go to the Audio tab

Choose ASIO as the driver type

Then choose your Line 6 device for the 
Audio Device. In this example, we’ll 
choose our connected UX2

Since we’re using the ASIO driver, the 
Buffer Size is actually adjusted in the 
Line 6 Audio-MIDI Settings dialog 
- click the Hardware Setup button to 
launch it

Set a Sample Rate – 44, 100 is a good 
choice here, or you can use 48,000, 
88,200 or 96,000 Hz if your Project 
requires a higher sample rate

http://www.propellerheads.se/
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Activate Inputs:

Here you can “activate” all the inputs from your 
Line 6 hardware that you want to be accessible 
for any audio track as a track input for recording

Click OK when done

You’ll want at least the 1 (mono) & 2 (mono) and the 1/2 (stereo) inputs activated. Each additional 
activated input utilizes more CPU, so only activate the ones you need!

Note that you’ll see a different number of inputs listed in the Input Config dialog depending on 
the specific Line 6 device you are using. Typically these enumerated inputs correspond to the Line 6 
device’s Sends of the same number (i.e. - Live’s input “1/2 (stereo)” is the UX2 Record Send 1-2). 

Activate Outputs:

To access the outputs, click the Output Config button back in the Live Preferences > Audio tab. This 
will show you all outputs available for your selected Line 6 Output Device. 

For all Line 6 devices (except UX8*), the ASIO driver offers Output 1/2, therefore the dialog will 
show its two mono and 1 stereo output options, and they will automatically be selected. 

*UX8: You’ll see 8 mono and 4 stereo outputs. For most Live projects, you likely only need to 
enable the Output 1/2 mono and stereo options and assign all track playback to one common 
output. UX8 does offer some very flexible monitoring and signal routing options using its additional 
outputs - Please see “Line 6 Audio-MIDI Devices - Inputs & Recording Tab (UX8 only)” on page 2•25, 
as well as your UX8 Pilot’s Handbook for more information.

Note : The Ableton Live Lite, Line 6 version has a restriction that allows only one stereo output to be used 
at a time. To be able to choose two or more different output devices in a Live Set, you must switch into 
Demo mode, or upgrade to a full version of Ableton Live

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Now that Ableton Live is configured to use your Line 6 device, launch Reason. Reason will automatically 
set itself to ReWire Mode. You can check this mode in the Reason Preferences: 

Select the Audio settings

When Reason is in ReWire mode, the Audio 
Output will be non-selectable and this message 
appears 

Now in Ableton Live, you can simply access the Output menu of any MIDI track to route its MIDI to 
any of the Reason synth modules.

In any of Live’s MIDI tracks, choose 
Reason as the MIDI To output

Then click on the Output Channel 
selector to choose any Reason module



Propellerhead Reason 4 - Windows

6•61

To receive the audio output from Reason, set the Input of any of Live’s audio tracks to receive the 
audio from any of Reason’s outputs.

In one of Live’s Audio tracks, choose 
Reason as the Audio From inputs

Then click on the Input Channel 
selector to choose any Reason output

(Note that the 1/2 Mix L, Mix R 
channel receives the full Reason project 
audio mix)

Now just hit the Play button in either Live or Reason, 
and both projects will play in sync, with all the audio 
being routed into Ableton Live and played through 
your Line 6 hardware!

You can utilize your Line 6 device and POD Farm 2 in standalone operation (or your POD X3/PODxt)
to also plug in a Mic or Instrument, dial in your tone, and record audio tracks right into the Ableton 
Live Set. This ReWire configuration is especially slick since the “ReWired” Reason audio can be 
treated as part of your Live Set - you can mix, add effects plug-ins (such as POD Farm 2 or POD 
Farm Elements Plug-Ins) on the incoming Reason ReWire audio track, and all will be incorporated 
into your audio mix-down when you do an Export from Live! It is important to note, however, that 
running all these programs at one time can require some hefty usage of your computers processor, RAM 
and disk access, especially as you add more tracks, Reason modules and real-time effects. Your actual 
performance will depend on the specifications of your computer. Also see the “Using the POD Farm 2  
VST or AU Plug-In” on page 3•4 .
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Steinberg Cubase® 5 Setup
For this chapter, we’ll show how to configure Steinberg Cubase® 5 to work with Line 6 POD Studio™, 
TonePort™, GuitarPort™, POD X3 or PODxt as the USB audio device, as well as optionally using 
POD Farm™ 2 Plug-In and/or POD Farm™ 2 in standalone operation on your Windows® computer.  
The steps are very similar for the setup of other recent Steinberg Cubase® Studio & Nuendo® versions. 
Steinberg’s Cubase® & Nuendo® 64-bit versions are also supported by your Line 6 hardware and POD 
Farm 2!

Choose Your Line 6 Gear Configuration

Before you record your first track in any DAW software, you have a few options to consider  with your 
Line 6 hardware & POD Farm 2 gear! You should decide if you want to record a “dry” signal into the 
audio track, such as if you want to utilize POD Farm 2 Plug-In to “non-destructively” apply your POD 
Farm 2 Tone onto the recorded track. Or, if you prefer to record a “processed” signal, where the POD 
Farm 2 Amp/Preamp and Effects are already applied and recorded permanently on the track. We’ll 
cover the steps to record either of these ways, but first it is helpful to understand the options with your 
particular Line 6 gear.

POD Studio, TonePort, GuitarPort devices 

•	 Using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into your 
device and launch POD Farm 2 in standalone operation. Use the Mixer View - Record Send 
Source options to choose the type of signal fed to your Record Sends. Also see “POD Farm™ 2 
Standalone Operation” on page 4•1 for more about the Mixer View. 

•	 Tone A, Tone B or Tone A+B - Feeds the same fully processed signal from the respective 
Tone path(s) that you hear out to the Record Send.

•	 Tone A (semi) - This option is available only when a single Tone A exists in POD Farm 2.  
It feeds only the signal processed with the Amp group of models (Amp/Cab/Mic/Preamp 
models) plus any effects inserted to the left of the Amp group within Tone A. Note that 
you’ll still hear the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ 
Monitoring output. (Useful, for example, if you want to hear a delay or reverb effect inserted 
after the Amp group, but do not want that delay effect recorded!)

•	 Dry Input - Feeds a completely unprocessed signal to the Record Send, even though you can 
listen to the fully Processed Tone from POD Farm 2 standalone’s ToneDirect™ Monitoring 
output. (This is a great option if you want to insert POD Farm 2 or Elements Plug-Ins on the 
recorded audio track in the DAW later!)

•	 Without using POD Farm 2 in standalone operation - Plug a Mic or Instrument directly into 
your device and configure the Line 6 Audio-MIDI Settings  dialog to feed your “dry” input source 
to your device’s Record Sends. See “Windows® Driver Settings” on page 2•19 for more about this. 
Note that when using this option, you won’t have the benefit of POD Farm 2 ToneDirect™ 
Monitoring when not running POD Farm 2 in standalone mode, so you’ll need to enable your 
DAW software’s monitoring feature on the audio track (more on this in the next section).

POD X3 devices - Plug a Mic or Instrument into your POD X3 and configure the options within 
X3’s onboard Outputs - Studio/Direct Mix settings screen to determine what type of signal is fed 
to the X3’s Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your POD X3 Pilot’s Handbook for 
details on X3’s Output screen options. 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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PODxt devices - Plug a Mic or Instrument directly into your PODxt device and configure the 
options within the Line 6 Audio-MIDI Settings dialog for the type of signal (Processed or Dry) that 
is fed to the Record Sends. You can also use the Monitor Volume slider in the Line 6 Audio-MIDI 
Settings dialog to control your Monitor level. Please refer to your PODxt Pilot’s Handbook for 
details about output options.

Monitoring through the DAW software - If you are using POD Studio/TonePort/GuitarPort hardware 
and not running POD Farm 2 in standalone operation, then you’ll need to use the DAW software’s own 
monitoring feature to hear your input signal routed through the DAW software’s audio track, as called 
out in the following steps. This also means you’ll hear the input signal effected with any Plug-Ins, such 
as if you have POD Farm 2 Plug-In inserted on the same audio track. You may need to set your DAW 
software’s buffer size fairly low to minimize the “latency” (the time between when you pluck a note 
on your guitar to the time you actually hear it after feeding through your DAW software and out your 
speakers). We’ll cover all these steps here.

Configure Your Windows® PC to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Windows® Control Panel and select the 
Line 6 Audio-MIDI Devices to access the Audio Driver settings. 

Go to the Driver tab

Set the ASIO® Buffer Size to 
256 as a good starting point*

Set the Bit Depth to 24 bit

 * If you are to be using POD Studio/TonePort/GuitarPort to record “dry” and using your DAW software’s 
Monitoring feature rather than running POD Farm 2 in standalone operation, you will likely need to set 
the ASIO Buffer as low as possible here to minimize latency. 

Please  see “Windows® Driver Settings” on page 2•19 for details on settings for your specific Line 6 
hardware. 

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Configuring Cubase to Use the Line 6 ASIO® Driver

Launch Cubase and Open the Device Setup Dialog:

Go to the Cubase Devices menu 
and choose Device Setup

First, we need to switch to the ASIO driver mode:

Click on VST Audio System 

Select the ASIO  
driver for your Line 6 
device 

Note you do NOT 
want the “ASIO 
Multimedia” driver, 
but the one with 
“ASIO” + the name of 
your device!*

Select Switch if you are 
prompted to “switch the ASIO 
driver?”

Then click OK to exit the 
Cubase Device Setup dialog

*It is possible to use the “ASIO Multimedia” driver mode, but using the Line 6 ASIO driver option is 
recommended since it offers the best performance and multiple input/output channels. For more about 
ASIO Buffer settings, please see “Windows® Driver Settings” on page 2•19.

Establish Your Inputs and Outputs:

Next we need to configure the Inputs and Outputs from the Line 6 hardware so they can be accessed 
within your Cubase Projects. This can get a bit fiddly in Cubase, but you only need to do this once for 
your audio device, so hang in there!
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Return the Cubase Devices menu 
and select VST Connections

Go to the Inputs tab

Initially, you’ll likely see that at least one Stereo In “Bus” has automatically been created for you 
using your  Line 6 device, and its Send 1 and 2 audio channels are each assigned as the Left and Right 
channels for this initial Bus. However, POD Studio, TonePort, GuitarPort and POD X3 devices offer 
more than just the one stereo Record Send 1-2. For these devices you’ll want to create an additional 
stereo Bus for each available stereo Send pair. Also, you’ll want to create mono Buses for each of the 
device’s individual Send audio channels to allow you to record from any one of them as a mono input 
to a Cubase audio track. In our example we’re using UX2, and just like GX, D.I., UX1, KB37 and 
GuitarPort devices, there is also a Send 3-4 available. UX8 offers 6 stereo Sends, and POD X3* offers 
4 stereo Sends. 

 *POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please see page 2•22, and your POD X3 Pilot’s Handbook.

You can follow these steps to add additional buses for all your device’s Sends.

Press the Add Bus button, create 1 Stereo Bus, then repeat and add 4 Mono 
Buses using the Add Input Bus dialog  



Steinberg Cubase 5 - Windows

6•66

Next, each of the desired device’s audio Send channels needs to be correctly assigned to each Cubase 
Bus. The Stereo In 2 Bus has likely already been correctly configured to use the Line 6 device’s next 
stereo Send (Send 3-4 for our UX2). But, typically the Mono In Buses all default to use “Send 1”, 
which is not what we want. Click directly on the Device Port field for each of the Mono Buses and 
select a different Send channel for each. For our UX2, we’ll configure one each to Send 1, 2, 3, & 4.

Click on the Device Port 
to choose the desired 
Line 6 device Send 
channel assignment - do 
this for each Mono Bus

The result should now look like this, 
with each Stereo In and Mono In Bus 
to its own specific Line 6 hardware 
Send 

(Make a mistake? No worries, you 
can right click or Ctrl+click on any 
Bus Name and “Remove” it and add 
another if needed)

Now to the Outputs tab... The procedure is the same here. You should see a Stereo Out Bus already 
created here for you and correctly assigned to your Line 6 device’s main Output 1 & 2 for its Left and 
Right channels. 
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This one Output Bus is fine as is for most Cubase Projects, since you’ll likely just assign all audio 
tracks to this one, common stereo output. But you can optionally create Mono Buses for each of these 
Outputs if you need them. Or, if you have a UX8, your device includes 4 Stereo outputs (8 Mono 
outputs) which means you can do the Add Bus thing here and create Stereo and Mono Buses utilizing 
all the additional Outputs if you like - even for a 5.1 Surround system if needed! 

UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and monitoring. 
Please see  “Line 6 Audio-MIDI Devices - Inputs & Recording Tab (UX8 only)” on page 2•25.

Create a Preset

Finally, its a good idea to save all these settings as a Preset. You can even create several different Bus 
scenarios for your Line 6 hardware and save each as a different Preset to recall them easily any time!

Click the little Add button 

Then type in a name for your Preset 
and click OK to finish it up

You can now exit the VST Connec-
tions dialog

 

TIP! Be sure to open the VST Connections window and select this Preset before you open or create a 
Cubase Project so that it will use these settings! It’s also pretty handy to create a Project Template with a 
Cubase Project so that you don’t need to go through the repetitive task of creating a bunch of tracks and 
assigning them to the same Ins & Outs every time you start a new Project. See the Cubase documentation 
regarding creating a Project Template.

Open or Create a New Cubase Project

Go to File > New Project to start a new Cubase Project. Once your Project is open, look at the bottom 
left of the Cubase screen to check its Sample Rate & Bit Depth. If these are not what you want, then 
you can go to the Project > Project Setup dialog. (Note that it is best to set the Sample Rate and Bit 
Depth first in the Line 6 Audio-MIDI Devices, as shown in the first step of this chapter - you did 
follow that step, right?)
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Look at the Cubase Project’s Sample Rate 
& Bit Depth at the bottom left of the main 
Cubase window 

44,100 Hz is a good choice for your 
Sample Rate, or you can choose 48,000, 
88,200 or 96,000 Hz if your project 
specifically requires one of these higher 
rates

Choose 24 Bit as your Record Format -it 
is best if you match this to the same Bit 
Depth setting you set in the Line 6 Audio-
MIDI Devices dialog

Configuring an Audio Track for Recording 

Now that your Line 6 hardware and Cubase Buses are set up, you are ready to start working in your 
Cubase Project!  

Add a New Audio Track

This launches the Add Audio Track dialog, 
where you can choose the type of track, and 
how many to add. We’ll add one Stereo track 
for our example

In the Cubase Project menu, select to 
add an Audio track
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Select Your Audio Track’s Input and Output

You’ll see all the Input Buses here that you 
created in the VST Connections - Input dialog. 
You can choose either a stereo or mono input*

Click on the Audio track’s Input 
Routing selector to choose the recording 
input

The Audio tracks’ Output Routing 
should default to your Line 6 device’s 
Output 1
(Or, if you created additional Output 
Buses in the VST Connections dialog, 
you can choose the preferred one here)

*Note that for a stereo audio track, choosing a Stereo Input Bus will record a stereo file. Choosing a 
Mono Input Bus will record a mono file. If you create a mono audio track, then you can only choose 
a Mono Input Bus (or only one channel of your Stereo Bus) as the track input, and this will record a 
mono file. 

Set Input Monitoring Options

As mentioned in the previous Choose your Line 6 Gear Configuration section, you’ll want to keep 
the Cubase Software Monitoring function “off” on the audio track if you are utilizing POD Farm 2 in 
standalone operation, or if using POD X3 or PODxt for their monitoring capabilities. This way, your 
input is not additionally fed through the Cubase software.

Keep the audio track’s Monitor button set to OFF
(You can access this and most other track controls on both the Track 
Header or to the left in the “Inspector”)

If you are using POD Studio/TonePort/GuitarPort and not running the POD Farm 2 in standalone 
application, then you’ll want to turn the Cubase track’s Monitor button “ON” to hear your input 
signal through the Cubase software. You’ll likely also want to insert POD Farm 2 and/or POD Farm 
Elements Plug-Ins on this audio track now and use some amp & effects models to hear applied to your 
input signal while recording. See the Cubase documentation for more about its Software Monitoring 
options.
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Arm Your Track & Set Your Levels

Click the Record Enable button “ON” 
to arm the audio track for recording*

*Note that the track meters in Cubase will not measure the input signal unless the Software Monitoring 
feature is on (which you might have just turned OFF in the last step). You can display the Cubase Mixer 
and the level meters there are active for inputs with the track Monitor function on or off. 

If desired, launch the Cubase Mixer and you can 
view the meters for the respective Audio track to 
gauge your input levels before you start recording

The signal coming into the audio track, and how you adjust its level, depends upon the configuration 
of Line 6 gear you’ve selected, as covered at the start of this chapter. 

•	 If you are using POD Studio/TonePort/GuitarPort hardware and not running POD Farm 2 in 
standalone operation, then you’ll need to use your guitar’s volume knob, the hardware’s Mic 
Gain knob, or the volume on the external device plugged into any Line In.

TIP: As always, your signal levels are very important for quality recordings - be sure to always adjust your 
instrument or input source’s volume to avoid “clipping” on all meters!

•	 If you are using POD X3/PODxt hardware, adjust your levels using the onboard Output controls 
for what is routed to the Record Send you’ve selected for the audio track’s inputs.
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•	 If you are using POD Farm 2 in standalone operation, use the POD Farm 2 Mixer View. Note 
that here you can choose the type of signal fed to either Record Send and adjust the levels 
independently of the signal you hear coming from the ToneDirect™ Monitoring signal!

Adjust the Record 
Send Levels

Choose the type of “Source” signal 
that is fed to each Send*

If the Record Send output 
is still very low, activate the 
+18 boost 

POD Farm 2 standalone Mixer - Record Send controls

*Note that you’ll have different options for POD Farm 2 Record Send Sources depending on if you 
currently have a Single or Dual Tone running. Please see the “Mixer View” on page 4•1.

Start Recording!

Once your record level is set, click on the transport Record button and start riffing!

Using POD Farm 2 & POD Farm Elements Plug-Ins in Cubase

If you want to insert the POD Farm 2 or any of the POD Farm Elements Plug-Ins on your Cubase track, 
just click on one of the Inserts menus, found  both in the Cubase Track Inspector to the left of the 
track, and in the Cubase Mixer.  
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Click on one of the Insert slots for your 
audio track and choose POD Farm 2 or 
one of the Elements Plug-Ins from the 
list

Cubase supports the VST Plug-In format, so if you installed the VST POD Farm 2 & Elements Plug-
Ins during your POD Farm 2 installation, they should be available in Cubase, as shown above. If the 
Plug-Ins do not appear within the Cubase Insert menu, you may need to set Cubase to find the POD 
Farm 2 VST directory. To do this go to the Cubase Devices menu.

In the Devices menu, select Plug-in 
Information

In the VST Plug-ins screen, click the 
VST 2.x Plug-in Paths button
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Click the Add button and browse to the 
directory where your POD Farm 2 VST 
Plug-Ins are installed. Unless you chose a 
custom location during the POD Farm 2 
installation, by default the directory is: 
\Program Files\Line6\POD Farm 2\
VST* 

Once you’ve added the new path, click 
OK 

*TIP: If you have other Line 6 VST Plug-Ins (POD Farm 1 or GearBox) installed you can alternatively 
select the \Program Files\Line6 folder and Cubase will then find all VST plug-ins within this directory, 
and all its sub-directories.

Now, back in the VST Plug-ins dialog, click the Update button to have Cubase 
rescan your system, and you should see the POD Farm 2 & POD Farm Elements 
Plug-In appear in the VST list below. All Plug-Ins should then be available 
within the Cubase Insert menus

External MIDI Control of POD Farm 2 Plug-In in Cubase

Cubase offers the ability to access the knobs, sliders & switches of any inserted VST Plug-In remotely, 
via a hardware MIDI controller device, provided the VST Plug-In supports this ability. And POD 
Farm 2 Plug-In does indeed support MIDI Control to allow you to take full advantage of these MIDI  
features! It is recommended that you first get familiar with the POD Farm 2 MIDI control features and 
configuration covered in the POD Farm 2 Basic User Guide, as well as in the Plug-In chapter on 
page 3•7.

As described in the Plug-In chapter, Cubase, like most DAWs, requires that you configure a MIDI 
track to route your MIDI controller device’s MIDI commands into the POD Farm 2 Plug-In. The first 
step is to make sure your MIDI controller device is connected to your computer, and accessible within 
Cubase. For example, our USB-connected Line 6 UX2 & FBV Shortboard Express devices are both are 
automatically detected by Cubase, and appear as available input to a Cubase MIDI track. If your MIDI 
controller device is not detected, please consult the Cubase documentation.

To route MIDI to an instance of POD Farm 2 Plug-in, insert POD Farm 2 Plug-In on one of your audio 
track’s effects Inserts, and make note of which Track and Insert slot you’ve loaded it into. For our 
example, we’ve inserted the Plug-In on the Audio 01 track, in Insert “1” (the top slot).
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POD Farm 2 Plug-In loaded into  
“Insert 1” of the Audio 01 track

Next, create a new MIDI track in your project and configure its MIDI Input & Output options. We’ll 
select our Line 6 FBV Shortboard MkII-Port 1 as the Input (our MIDI controller device). For the MIDI 
track’s Output we need to select the specific track & Insert slot for the desired “POD Farm 2 Plug-In”.

Select your MIDI controller device as the 
MIDI track Input

Select the “Audio 01 Ins. 1 - POD Farm 2 
Plug-In” as the MIDI track output to route 
the MIDI to the specific Plug-In

Important - you must keep the MIDI track’s Monitor 
option ON to allow MIDI to be fed to the track output!

This completes the configuration. You should now be able to access the “pre-configured” MIDI control 
assignments within POD Farm 2 Tone Presets, or utilize the POD Farm 2 MIDI Learn feature to “map” 
your controller to POD Farm 2 parameters (see “External MIDI Control with POD Farm 2 Plug-In” on 
page 3•7). Please see your Cubase documentation for more about its MIDI control features.

Plug-In Parameter Automation in Cubase

Cubase offers robust features for “writing” and editing VST plug-in parameter automation, and 
POD Farm 2 and POD Farm Elements Plug-Ins all allow you to take full advantage of them! We’ve 
provided step by step instructions for assigning POD Farm 2 Plug-In parameters, displaying and editing 
automation envelopes, as well as for using the Cubase automation “Write” modes in the Plug-In 
chapter. Please see “Parameter Automation with POD Farm 2 & Elements Plug-Ins” on page 3•10.
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